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capitolo 1

Introduzione a SampleCell Il Plus

SampleCell Il unisce le migliori funzioni
dei campionatori dedicati alla potenza di
una stazione di lavoro audio e offre potenti
funzionalita di montaggio e riproduzione
del campionamento in computer
Macintosh o Windows dotati di slot PCI.

Con SampleCell 11 é possibile utilizzare file
audio provenienti da raccolte di campioni
su CD-ROM o importare suoni registrati
digitalmente e modificarli a piacimento. E
anche possibile controllare la riproduzione
dei campioni da qualsiasi periferica o
software MIDI.

Novita presenti in SampleCell 1l
Plus

La scheda SampleCell 11 Plus & dotata di
tutte le funzioni della scheda SampleCell 11
PCI con in piu 32 MB di RAM incorporata.
Non occorre memoria RAM
supplementare.

Il sistema SampleCell 11 Plus supporta
Open Music System (OMS) nei sistemi
Macintosh e Multimedia nei sistemi
Windows 98 e Windows NT,
consentendone I'utilizzo con sequencer e
controller MIDI esterni.

Informazioni sulla guida

La guida si compone di:

0 Capitolo 1: Introduzione a SampleCell I
Plus, la parte restante del presente capitolo
che costituisce un'introduzione alle
funzioni di SampleCell 11.

0 Capitolo 2: Installazione di

SampleCell Il Plus in un sistema Macintosh
descrive l'installazione e il test della parte
hardware di SampleCell Il e del relativo
software (compreso OMS), nonché il
collegamento all'hardware audio e MIDI.

0 Capitolo 3: Installazione di

SampleCell Il Plus in Windows descrive
I'installazione e il test della parte hardware
di SampleCell Il e del relativo software
(compreso Windows Multimedia), nonché
il collegamento all'hardware audio e MIDI.

0 Capitolo 4: Guida del compositore a
SampleCell descrive il funzionamento con
banchi e strumenti e include una
panoramica della finestra Bank.

0 Capitolo 5: Creazione e modifica di
strumenti descrive come creare strumenti
personalizzati utilizzando i propri
campioni e come configurarne la
riproduzione.
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0 Capitolo 6: Montaggio dei campioni,
esecuzione di loop e trim dell'audio spiega
come utilizzare SampleCell Editor per
creare e modificare loop campioni.

0 Capitolo 7: Tecniche avanzate mostra
alcuni esempi delle potenti funzioni di
riproduzione dei campioni di
SampleCell II.

0 Capitolo 8: Scheda di riferimento di
SampleCell Il elenca e descrive i comandi di
menu di SampleCell Editor.

Convenzioni utilizzate nella presente
guida

I seguenti simboli sono utilizzati per
evidenziare informazioni importanti
contenute nella guida:

O Suggerimenti per I'utente : consigli utili per
ottenere il massimo dal sistema.

A Awvertenze importanti : riportano
informazioni che potrebbero influire sui dati e
sulle prestazioni del sistema.

Caratteristiche di
SampleCell Il Plus

Le principali caratteristiche di
SampleCell Il Plus includono:

« Supporto completo OMS per Macintosh

e Supporto multimediale per Windows 98
e Windows NT

e 32 MB di RAM incorporata

< Editor di loop integrato

< Polifonia a 32 voci e funzionalita
multitimbro
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« 50 strumenti multicampione mono
oppure 25 stereo e 10 strumenti mono o
5 stereo a campione singolo per scheda

* 2 generatori di tracciamento con 9 punti
ciascuno

< Un filtro passa basso sweeping per voce

e Convertitori digitale-analogico per
ciascuna delle quattro uscite audio stereo

« Versione dimostrativa di un'utility che
consente agli utenti Windows di aprire
file campione e strumenti in volumi
Macintosh HFS

Opzione SampleCell TDM

SampleCell TDM™ é una scheda figlia
aggiuntiva che integra la riproduzione
audio in SampleCell con I'ambiente TDM
dei sistemi Digidesign Pro Tools®. Con
SampleCell TDM le uscite audio di
SampleCell vengono visualizzate come
sorgenti d'ingresso nelle sessioni di

Pro Tools.

Articoli inclusi

Nella confezione di SampleCell 11 Plus

sono presenti i seguenti componenti:

« Scheda audio digitale a 16 bit
SampleCell Il Plus con 32 MB di RAM
incorporata

* Cavo stereo-a-Y per collegare al sistema
una delle quattro uscite di SampleCell 1l

e CD-ROM con il programma di
installazione di SampleCell Il per
installare il software SampleCell Editor

* Driver MIDI Multimedia per
Windows 98 e Windows NT

« DAE e DigiSystem Init per Macintosh



e Quattro raccolte di campioni su CD-
ROM con oltre 900 megabyte di
campioni e strumenti che comprendono:
le raccolte SampleCell #1 e #2 per
Macintosh e #1 e #2 per Windows

< Versione dimostrativa di un'utility che
consente agli utenti Windows di aprire
file e montare volumi HFS/Macintosh

Requisiti di sistema

Di seguito sono riportati i requisiti di
sistema per le tre piattaforme supportate.

Macintosh

Per utilizzare SampleCell 1l Plus con un
Macintosh, occorre:

« Power Macintosh 7200, 7500, 7600,
8500, 9500, 9600 o0 G3

Almeno 20 megabyte di memoria RAM

OMS™ 2.3.2 0 versione successiva
(fornito)
Interfaccia MIDI Macintosh

Windows 98

Per utilizzare SampleCell 11 Plus con un PC

e Windows 98, occorre:

* Processore Pentium

« Windows 98 Second Edition

e Almeno 32 MB di memoria (oltre 64
consigliati)

e Funzionalita Windows Multimedia

e Interfaccia MIDI compatibile con
Windows 98

Mac OS System 7.5 o versione successiva

Windows NT

Per utilizzare SampleCell Il Plus con un PC

e Windows NT, occorre:

« Processore di classe Pentium

* Windows NT 4.0 con Service Pack 3 (o
Service Pack 4)

e Almeno 32 MB di memoria (oltre 64
consigliati)

e Funzionalita Windows Multimedia

« Interfaccia MIDI compatibile con
Windows NT

Dispositivi facoltativi

In base alle esigenze specifiche dell'utente
potrebbero essere necessari anche i
seguenti dispositivi:

« Cavi stereo-a-Y supplementari per
collegare le uscite stereo da 1/4 di pollice
di SampleCell Il al sistema audio. Nella
confezione di SampleCell 11 & incluso un
cavo stereo.

» Tastiera con controller MIDI (o altri
controller MIDI) e cavi MIDI per attivare
la riproduzione con SampleCell Il
tramite MIDI.

O Nei sistemi Windows numerose schede
audio e per giochi dispongono di un'interfaccia
MIDI integrata.

« Software di sequencing MIDI
compatibile con OMS nei sistemi
Macintosh o con Multimedia nei sistemi
Windows 98 o Windows NT.

« Sesi desidera utilizzare Digital Performer
di MOTU o un'altra applicazione
FreeMIDI, occorre utilizzare FreeMIDI
OMS Emulator quando si attiva la
riproduzione SampleCell II.
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Utilizzo di SampleCell con i
sistemi estesi

E possibile utilizzare pit schede SampleCell
in un singolo computer (a patto che sia
disponibile un numero sufficiente di slot
PCI). Ciascuna scheda consente di
aggiungere 32 voci e 4 uscite stereo
supplementari. E inoltre possibile utilizzare
uno chassis di espansione PCl approvato da
Digidesign, per aggiungere fino a 10 schede
SampleCell in un sistema standalone,
oppure fino a otto schede quando si
installa SampleCell Il in un sistema

Pro Tools.

A |l programma SampleCell Editor versione
2.1.1 e versione successiva non supporta
SampleCell | per Macintosh o SampleCell Il
per PC.
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capitolo 2

Installazione di SampleCell Il Plus in un

sistema Macintosh

Prima di installare un qualsiasi software
SampleCell occorre installare la scheda nel
computer.

Installazione della scheda
SampleCell Il

Se si utilizza SampleCell Il con un sistema
Pro Tools TDM, assicurarsi di installare le
schede nell'ordine corretto di slot. Per

dettagli vedere “Ordine corretto degli slot

delle schede per i sistemi TDM” a pagina 6.

Per installare schede SampleCell I

1 Accertarsi che il computer e le periferiche
siano spente. Lasciare il cavo di
alimentazione del computer collegato alla
presa di corrente in modo da stabilire la
messa a terra.

2 Rimuovere il coperchio del Macintosh.
Nella Figura 1 viene mostrato come
eseguire l'installazione in un Power
Macintosh 9600; la procedura € molto
simile anche per gli altri sistemi Macintosh.
Se non si ¢ certi della procedura di
installazione della scheda, fare riferimento
al manuale utente del Macintosh.

3 Prima di maneggiare le schede
SampleCell, scaricare I'elettricita statica
eventualmente presente sui propri vestiti o
sul corpo toccando una superficie metallica
con messa a terra, quale la parte esterna
dell'alimentatore all'interno del computer
Macintosh.

Figura 1. Scaricamento dell'elettricita elettrostatica
residua e rimozione degli sportelli delle porte di
accesso

4 Rimuovere lo sportello metallico della
porta di accesso dietro allo slot di
espansione che si desidera utilizzare,
facendolo scorrere rispetto alla porta di
accesso.
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5 Rimuovere la scheda SampleCell Il dalla
confezione antistatica. Maneggiare la
scheda afferrandola per i bordi in modo da
evitare di scaricare energia statica o
sporcare i componenti con le sostanze
grasse presenti sulle mani.

6 Inserire lascheda SampleCell in uno slot
PCI all'interno del computer (vedere la
Figura 2). Fare pressione con cautela sulla
scheda fino a quando non é fissata al
connettore. Evitare di flettere la scheda o di
fare pressione sulla scheda madre del
computer. In caso di resistenza estrarre la
scheda e riprovare.

Figura 2. Installazione della scheda SampleCell Il in
un sistema Macintosh

Ripetere la procedura per qualsiasi altra
scheda SampleCell 1l aggiuntiva.

7 Una volta terminato, riposizionare il
coperchio del Macintosh.

Se si dispone di una scheda SampleCell Il
meno recente (versione PCI), & possibile
utilizzarla con la scheda SampleCell Il Plus
piu recente.
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Ordine corretto degli slot delle
schede per i sistemi TDM

Affinché il modulo TDM possa
sincronizzare correttamente i dati che
transitano nel sistema, tutte le schede con
modulo TDM devono essere installate
nell'ordine di slot corretto. Se il sistema &
dotato di uno chassis di espansione esterno
PCI, l'ordine di slot deve essere rispettato
anche in questo chassis.

Nei sistemi Pro Tools estesi, tutte le schede
SampleCell Il (e SampleCell 1l TDM)
dovrebbero seguire le schede DSP Farm,
mentre nel caso di piu schede SampleCell,
queste ultime dovrebbero essere installate
una accanto all'altra.

L'ordine delle schede, a partire dallo slot
alfanumerico piu basso, deve essere:

1 Schede MIX Core (Pro Tools 24 MIX),
schede d24 (Pro Tools 24), o schede
Disk 1/0 (Pro Tools 111 PCI)

2 Schede MIX Farm

3 Schede DSP Farm

4 Schede SampleCell 11 TDM

5 Schede SampleCell Il non TDM

Se si dispone di piu schede dello stesso tipo,
occorre installarle in slot adiacenti. Ad
esempio, occorre installare tutte le schede
DSP Farm assieme, quindi le schede
SampleCell II TDM e infine qualsiasi
scheda SampleCell 1l non TDM.

A Non installare schede non TDM, o lasciare
slot vuoti, tra le schede TDM.



Installazione del software
SampleCell

Una volta installata la scheda SampleCell 11
e dopo avere acceso il computer, si & pronti
per installare il software SampleCell.

Tramite il programma di installazione di
SampleCell verranno copiati sul disco
rigido SampleCell Editor, il programma di
diagnostica DigiTest, Digidesign Audio
Engine (DAE) e DigiSystem Init.

Inviare la scheda di registrazione di
SampleCell

Gli utenti registrati riceveranno
aggiornamenti software periodici e la
notifica dei nuovi aggiornamenti. E
opportuno non perdere tempo e inviare la
scheda di registrazione oggi stesso.

Per installare il software SampleCell:

1 Inserire il CD-ROM di SampleCell
nell'apposita unita.

2 Individuare I'applicazione Install
SampleCell presente nel CD e farvi doppio
clic sopra.

3 Per installare il software, seguire le
istruzioni visualizzate sullo schermo.

Le applicazioni SampleCell Editor e
DigiTest vengono installate nelle cartelle
corrispondenti all'interno della cartella
Digidesign (nella directory principale del
disco rigido). Nella cartella Sistema viene
installata la cartella DAE e nella cartella
Estensioni la cartella DigiSystem Init.

4 Quando viene chiesto, riavviare il
computer.

Rimozione del software
SampleCell

E possibile rimuovere il software
SampleCell dal computer utilizzando la
funzione Remove del programma di
installazione.

Per rimuovere il software SampleCell:

1 Inserire il CD-ROM di SampleCell
nell'apposita unita.

2 Individuare I'applicazione Install
SampleCell presente nel CD e farvi doppio
clic sopra.

3 Nella finestra del programma di
installazione, scegliere Remove dal menu a
comparsa nell'angolo superiore sinistro.

4 Fare clic su Switch Disk per specificare il
disco rigido in cui si trova il software
SampleCell.

5 Fare clic su Remove.

SampleCell Editor, I'applicazione DigiTest,

DAE e DigiSystem Init vengono rimossi dal
disco rigido.

Configurazione del
software OMS

Per utilizzare SampleCell Il con
applicazioni compatibili con OMS o per
utilizzare i servizi MIDI in SampleCell
Editor occorre installare e configurare
Open Music System (OMS).

Il software OMS consente di sapere come lo
studio MIDI é collegato e configurato; tali
informazioni vengono memorizzate nei
documenti Studio Setup, modificabili
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tramite I'applicazione OMS Setup. Il

sistema OMS si occupa anche di eseguire il
routing MIDI tra SampleCell Il, i sequencer
compatibili con OMS e l'interfaccia MIDI.

Se non ¢ gia installato, installare il software
OMS fornito con SampleCell.

Se OMS & gia stato installato e configurato,
occorre aggiornare la versione corrente di
Studio Setup affinché SampleCell 1l venga
riconosciuto.

Per aggiornare la versione di OMS Studio
Setup:

1 Nell'applicazione OMS Setup scegliere
Studio > MIDI Cards and Interfaces.

Viene individuata la scheda SampleCell 11
che quindi viene visualizzata nel
documento Studio Setup.

2 Fare doppio clic sull'icona SampleCell
per configurarne la finestra di dialogo MIDI
Device Info.

Verificare che sia impostata per ricevere su
tutti i canali (1-16), a meno che non si
desideri che laricezione MIDI avvenga solo
in determinati canali.

0 Per alcune applicazioni OMS potrebbe
essere necessario aggiornare I'elenco “OMS
instruments” prima che SampleCellvenga
reso disponibile. Per ulteriori informazioni,
consultare la documentazione del produttore.

Routing MIDI verso la scheda
SampleCell Il

In SampleCell Editor € possibile attivare la
riproduzione di SampleCell Instruments
dalla tastiera MIDI. SampleCell Editor
consente di eseguire il routing MIDI (via
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OMS) dal controller della tastiera a
qualsiasi strumento assegnato al canale
inviato dalla tastiera.

Per indirizzare automaticamente il MIDI
allo strumento SampleCell correntemente
selezionato, attivare la preferenza “Pass
MIDI Thru”. Per ulteriori informazioni
sull'opzione vedere “Finestra Preferences” a
pagina 101.

Se si desidera azionare gli strumenti
SampleCell dalla tastiera MIDI quando
SampleCell Editor non é I'applicazione
corrente, attivare I'opzione OMS per “Run
MIDI in Background”.

Per attivare Run MIDI in Background:

1 Scegliere SampleCell > MIDI Setup da
SampleCell Editor.

2 Nella finestra di dialogo OMS MIDI Setup
selezionare Run MIDI in Background.

3 Fare clic su OK.

Questa opzione consente anche al
sequencer compatibile con OMS di
continuare la riproduzione MIDI quando il
sequencer non ¢ piu l'applicazione corrente,
permettendo in tal modo di ascoltare le
modifiche in SampleCell Editor mentre il
sequencer continua la riproduzione.

Tenere presente che quando Run MIDI in
Background é attivato e il segnale MIDI
viene echeggiato sia in SampleCell Editor
che nel sequencer attraverso lo stesso
strumento, verranno prodotte delle note
doppie.

Per ovviare al problema, disabilitare MIDI
“echo” nel sequencer o assicurarsi che non
avvenga il routing MIDI verso uno
strumento SampleCell.



Utilizzo di applicazioni non
OMS

FreeMIDI

Se si utilizza SampleCell 1l con un software
compatibile con Mark di FreeMIDI™ di
Unicorn’, occorre utilizzare OMS Emulator.
Per ulteriori informazioni sulla
configurazione consultare la
documentazione di FreeMIDI.

Assicurarsi di non eseguire
contemporaneamente FreeMIDI e OMS. Se
si installa Performer o Digital Performer,
che installa automaticamente FreeMIDI
OMS Emulator nella cartella Extensions,

assicurarsi di rimuovere o disabilitare OMS.

A FreeMIDI OMS Emulator interrompera la
riproduzione se si passa a SampleCell Editor
durante la riproduzione.

Collegamenti MIDI

Per riprodurre audio con SampleCell 1l da
un controller di tastiera MIDI esterno,
collegare MIDI OUT del controller a MIDI
IN dell'interfaccia MIDI. In questo modo la
tastiera MIDI puo trasmettere MIDI alla
scheda SampleCell Il “attraverso” il
software MIDI compatibile con OMS.

Per ulteriori informazioni sull'installazione
e la configurazione dell'interfaccia MIDI
consultare la documentazione del
produttore.

Collegamenti Audio

SampleCell Il presenta 8 canali audio in
uscita. | connettori per queste uscite sono
quattro connettori stereo da 1/4 di pollice
che si trovano nella parte posteriore della
scheda SampleCell 11. Ciascun strumento
SampleCell puo essere assegnato a una
qualsiasi di queste coppie stereo e pud
esserne regolato il pan nel modo
desiderato.

Per collegare le uscite audio di SampleCell II:

1 Collegare una terminazione stereo del
cavo stereo a Y- (incluso nella confezione di
SampleCell Il) all'uscita audio desiderata di
SampleCell.

La Figura 3 illustrata la numerazione delle
uscite audio di SampleCell II.

12
3-4
56
7-8

Figura 3. Numerazione delle uscite audio di
SampleCell

2 Collegare l'altra terminazione “doppia”
agli ingressi del livello di linea del mixer.

Il cavo stereo a Y incluso nella confezione
di SampleCell Il presenta i seguenti colori:
rosso = destra, grigio = sinistra.

Capitolo 2: Installazione di SampleCell Il Plus in un sistema Macintosh
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Guadagno di ottimizzazione per
il sistema audio

SampleCell é dotato di varie funzioni di
test incorporate, incluso un generatore di
onde sinusoidali che puo essere utilizzato
per regolare il guadagno nel sistema.

A |l generatore di audiofrequenza di
SampleCell emette un'onda sinusoidale con
segnale digitale massimo, il cui suono & molto
forte. Per ragioni di sicurezza si consiglia di
abbassare il volume di tutte le
apparecchiature di monitoraggio, quindi di
alzarlo lentamente dopo aver abilitato il
generatore di audiofrequenza. Procedere con
cautela se si utilizzano le cuffie.

Per ottimizzare il guadagno in uscita di
SampleCell:

1 Abbassare il volume dei canali del mixer.

2 In SampleCell Editor scegliere
SampleCell > Test SampleCell.

Viene aperta la finestra Test SampleCell.
All'estremita destra si trovano i pulsanti
Test Sine.

I———————————— T ———— 5

nnnnn asic M

sear bram
fsampleCeTl Il (Test ) CTest ) CTest ) CTest ) Test sine: [ZIEWEIETE!

Finestra Test SampleCell

3 Uno alla volta, fare clic su Test Sine per
ciascun canale e regolare i canali
corrispondenti nel mixer, in modo che sia
possibile udire un tono puro senza alcuna
distorsione.

O Consultare I'Appendice B: Risoluzione dei
problemi prima di utilizzare qualsiasi altra
opzione nella finestra Test SampleCell.
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Test degli strumenti

E possibile utilizzare un banco della
raccolta di campioni su CD-ROM per
eseguire un controllo rapido dei
collegamenti audio e MIDI.

Per eseguire il test dei collegamenti audio e
MIDI:

1 In SampleCell Editor scegliere File >
Open.

2 Inserire il CD-ROM con la raccolta di
campioni per sistemi Macintosh #1
nell'apposita unita.

3 Selezionare il banco “Tite Groove
Playstation” e fare clic su Open.

4 Per aprire la finestra Sample Map, fare
doppio clic su un qualsiasi strumento nella
finestra Bank.

5 Per riprodurre un campione nella finestra
Sample Map, fare clic sulla tastiera.

6 Utilizzare il controller della tastiera MIDI
e confermare la comunicazione MIDI.

7 Mentre si riproduce un suono, bilanciare
i controlli del mixer per assicurarsi che le
uscite audio siano collegate correttamente.



Installazione di SampleCell Il Plus in

Windows

Prima di installare un qualsiasi software
SampleCell occorre installare la scheda nel
computer.

Installazione della scheda
SampleCell Il

Se si utilizza SampleCell Il con un sistema
Pro Tools TDM, assicurarsi di installare le
schede nell'ordine corretto di slot. Per
informazioni vedere “Ordine corretto degli
slot delle schede per i sistemi TDM” a
pagina 12.

Per installare le schede SampleCell II:

1 Accertarsi che il computer e le periferiche
siano spente. Lasciare il cavo di
alimentazione del computer collegato alla
presa di corrente in modo da stabilire la
messa a terra.

2 Rimuovere il coperchio del computer. Se
non si e certi della procedura di
installazione della scheda, fare riferimento
al manuale dell'utente fornito con il
computer.

3 Prima di maneggiare la scheda
SampleCell Il scaricare I'elettricita statica
eventualmente presente sui propri vestiti o
sul corpo toccando una superficie metallica
con messa a terra, ad esempio la parte
esterna dell'alimentatore all'interno del
computer.

4 Rimuovere lo sportello metallico della
porta di accesso dietro allo slot di
espansione che si desidera utilizzare
facendolo scorrere rispetto alla porta di
accesso.

5 Rimuovere la scheda SampleCell Il dalla
confezione antistatica. Maneggiare la
scheda afferrandola per i bordi, per evitare
di scaricare energia statica o di sporcarne i
componenti con le sostanze grasse presenti
sulle dita.

6 Inserire la scheda SampleCell 1l in uno
slot PCl all'interno del computer (vedere la
Figura 4). Fare pressione con cautela sulla
scheda fino a quando non é fissata al
connettore. Evitare di flettere la scheda o di
fare pressione sulla scheda madre del
computer. In caso di resistenza estrarre la
scheda e riprovare.

Capitolo 3: Installazione di SampleCell 1l Plus in Windows
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/
Figura 4. Installazione della scheda SampleCell Il in
un PC

Ripetere la procedura per qualsiasi altra
scheda SampleCell 1.

7 Una volta terminato, riposizionare il
coperchio del computer.

Ordine corretto degli slot delle
schede per i sistemi TDM

Affinché il modulo TDM possa sicronizzare
correttamente i dati che transitano nel
sistema, tutte le schede con modulo TDM
devono essere installate nell'ordine di slot
corretto. Se il sistema € dotato di uno
chéssis di espansione esterno PCI, I'ordine
di slot deve essere rispettato anche in
questo chassis.

Nei sistemi Pro Tools estesi, tutte le schede
SampleCell Il (e SampleCell 11 TDM)
dovrebbero seguire le schede DSP Farm e le
schede multiple SampleCell dovrebbero
essere installate una accanto all'altra.

L'ordine delle schede, a partire dallo slot
alfanumerico piu basso, deve essere:

1 Schede MIX Core (Pro Tools 24 MIX) o
schede d24 (Pro Tools 24)

2 Schede MIX Farm

12 Guida di SampleCell 1l

3 Schede DSP Farm
4 Schede SampleCell Il TDM
5 Schede SampleCell Il non TDM

Se si dispone di piu schede dello stesso tipo,
occorre installarle in slot adiacenti. Ad
esempio, occorre installare tutte le schede
DSP Farm assieme, quindi le schede
SampleCell Il TDM e infine qualsiasi
scheda SampleCell non TDM.

A Non installare schede non TDM o lasciare
slot vuoti tra le schede TDM.

Installazione del software
SampleCell

L'installazione del software SampleCell e
leggermente diversa a seconda del sistema
operativo utilizzato, Windows 98 o
Windows NT. Accertarsi di leggere la
procedura relativa al proprio sistema.

A Se si e installata e si utilizza un'utility
software per leggere i volumi Macintosh HFS,
verificare che sia impostata per accettare il
volume PC nei CD con formato doppio.

Inviare la scheda di registrazione di
SampleCell

Gli utenti registrati riceveranno
aggiornamenti software periodici e la
notifica dei nuovi aggiornamenti. E
opportuno non perdere tempo e inviare la
scheda di registrazione oggi stesso.



Installazione del software per
Windows 98

Unavolta installata la scheda SampleCell 11
e acceso il computer, mediante la
procedura Installazione guidata nuovo
hardware verra chiesto di installare i driver
necessari per Windows 98.

Add New Hardware Wizard

This wizard searches for new drivers for:

PCI Multimedia Audio Device

A device diver is a software program that makes a
hardware device waork.

e Cancel |

Figura 5. Schermata Installazione nuovo hardware,
Windows 98

Per installare i driver per Windows 98:

1 Quando viene visualizzata la schermata
Installazione guidata nuovo hardware, fare
clic su Avanti.

2 Quando viene chiesto come procedere,
selezionare I'opzione L'hardware potra
essere selezionato da un elenco e fare clic su
Avanti.

3 Dall'elenco dei tipi di periferica ,
selezionare Controller audio, video e giochi
e fare clic su Avanti.

4 Inserire il CD-ROM di SampleCell
nell'apposita unita e fare clic su Disco
driver.

5 Specificare la lettera dell'unita CD-ROM
(ad esempio D:\) e fare clic su OK.

6 Con l'opzione del driver SampleCell
selezionata, fare clic su OK. Fare clic su
Avanti per installare i componenti dei
driver necessari.

7 Se non e necessario installare altri driver,
fare clic su Avanti e quindi su Fine per
uscire da Installazione guidata nuovo
hardware.

Una volta installato il driver di
Windows 98, installare il software
SampleCell Editor dal CD-ROM fornito.

Per installare SampleCell Editor in
Windows 98:

1 Inserire il CD-ROM di SampleCell
nell'apposita unita.

2 Se il programma di installazione non si
avvia automaticamente, individuare e
I'icona Setup.exe nel CD di installazione e
farvi doppio clic sopra.

3 Per installare il software, seguire le
istruzioni visualizzate sullo schermo. I file
del programma SampleCell vengono
installati nella cartella Digidesign
all'interno della cartella Programmi
dell'unita di sistema.

4 Quando viene chiesto, riavviare
Windows.

Installazione del software per
Windows NT

Unavoltainstallata la scheda SampleCell 11
e avviato il computer, utilizzare il
programma Setup nel CD-ROM di
SampleCell per installare tutto il software
necessario per Windows NT.

Per installare i driver di SampleCell Editor e
per Windows NT:

1 Inserire il CD-ROM di SampleCell
nell'apposita unita.

Capitolo 3: Installazione di SampleCell 1l Plus in Windows
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2 Se il programma di installazione non si

avvia automaticamente, individuare e fare
doppio clic sull'icona Setup.exe nel CD di

installazione.

3 Per installare il software, seguire le
istruzioni visualizzate sullo schermo. | file
del programma SampleCell vengono
installati nella cartella Digidesign
all'interno della cartella Programmi
dell'unita di sistema. Vengono inoltre
installati i driver per Windows NT per
SampleCell II.

4 Quando viene chiesto, riavviare
Windows.

Rimozione del software
SampleCell

E possibile rimuovere il software
SampleCell dal computer mediante
Installazione applicazioni del Panello di
controllo di Windows.

Per rimuovere il software SampleCell:

1 Fare doppio clic sull'icona Installazione
applicazioni nel Pannello di controllo.

2 Selezionare l'opzione per SampleCell

Editor e fare clic su Aggiungi/Rimuovi per
rimuovere il software.

Utilizzo delle applicazioni
MIDI di Windows

Una volta installato il driver per Windows
di SampleCell, nelle applicazioni MIDI
utilizzate viene visualizzato il
corrispondente dispositivo di uscita MIDI.
Verificare di assegnare le tracce MIDI ai
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canali SampleCell che corrispondono agli
strumenti di SampleCell correntemente
caricati.

Se si utilizzano piu schede SampleCell Il,
ogni scheda viene visualizzata con un
nome nelle applicazioni MIDI di Windows
(“SampleCell Card 1,” “SampleCell Card 2”
e cosi via).

3 Nei sistemi con piti schede vi & inoltre un
driver di periferica chiamato “SampleCell
Broadcast” che consente di inviare dati
MIDI contemporaneamente a tutte le
schede.

Collegamenti MIDI

Tutti i routing di segnali MIDI per
SampleCell Il sono gestiti internamente dal
sottosistema Windows Multimedia.
Windows Multimedia consente di gestire la
comunicazione tra le applicazioni e tutte le
periferiche compatibili nel sistema, ad
esempio schede audio, interfacce MIDI e
schede SamplecCell II.

Per riprodurre audio con SampleCell 1l da
un controller di tastiera MIDI esterno,
collegare MIDI OUT del controller a MIDI
IN dell'interfaccia MIDI compatibile con
Windows. In questo modo i dati MIDI
verranno inviati dalla tastiera MIDI alla
scheda SampleCell 11.

Per ulteriori informazioni sull'installazione
e la configurazione dell'interfaccia MIDI
consultare la documentazione del
produttore.



Collegamenti audio

SampleCell Il presenta 8 canali audio in
uscita. | connettori per queste uscite sono
quattro connettori stereo da 1/4 di pollice
che si trovano nella parte posteriore della
scheda SampleCell Il. Ciascun strumento
SampleCell puod essere assegnato a una
qualsiasi di queste coppie stereo e puo
esserne regolato il pan nel modo
desiderato.

Per collegare le uscite audio di SampleCell II:

1 Collegare una terminazione stereo del
cavo stereo a Y- (incluso nella confezione di
SampleCell Il) all'uscita audio desiderata di
SampleCell.

La Figura 6 illustrata la numerazione delle
uscite audio di SampleCell II.

Figura 6. Numerazione delle uscite audio di
SampleCell

2 Collegare l'altra terminazione “doppia”
agli ingressi del livello di linea del mixer.

Il cavo stereo a Y incluso nella confezione
di SampleCell Il presenta i seguenti colori:
rosso = destra, grigio = sinistra.

Guadagno di ottimizzazione per
il sistema audio

SampleCell é dotato di varie funzioni di
test incorporate, incluso un generatore di
onde sinusoidali che puo essere utilizzato
per regolare il guadagno nel sistema.

A |l generatore di audiofrequenza di
SampleCell emette un‘onda sinusoidale con
segnale digitale massimo, il cui suono & molto
forte. Per ragioni di sicurezza si consiglia di
abbassare il volume di tutte le
apparecchiature di monitoraggio, quindi di
alzarlo lentamente dopo aver abilitato il
generatore di audiofrequenza. Procedere con
cautela se si utilizzano le cuffie.

Per ottimizzare il guadagno in uscita di
SampleCell:

1 Abbassare il volume dei canali del mixer.

2 In SampleCell Editor scegliere
SampleCell > Test SampleCell.

Viene aperta la finestra Test SampleCell.
All'estremita destra si trovano i pulsanti
Test Sine.

WD 7 est =] E3

| 55000 ASIC SRAM DRAM

——y Test | Tes || Test [ Test | mestsre WEGIEBREDE =

Z

Finestra Test di SampleCell

3 Uno alla volta, fare clic su Test Sine per
ciascun canale e regolare i canali
corrispondenti nel mixer, in modo che sia
possibile udire un tono puro senza alcuna
distorsione.

O Consultare I'Appendice B: Risoluzione dei
problemi prima di utilizzare qualsiasi altro
elemento nella finestra Test SampleCell.
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Test degli strumenti

E possibile utilizzare un banco della
raccolta di campioni su CD-ROM per
eseguire un controllo rapido dei
collegamenti audio e MIDI.

Per eseguire i test dei collegamenti audio e
MIDI:

1 In SampleCell Editor scegliere File >
Open.

2 Inserire il CD-ROM con la raccolta di
campioni per Wndows #1 nell'apposita
unita.

3 Selezionare il banco “Tite Groove
Playstation” e fare clic su Open.

4 Per aprire la finestra Sample Map, fare
doppio clic su un qualsiasi strumento nella
finestra Bank.

5 Per riprodurre un campione nella finestra
Sample Map, fare clic sulla tastiera.

6 Utilizzare il controller della tastiera MIDI
e confermare la comunicazione MIDI.

7 Mentre si riproduce un suono, bilanciare
i controlli del mixer per assicurarsi che le
uscite audio siano collegate correttamente.
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capitolo 4

Guida del compositore a SampleCell

Nel presente capitolo vengono spiegate le
nozioni di base per l'utilizzo di banchi e
strumenti dalla libreria SampleCell.

Per informazioni su come creare da zero
strumenti e banchi utilizzando i propri
campioni, consultare il

Capitolo 5: Creazione e modifica di strumenti.

Tipi di file SampleCell

Campioni

Un campione & costituito dai dati grezzi
della forma d'onda di un suono
campionato.

ol
[

File campione (formato SD 1)

In SampleCell non & prevista la
registrazione diretta di forme d'onda
digitali o campioni. Numerosi campioni
vengono forniti nei CD-ROM inclusi e
molti altri sono disponibili da sviluppatori
audio di terze parti. Inoltre € possibile
registrare campioni con Pro Tools.

Non ¢ possibile riprodurre i campioni
direttamente con SampleCell, ma e
necessario caricarli dapprima in uno
strumento.

Strumenti

Uno strumento consiste di uno o piu
campioni assegnati a gamme diverse di
tasti e velocity.

E.

Strumento (in alto ) e file di campioni

Molte opzioni di modulazione, quali
inviluppi e oscillatori a bassa frequenza
possono essere utilizzati a livello di
strumento.

Banchi

Gli strumenti sono suddivisi in gruppi di
interpretazione/esecuzione chiamati
banchi.

Capitolo 4: Guida del compositore a SampleCell
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Banco (in alto), strumento e file di campioni

I banchi sono le entita nelle quali vari
strumenti vengono assegnati alle uscite,
attenuati e dei quali viene eseguito il pan.
Ogni strumento di un banco puo essere
assegnato in modo da rispondere a un
canale MIDI e a una gamma di note diversi
per l'utilizzo come modulo audio
multitimbro con un sequencer (o un altro
dispositivo in grado di trasmettere piu
canali MIDI).

Utilizzando i comandi standard
Copy/Paste, ¢ possibile inserire uno
strumento in numerosi banchi diversi. Non
€ possibile aprire gli strumenti in piu
banchi caricati nella stessa scheda
SampleCell Il Plus, ma é possibile copiarli e
incollarli.

I banchi sono utili per organizzare tutti gli
strumenti necessari per un dato brano o
una sequenza MIDI in un unico
documento o per unire tutti gli elementi di
un missaggio secondario (tipologie di suoni
o strumenti musicali/effetti diversi) in
un‘unica schermata.

A Quando si aprono file di strumenti o banchi
0 quando si apre la finestra Edit Loops,
interrompere sempre il sequencer (per evitare
note incollate).
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Struttura dei file nel CD-
ROM

La struttura dei file nei CD-ROM
SampleCell riflette la gerarchia illustrata
nella sezione precedente. | campioni, gli
strumenti e i banchi si trovano tutti in
cartelle alle quali € assegnato
rispettivamente il nome Samples,
Instruments e Banks.

La cartella Banks contiene le informazioni
necessarie per consentire a SampleCell di
creare banchi da uno o piu strumenti.

La cartella Instruments contiene le
informazioni necessarie per consentire a
SampleCell di creare strumenti dai
campioni associati. Queste cartelle
annidate rendono piu facile tenere sotto
controllo gli strumenti memorizzati per
categoria sul CD-ROM, ad esempio
chitarre, sintetizzatori e strumenti a fiato in
legno.

La cartella Samples contiene solamente
campioni grezzi, organizzati in base agli
strumenti.

Q

EBanks Instruments Samples

by

EE
i
Tite Groove Playstation Basses Electric Bass |

Electric Basses Elec Bass F1t wnd Pick AD

B

Elec Bass 1

Gerarchia dei file nei CD-ROM di SampleCell



Se si sta lavorando con i propri campioni, &
opportuno creare cartelle per i banchi, gli
strumenti e i campioni, organizzate nello
stesso modo, affinché tutto sia sempre
organizzato in maniera logica.

Caricamento degli
strumenti

Per caricare un banco esistente, seguire le
istruzioni riportate di seguito per la
piattaforma utilizzata.

Macintosh

Per caricare un banco esistente:
1 Scegliere File > Open.

Select a file to open:

= Somplecell..  Instruments:
D Jo-ka-di' (bank) [ Moog Bass 1 Left
D Pop Ballade Playstation Moog Bass 1 Right
D Tite Groove Playstation Tite Room Drums 1
Tite Room Open Hat
Ska Synth Stereo
Clavinet Left
Clavinet Right
Golan synth
Bank SampleCell 11™:Moog Bass 1
<no comment > Lert:
Moog Bass 1 Left: The
Memory Moog punch with a

Find Missing Instruments 0n Find Missing Samples On [Jconfirm Found Files

[ Filtotumes ] |

Apertura di un banco in un sistema Macintosh

2 Selezionare il banco desiderato e fare clic
su Open.

Windows

Per caricare un banco esistente:
1 Scegliere File > Open.

2 Scegliere il tipo di file dal menu a
comparsa Files of Type.

3 Individuare il banco desiderato e fare clic
su Open.

Select a file to apen:
Folders Files

Lookin: 23 1-disc sets B ﬁl

Componerts

File: pame:

Fills of bype: |ERRBRTERN

Fike Info:

Type: WAVE Bit Depifi: 1601
Length 01:0:00.000 Sample Rate: 441000000 —
S —
Crestedt Janisaty 7, 1998 1222 P o
Modiied January 7, 1938 12:22 Phi e Cancel

Apertura di un banco in Windows

Tutti i sistemi

Nella finestra di dialogo Select Instrument
specificare quali strumenti tra gli strumenti
del banco selezionati si desidera caricare
nella memoria RAM di SampleCell. Se si
dispone di piu schede SampleCell &
possibile specificare in quale scheda verra
caricato ciascuno strumento. Selezionare
gli strumenti desiderati, scegliere la scheda
o le schede appropriate e fare clic su OK.

Bank : Tite Groove Playstation
Load File Volume Card
[ MoogBass 1 Left SampleCeTl (™ SampleCell 11~ ]
[ MoogBass 1 Right SampleCell 1™ ;
i) Tite Room Drums 1 SampleCell 1™
] Tite Room Open Hat SampleCeTl II™
B %kaSunth Steren SampleCell ™
B Clavinet Left SampleCell 1M
B  Clavinet Right SampleCell ™
B9 Golan Synth SampleCell IIM
]

Finestra di dialogo Select Instrument

Ricerca di file

Se non & possibile trovare uno strumento o
un campione necessario per caricare un
banco o uno strumento nella posizione
memorizzata all'interno del file, viene
visualizzata la finestra di dialogo Find File.

Capitolo 4: Guida del compositore a SampleCell
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Macintosh

Nella finestra di dialogo Where Is &
possibile cercare i file mancanti scegliendo
la destinazione della ricerca nei menu a
comparsa posti nella parte inferiore della
finestra di dialogo e quindi facendo clic su
New Search.

Where is Sample "SOLi Synth 3 SCMORPH DWIRLY C4 ST?

G MORPHEUS | = 9600 HD

[ Hect =]

Desktop

Cancel

i

il

Find Missing Instruments On [4 Confirm Found Files

[__Anvolumes v |

Find Missing Samples 0n
AllVolumes |

Finestra di dialogo Where Is (Macintosh)

E possibile ascoltare un file campione in
questa finestra di dialogo selezionandone il
nome e facendo clic su Play. Fare clic sullo
stesso pulsante (Stop) per interrompere la
riproduzione.

Windows

Nella finestra di dialogo Please Locate
cercare i file mancanti selezionando la
cartella nella casella di riepilogo a discesa
posta nella parte superiore della finestra di
dialogo oppure fare clic su Look On
Mounted Volumes.
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Please locate: 335 Sustained 1
Folders  Files

Laokin. Ia'l-dlscsels j ﬁ b3
quitar central 15 Mb T

Mirimong Selector 10 kb
teol 12 b
telio2 22 b

scifi channel 6 Mb Play Position

l:
Play

Look In Cumrent Folder |

File hame: ||

File Irfo: [¥ Inohudz subfolders
TigEz - Bi Depth - Look On Mounted Yolumes |
Length: - Sample Rate: I™ Inchidz network volumes
Size - Channels . .
el s | sbal |

Modiied
Open I Cancel |

Finestra di dialogo Please Locate (Windows)

E possibile ascoltare un file campione
selezionandone il nome e facendo clic su
Play. Per iniziare I'ascolto dalla parte
centrale di un file campione, spostare il
dispositivo di scorrimento orizzontale
sopra il pulsante Play. Per regolare il
volume di riproduzione, spostare il
dispositivo di scorrimento verticale.

Caricamento dei campioni

E possibile selezionare e caricare i campioni
uno alla volta oppure ¢ possibile scegliere
Load All Samples dal menu SampleCell per
caricare tutti i campioni necessari per lo
strumento in questione.

Se la memoria RAM disponibile nella
scheda SampleCell selezionata non &
sufficiente per caricare tutti i campioni per
un dato strumento, lo strumento verra
caricato senza i dati dei campioni. |
campioni vuoti o “non caricati” sono
indicati dal nome di zona/gruppo di note
che appare in corsivo.



Per creare lo spazio necessario per nuovi
campioni, puo darsi che occorra rimuovere
dei campioni caricati dalla memoria.

Per rimuovere dei campioni caricati dalla
memoria:
= Scegliere SampleCell > Delete Unused
Samples.

Controllo del caricamento dei
campioni

Una volta aperti i file degli strumenti, é
possibile controllare I'ordine in cui i
campioni verranno caricati risistemando
gli strumenti nei rispettivi banchi.

Opzione Automatically Load Samples

Se selezionata, questa opzione consente di
eliminare dalla RAM i campioni non
utilizzati, se necessario, per aprire un banco
0 uno strumento.

Operazioni con i banchi

Quando un banco carica tutti i file ad esso
associati, viene visualizzata la finestra
Bank.

Viste del banco

In SampleCell sono disponibili due viste
del banco: unaaschermo intero (full size) e
una in dimensioni ridotte (Small Bank
View). La vista a schermo intero consente
di visualizzare le file dei canali ad altezza
intera per tutti gli strumenti del banco.
Utilizzando I'opzione Small Bank View &
possibile configurare ogni banco per uno
stile di vista “ridotto a riga”.

Banco in vista a schermo intero

Per passare da una vista all'altra:

= Scegliere Windows > Switch Bank View.

Per impostare la vista del banco predefinita

su Small Bank View:
1 Scegliere SampleCell > Preferences.

2 Selezionare l'opzione Default to Small
Bank View.

Per modificare i parametri in Small Bank
View:

= Per regolare un parametro, fare clic sul
relativo pulsante ed eseguire la modifica

come desiderato. Premere il tasto Opzione

e fare clic per reimpostare i parametri sui
valori predefiniti.

=———— Tite Groove Playstation =———H

= 1M A 2 AL

M [MIDI[¥ol [Pan | Lo | Hi [Out[Card]
| [ I}

Instrument
[Moog Bass 1 Lett

5
5
= —

[Moog Ess 1 Rigt 7] an[ce]i=

[Tite Room Drums 1 10][3 an][ce][i-=

[Tite Roorn Open Hat

an][ce][i=2
=

Al
[es](so][cs]
s9](~0

0 [0

[Clavinet Lett

[Clavinet Right

o
=

[Golan Synth s 3

=
[l B

Banco in vista ridotta

Vi sono altre opzioni di visualizzazione che

possono essere impostate come viste
predefinite. E possibile visualizzare i
parametri degli strumenti, ad esempio
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accordatura, inviluppo e ampiezza. La
maggior parte di questi parametri sono
presenti nelle finestre Sample Map, Misc,
Envelopes, Matrix, Trackers e Modulators.
Per ulteriori informazioni vedere la sezione
“Display Preferences” a pagina 103.

Creazione di un nuovo banco

Quando si utilizzano strumenti e campioni
da volumi sorgente multipli (pio CD-ROM,
ad esempio) sara opportuno organizzare
tutti i file di ogni volume nel rispettivo
banco.

Per gestire i file da piu CD-ROM, creare un
banco per ogni disco. Cio semplifichera le
cose quando si salva un banco che contiene
strumenti e/o campioni provenienti da piu
CD-ROM.

Per creare un nuovo banco:
1 Scegliere File > New.

—Select New Document Type: —
@ Eank

D Multi-Sample Instrument

D Stereo Multi-Sample Instrument
O Single-Sample Instrument

D Sterea Single-Sample Instrument

[ Cancel } [[ oK ]]

Selezionare la finestra di dialogo Document Type

2 Selezionare Bank e quindi fare clic su OK.

_O_
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Scegliere File > Save Bank As. In questo
modo é possibile salvare in batch campioni
e strumenti in posizioni nuove, allo stesso
modo di quando si salva dal CD-ROM sul
disco rigido.

Caricamento di strumenti in un
banco

E necessario caricare uno o pitl strumenti in
un banco nuovo. Inoltre & possibile
aggiungere strumenti a un banco esistente,
a condizione di disporre di memoria a
sufficienza.

A Importante: quando si aprono file di
strumenti o banchi oppure quando si apre la
finestra Edit Loops, interrompere sempre il
sequencer (per evitare note incollate).

Per caricare uno strumento in una finestra
Bank aperta:

1 Scegliere File > Open e individuare le
cartelle contenenti gli strumenti che si
desidera caricare.

Select a file to open:

D Bosendorfer |
D Bosendorfer 2
D Bosendorfer 3 Desktop
0 Bosendorfer 4
D Bosendorfer Im
D Bosendorfer Stereo Cancel

= SampleCell .. Regions:
BOSEN A Op

o]

Eject

[l

Multi-Sample Instrument
7,489,552 sample bytes

Besendorfer grand with smooth forte
samples.

sampleCell 11™:BOSEN A Op:
<no comment>

Find Missing Instruments On Find Missing Samples On [ Confirm Found Files

[ All Uolumes | [ All Uolumes  — |

Apertura di uno strumento (Macintosh)



Select a file to open. HE
Folders Fies

Lookin: [ Tdisc sels - =i

Componens

Fle pane: [

Files of type: [ s ampleCell nstiument (~ins] =l

Fle I

e Play Posiion

Type: WAVE Bit Depth: 1640 300
Length: 01:00:00.000 Sarple Rate: 44100.0000 —
i —
CreatedJanuay 7, 1999 1222 PH =
Modifed: January 7, 1338 12.22 PM £ Cancel

Apertura di uno strumento (Windows)

2 Selezionare lo strumento desiderato e
fare clic su Open oppure fare doppio clic sul
nome dello strumento.

O In questa finestra di dialogo € possibile
selezionare e caricare anche i campioni. Il
campione selezionato verra caricato in uno
strumento nuovo, a campione singolo, nel
banco corrente o in un banco nuovo se non vi
e alcun banco aperto.

3 Se si utilizzano piu schede SampleCell,
scegliere la scheda nella quale si desidera
caricare lo strumento.

4 Ripetere per tutti gli strumenti
eventualmente presenti.

Non ¢ possibile aprire lo stesso strumento
in piu banchi nella stessa scheda
SampleCell. Se alcuni campioni necessari
per lo strumento caricato sono gia in
memoria, non verranno ricaricati.

Ska Sunth
Steren

=

Lo strumento cosi come viene visualizzato in un
banco

0O Se si verificano problemi durante il
caricamento di strumenti di notevoli
dimensioni nella memoria disponibile, per
molti strumenti sono previste delle versioni
alternative, di dimensioni inferiori, presenti nel
CD-ROM di SampleCell. Questi file presentano
il suffisso “Im” per “low memory” (poca
memoria) e si trovano nella cartella
Instrument.

Informazioni sui banchi
multipli

I banchi multipli possono essere aperti ed
essere attivi contemporaneamente. Ad
esempio, banchi diversi possono contenere
strumenti per brani o gruppi diversi.
Oppure un banco pud contenere una
batteria rock mentre un altro puo
contenere una batteria jazz. Probabilmente
si notera che questo approccio modulare
rende la configurazione di banchi e
strumenti piu semplice per una

Capitolo 4: Guida del compositore a SampleCell 23



moltitudine di brani e sorgenti. Se
possibile, raggruppare tutti i file dai singoli
CD-ROM in banchi separati.

Utilizzo di piu copie di uno
strumento in un banco

Una tecnica di produzione comune
comporta l'utilizzo di due suoni identici
accordati in modo leggermente diverso
I'uno dall'altro. Per implementare questo
tipo di effetto sono tuttavia necessari due
strumenti identici in memoria. Questa
procedura richiede un quantitativo
minimo di memoria supplementare,
poiché vengono riutilizzati gli stessi
campioni, tuttavia SampleCell non
consente di caricare piu volte il file di un
dato strumento in un banco e certi
parametri di campione sono globali, il che
significa che le impostazioni specifiche di
un dato campione nella finestra di dialogo
Sample Parameters del campione
riguardano tutti gli strumenti nei quali
viene utilizzato il campione.

Poiché possibile regolare due parametri
degli strumenti indipendentemente I'uno
dall'altro, & possibile copiare uno
strumento e incollarlo nello stesso banco
per ottenere effetti chorus e altri effetti
simili.

Per effettuare la copia di uno strumento

all'interno di un banco:

1 Selezionare lo strumento da copiare
facendo clic sul nome.

2 Scegliere Edit > Copy Instrument.

3 Fare clic sull'area vuota nella finestra
Bank dove si desidera collocare la copia.

4 Scegliere Edit > Paste.
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Controllo dei campioni utilizzati in piu
strumenti

Quando si copia e si incolla per creare un
duplicato di uno strumento, i parametri del
campioni quali Panning e Loop Detune
possono essere modificati
indipendentemente da quelli dello
strumento originale. Altri parametri dei
campioni, tra cui Sample Select
Coarse/Medium, Zone Start e Sample
Detune sono regolazioni globali che
riguardano tutti gli strumenti che
includono quel campione. Cio e dovuto al
fatto che gli strumenti copiati fanno
riferimento agli stessi campioni (e cio
consente di risparmiare memoria RAM).

Eliminazione di strumenti da un
banco

Gli strumenti possono essere rimossi dai
banchi con la stessa facilita con cui
vengono aggiunti.

Per eliminare uno strumento da un banco:

1 Selezionare lo strumento da copiare
facendo clic sul nome.

2 Scegliere Edit > Cut Instrument oppure
Edit > Clear Instrument.

0 Mediante il comando Cut Instrument una
copia dello strumento viene memorizzata negli
Appunti mentre con il comando Clear
Instrument cid non avviene. L'eliminazione di
uno strumento con il comando Clear &
un'operazione che non puo essere annullata!

L'eliminazione dei campioni puo
richiedere un po' di tempo perché
SampleCell “riorganizza” i campioni
rimanenti nella memoria resa disponibile.



Metodi alternativi di
Immissione dei dati

La maggior parte dei parametri degli
strumenti e dei banchi di SampleCell sono
controllati mediante dispositivi di
scorrimento e pulsanti sullo schermo.

I controlli sullo schermo per le note alte e
basse e il canale MIDI visualizzano speciali
elenchi a comparsa per I'impostazione di
questi parametri.

Vi sono diverse combinazioni di tasti e
metodi alternativi per immettere i valori
della maggior parte dei parametri in
SampleCell. Tra questi vi sono il controllo
MIDI dei dispositivi scorrevoli di
SampleCell (ad esempio il controllo
Modulation e il filtro), nonché la modifica
di testo e numeri di valori mediante la
tastiera del computer e/o il dispositivo di
ingresso MIDI.

0 La comunicazione MIDI del sequencer con
SampleCell e la mappatura della matrice di
SampleCell consentono il controllo diretto dei
parametri di SampleCell. La finestra Matrix
viene illustrata nel Capitolo 5: Creazione e
modifica di strumenti.

Per controllare un dispositivo di scorrimento

di SampleCell utilizzando un dispositivo MIDI:

1 Premere il tasto Control e fare clic
(Macintosh) o fare clic col pulsante destro
del mouse (Windows) sul dispositivo di
scorrimento da modificare. Viene
visualizzata una piccola icona che
rappresenta un connettore MIDI.

Assegnazione del controllo Pan a un controller MIDI
esterno

2 Utilizzare il controllo Modulation, il
joystick, la pedaliera, il dispositivo di
scorrimento per I'immissione di dati o altri
controller continui del dispositivo MIDI
per assegnare quel controller al dispositivo
scorrevole di SampleCell selezionato e
regolarlo via MIDI.

3 Il dispositivo di scorrimento di controllo
rimane assegnato al controllo sullo
schermo finché non si fa clic di nuovo con
il mouse. Fare clic con il mouse su un‘altra
parte dello schermo di SampleCell per
uscire dalla modalita MIDI.

Per specificare il numero di nota MIDI da un
dispositivo MIDI per definire lagamma di note
MIDI di uno strumento:

1 Premere il tasto Control e fare clic
(Macintosh) o fare clic col pulsante destro
del mouse (Windows) sul nome della nota
alta o della nota bassa (ad esempio, A0).
Verra visualizzata una piccola icona che
rappresenta un connettore MIDI.

2 Riprodurre la nota desiderata mediante la
tastiera del controller MIDI.
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Per regolare il valore del dispositivo di
scorrimento SampleCell utilizzando la
tastiera:

1 Premere Control e fare clic (Macintosh) o
fare clic col pulsante destro del mouse
(Windows) sul valore visualizzato del
dispositivo di scorrimento (I'impostazione)
0 su un altro controllo, attivando la
modalita di immissione diretta per quel
valore. Viene visualizza l'icona del
controllo MIDI.

2 Utilizzando la tastiera, regolare il valore
premendo + o i tasti Freccia su o Freccia
destra per aumentare il valore; premere - 0
i tasti Freccia giu o Freccia sinistra per
diminuirlo.

3 Uscire da questa modalita di immissione
remota facendo clic col pulsante del
mouse.

Per reimpostare il valore predefinito di un
parametro:

= Premere il tasto Opzione (Macintosh) ol
tasto Alt (Windows) e fare clic sul
parametro desiderato.

Impostazione del canale
MIDI

Il canale MIDI degli strumenti esistenti puo
essere impostato mediante il menu a
comparsa dei canali MIDI sulla fila dello
strumento.

Per impostare il canale MIDI di uno

strumento:

1 Fare clic sul numero posto sopra
I'indicatore del canale MIDI. Viene
visualizzato un menu a comparsa.
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Impostazione del canale MIDI (vista in dimensioni
ridotte)

2 Trascinare finché non viene evidenziato
il numero di canale desiderato.

0 Quando si creano nuovi strumenti,
SampleCell € in grado di assegnare un canale
MIDI unico a ogni strumento nuovo. Per
ulteriori informazioni vedere la sezione “Try to
Assign Unused MIDI Channel for New
Instruments” a pagina 102.

Impostazione delle zone MIDI

Quando uno strumento viene caricato per
la prima volta in un banco, risponde
all'intera gamma di note MIDI. Questa
gamma di risposta puo essere cambiata per
ogni strumento. Ad esempio, per creare
una tastiera divisa si puo desiderare che il
suono di un basso risponda solo alle note
inferiori a C2 e che il suono di un organo
risponda alle note C2 e superiori. La
tastiera a comparsa Hi/Lo Note fornisce un
modo rapido per definire i punti di
divisione impostando la gamma delle note
alte e basse dello strumento.

Per cambiare la nota MIDI piu bassa alla
quale uno strumento rispondera:

1 Fare clic sull'icona della tastiera a destra
di Lo. Viene visualizzata una tastiera a
comparsa.



Impostazione della nota Lo MIDI

2 Trascinare lungo la tastiera finché la nota
desiderata non viene evidenziata. Lo
strumento non rispondera piu alle note
inferiori a quella selezionata.

Per cambiare la nota MIDI piu alta alla quale
uno strumento rispondera:

1 Fare clic sull'icona della tastiera a destra
di Hi. Viene visualizzata una tastiera a
comparsa.

2 Trascinare lungo la tastiera finché la nota
desiderata non viene evidenziata. Lo
strumento non rispondera piu alle note
superiori a quella selezionata.

Inoltre é possibile regolare il valore Hi/Lo
premendo il tasto Control e facendo clic e
quindi immettere un nuovo valore
riproducendo una nota con la tastiera
MIDI.

O Il canale MIDI e le zone MIDI possono
essere salvate come impostazioni predefinite
dello strumento. Per informazioni sul comando
Set Instrument Default vedere il

Capitolo 8: Scheda di riferimento di
SampleCell II.

O E possibile creare e salvare strumenti come
modelli da memorizzare per essere riutilizzati
in strumenti nuovi. Vedere la sezione
“Modelli” a pagina 81 per ulteriori
informazioni.

Assegnazione di uscite
audio

Non & pura coincidenza il fatto che i
pannelli dei controlli degli strumenti
assomiglino a una console di missaggio. Le
funzioni sono quasi identiche, con gli
strumenti che svolgono lo stesso ruolo dei
canali sulle console tradizionali; la
differenza é che SampleCell presenta uno
strumento musicale vero e proprio caricato
in ogni canale.

Ogni strumento puo essere indirizzato a
una delle quattro coppie di uscite audio
della scheda SampleCell alla quale &
assegnato. Cosi come si puo avere il
pianoforte, il basso e la batteria in ricezione
su canali MIDI separati, le rispettive uscite
audio possono essere indirizzate a tre uscite
stereo diverse della scheda SampleCell.
Queste possono, a loro volta, essere
indirizzate a tre coppie stereo separate di
una console di missaggio per un missaggio
secondario. In modo analogo, ogni coppia
di uscite in una postsessione di un video o
un film puo essere dedicata a un gruppo
diverso (ad esempio musica ed effetti,
foley, atmosfera).

Per assegnare uno strumento a una coppia di
uscite audio:

= Fare clic sul pulsante Output associato
alla coppia di uscite desiderata. L'audio
dello strumento viene visualizzato solo
sulle uscite corrispondenti.

Impostazione dei canali in uscita
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E possibile selezionare una sola coppia di
uscite alla volta per ogni strumento.

Se si utilizza SampleCell TDM, la modifica
dei controlli per I'assegnazione delle uscite
analogiche modifica anche il routing nel
modulo TDM.

O L'uscita audio puo essere salvata come
impostazione predefinita dello strumento. Per
informazioni sul comando Set Instrument
Default vedere il Capitolo 8: Scheda di
riferimento di SampleCell I1.

Pan dello strumento

Pan determina il bilanciamento dello
strumento per quanto riguarda la coppia di
uscite stereo selezionate. Ad esempio, se
sono selezionate le uscite 1-2 con il pan
tutto a sinistra, viene inviato uno
strumento mono solamente all'uscita 1,
mentre con il pan tutto a destra lo
strumento viene inviato solamente
all'uscita 2.

Le uscite degli strumenti stereo sui canali
dispari sono completamente a sinistra,
quelle sui canali pari completamente a
destra.

Il dispositivo di scorrimento per il pan
dello strumento consente di spostare il
centro dell'immagine stereo dello
strumento. | valori negativi spostano il
suono verso l'uscita sinistra, mentre i valori
positivi lo spostano verso l'uscita destra.

Per cambiare il pan per i singoli campioni
all'interno dell'immagine stereo, vedere la
sezione “Pan del gruppo di note” a
pagina 48.
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Per eseguire il pan di uno strumento nella
coppia di uscite selezionata:

= Trascinare il controllo del pan nella
direzione desiderata. Il numero posto sul
controllo indica la quantita esatta di pan.

BEEE

|
Controllo del pan dello strumento

Per informazioni sulla modulazione del
pan con gli oscillatori a bassa frequenza o
altre sorgenti di modulazione, vedere la
sezione “Modulazione della matrice” a
pagina 56.

O Il pan dello strumento puo essere salvato
come impostazione predefinita dello
strumento. Per informazioni sul comando Set
Instrument Default vedere il

Capitolo 8: Scheda di riferimento di
SampleCell I1.

Silenziamento e assolo di uno
strumento

In modo analogo a una console di
missaggio, il silenziamento consente di
silenziare lo strumento associato, mentre
I'assolo consente di sentire solamente gli
strumenti selezionati.

E possibile silenziare o selezionare I'assolo
per piu strumenti contemporaneamente.
Se si seleziona l'assolo per uno strumento,
tutti gli altri strumenti in tutti i banchi
aperti vengono silenziati.



Tite Foarn
Crurns 1

Pulsanti Solo e Mute

Per silenziare uno strumento:

= Fare clic sul pulsante Mute dello
strumento.

Per tornare al funzionamento normale, fare
clic di nuovo su Mute. Premere il tasto
Opzione (Macintosh) o il tasto Alt
(Windows) e fare clic per rimuovere il
silenziamento da tutti gli strumenti.

Per silenziare uno strumento:

= Fare clic sul pulsante Solo dello
strumento.

Per tornare al funzionamento normale, fare
clic di nuovo su Solo. Premere il tasto
Opzione (Macintosh) o il tasto Alt
(Windows) e fare clic per rimuovere l'assolo
da tutti gli strumenti.

Volume dello strumento

Il volume principale di uno strumento
viene attenuato mediante il fader del
volume.

Per cambiare il volume di uno strumento:

= Trascinare il fader del volume dello
strumento fino al livello desiderato. Per
un'impostazione accurata sono forniti dei
valori numerici.

Fader del volume dello strumento

0 Premere il tasto Control e fare clic
(Macintosh) o fare clic col pulsante destro del
mouse (Windows) sul fader del volume per
assegnare temporaneamente un controller
MIDI (controller Modulation, ecc.) al volume
dello strumento.

Informazioni sul clipping

E possibile eseguire il clipping delle uscite
di SampleCell mentre viene eseguita la
riproduzione simultanea a volume elevato
di numerosi strumenti. Controllare
I'impostazione del guadagno dell'intera
configurazione audio (ossia i livelli di ogni
componente quali SampleCell, livello in
entrata del mixer, livello in uscita del
mixer, guadagno dell'amplificatore e livello
in uscita dell'amplificatore).

0 Il volume dello strumento puo essere
salvato come impostazione predefinita dello
strumento. Per informazioni sul comando Set
Instrument Default vedere il

Capitolo 8: Scheda di riferimento di
SampleCell I1.
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Commenti relativi a strumenti e
banchi

Con SampleCell € possibile immettere i
propri commenti sugli strumenti e i
banchi. | commenti vengono visualizzati
nella finestra di dialogo Open File quando
si seleziona un banco o uno strumento
particolare.

Per immettere o modificare commenti per un
banco o uno strumento:

1 Con un file di banco aperto, scegliere File
> Get Bank Info.

— O —
2 Selezionare lo strumento desiderato e

scegliere Instruments > Get Instrument
Info (o fare clic sul pulsante Info).

3 Immettere o modificare i commenti.

4 Quando si chiude la finestra, i commenti
vengono memorizzati nel file del banco
corrente.

Anche i commenti associati agli strumenti
vengono immessi in questa finestra. Questi
commenti rimangono associati agli
strumenti anche quando vengono
utilizzati con altri banchi.

Accordatura degli
strumenti

In SampleCell non sono previsti controlli
globali di accordatura del banco. Ogni
singolo strumento ¢ invece dotato di propri
parametri di accordatura. Questi controlli
si trovano nella finestra Misc di ogni
strumento.

30 Guida di SampleCell I

Per accedere ai controlli di accordatura per
uno strumento:

1 Selezionare lo strumento desiderato nella
finestra Bank.

2 Scegliere Windows > Misc o fare clic su
Misc nella barra degli strumenti del banco.

Misc

Pulsante Misc

Tite Room Drums

Finestra Misc

Per eseguire la trasposizione dell'ottava dello
strumento:

= Trascinare il dispositivo di scorrimento
Pitch Octave nella posizione desiderata. La
gamma puo essere regolata fino a tre ottave
superiori o quattro ottave inferiori rispetto
al tono originale.

Per eseguire la trasposizione di uno
strumento in semitoni:

= Trascinare il dispositivo di scorrimento
Pitch Semitone nella posizione desiderata.
L'intervallo puo essere regolato di +12
semitoni rispetto al tono originale.

Un'accordatura precisa € estremamente
utile quando di desidera ottenere un effetto
chorus o un effetto stonato tra due copie
identiche dello stesso strumento.



Per accordare con precisione o disaccordare
uno strumento:

= Trascinare il dispositivo di scorrimento
Detune nella posizione desiderata.
L'intervallo puo essere regolato di £1/4 di
tono dal tono originale.

0 Ogni campione puod essere accordato
singolarmente nella finestra Sample
Parameters. Per ulteriori informazioni vedere
la sezione “Parametri del campione” a
pagina 49.

Informazioni sull'opzione Equal
Detune

I controlli di Detune rispondono nei
diversi intervalli di uno strumento, in base
all'impostazione Equal Detune nella
finestra Misc.

Opzione Equal Detune disattivata. Quando
I'opzione Equal Detune ¢ disattivata, la
riproduzione di SampleCell si basa
sull'accordatura temperata (esponenziale) e
il dispositivo di scorrimento Detune
cambia l'accordatura di tutte le note del
numero selezionato di cent (un cent=1
centesimo di semitono). In altre parole un
disaccordo di meno 5 cent produrra lo
stesso effetto percepito in tutto l'intervallo
di uno strumento. Al suonera “bemolle”
come A6 o D7. Questo perché I'offset in
cent é logaritmico.

Opzione Equal Detune attivata. Quando
I'opzione Equal Detune é attivata, I'effetto
del dispositivo scorrevole Detune variera in
funzione della frequenza. Con il
dispositivo Detune si potra disaccordare in
incrementi di cicli al secondo o di Hz. |l
dispositivo Detune sembra avere un effetto
maggiore sulle note basse e un effetto

minore sulle note alte. Con lI'opzione Equal
Detune attivata e un'impostazione di
disaccordo di -5, Al (55,0 Hz) suonera “piu
bemolle ” di A6 (1760,0 Hz), perché 5 Hz al
di sotto di Al é quasi un semitono (G#1 =
51,91 Hz) mentre 5 Hz sotto A6 & una
semplice frazione di un semitono. Questo
perché I'offset in Hz € lineare.

Puo darsi che si desideri sperimentare con
I'opzione Equal Detune con strumenti non
occidentali o strumenti antichi. Oppure e
possibile utilizzarla per far corrispondere i
loop ad altre battute. Potrebbe fornire
quellaleggera modifica in velocita (velocita
di riproduzione/tono) necessaria perché il
tutto risulti perfetto.

Salvataggio di un banco

Una volta configurato un banco con gli
strumenti e le relative impostazioni di base,
& opportuno salvare il banco per poterlo
utilizzare in futuro.

E possibile salvare tutti gli strumenti e i
campioni associati a un banco utilizzando
il comando Save Bank As.

A Accertarsi di assegnare nomi esclusivi ai
banchi, agli strumenti e ai campioni durante il
salvataggio. SampleCell non €& in grado di
distinguere automaticamente tra campioni,
strumenti e banchi e quindi, qualora si salvi
per errore uno strumento con lo stesso nome
nella stessa posizione di un campione, tale
campione verra sovrascritto.

Per salvare il banco corrente con il nome e la
destinazione originali:

= Scegliere File > Save Bank.
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Per salvare un banco con un nome e/0 una
destinazione nuovi:

1 Scegliere File > Save Bank As.

2 Immettere un nome e scegliere la
destinazione per il banco.

3 Scegliere tra le opzioni seguenti per
salvare gli strumenti associati al banco:

« Fare clic su Don’t Save se non si
desidera salvare le nuove copie degli
strumenti del banco in una nuova
destinazione.

e Fare clic su Annulla per salvare il
banco, lasciando tuttavia gli strumenti
inalterati.

» Fare clic su Save per salvare gli
strumenti associati.

4 Scegliere tra le opzioni seguenti per
salvare i campioni associati ai vari
strumenti.

» Fare clic su Don’t Save se non si
desidera salvare i campioni.

e Fare clic su Annulla per salvare lo
strumento, lasciando tuttavia i
campioni inalterati.

« Fare clic su Save per salvare ogni
campione nella cartella appena salvata
del banco.

Per salvare tutti gli strumenti e i banchi
modificati:
= Scegliere File > Save All Changed.

Chiusura di un banco

Per chiudere un banco:

= Fare clic sulla casella di chiusura del
menu di controllo della finestra del banco
o scegliere File > Close.
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O Per ulteriori informazioni sulla chiusura dei
banchi di SampleCell vedere la sezione
“Automatically delete unused samples” a
pagina 101.

Salvataggio di uno
strumento

La maggior parte dei parametri discussi in
questo capitolo vengono salvati come parte
di un banco piuttosto che insieme allo
strumento. Se si modificano i commenti o
altri parametri associati allo strumento, &
necessario salvare lo strumento per
preservare tali modifiche. Quando si
chiude un banco, viene automaticamente
chiesto se si desidera salvare le modifiche
apportate allo strumento; € tuttavia sempre
possibile salvare gli strumenti
manualmente.

Per salvare uno strumento con il nome e la
destinazione originali:

= Scegliere File > Save Instrument.

Per salvare uno strumento con un nuovo
nome e/0 una nuova destinazione:

1 Scegliere File > Save Instrument As.

2 Immettere un nome e scegliere la

destinazione per lo strumento.

3 Scegliere tra le opzioni seguenti per

salvare i campioni associati allo strumento:

e Fare clic su Don’t Save per chiudere senza
copiare i campioni.

e Fare clic su Annulla per salvare lo
strumento, lasciando tuttavia i campioni
inalterati.



« Fare clic su Save per salvare tutti i
campioni associati prima di chiudere.

Per salvare tutti gli strumenti e i banchi
modificati:

= Scegliere File > Save All Changed.

Termine di una sessione

I banchi e gli strumenti associati possono
contenere modifiche che verranno perse a
meno che non vengano salvate
correttamente.

Per uscire da SampleCell:

= Scegliere File > Quit (Macintosh) o File >
Esci (Windows).

Utilizzo di SampleCell una
volta terminata una
sessione

E possibile configurare SampleCell Editor
in modo che i campioni rimangano caricati
nella memoria RAM una volta usciti dal
programma.

Se I'opzione Automatically Delete Unused
Samples é deselezionata, € possibile uscire
da SampleCell anche se un banco € ancora
aperto e gli strumenti del banco
rimarranno disponibili e potranno essere
attivati dal sequencer.

Per ulteriori informazioni vedere la sezione
“Automatically delete unused samples” a
pagina 101.
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Creazione e modifica di strumenti

In questo capitolo viene spiegato il
funzionamento delle funzioni di
montaggio degli strumenti di SampleCell.

I controlli di SampleCell per volume dello
strumento, pan, uscita audio, canale MIDI
€ gamma sono associati ai banchi. Nei
banchi questi controlli sono raggruppati
con i parametri delle prestazioni. Per
ulteriori informazioni sui controlli dei
banchi vedere il Capitolo 4: Guida del
compositore a SampleCell.

Informazioni di base sullo
strumento

Uno strumento & un raggruppamento
riutilizzabile di campioni e, in quanto tale
deve appartenere a un banco per poter
essere modificato. E possibile caricare gli
strumenti da CD-ROM e modificarli oppure
€ possibile creare nuovi strumenti (aggiunti
a un banco) e configurarli con campioni
personalizzati, mappe di note e
impostazioni di modulazione.

Ciascuno strumento dispone di parametri
personalizzabili a cui si pud accedere
facendo clic sui seguenti pulsanti sulla
barra degli strumenti Edit:

Finestra Misc

Mise |

La finestra Misc € dotata di dispositivi di
scorrimento: tuning, priority, overlap,
velocity response, pitch wheel e filter.
Inoltre, sono presenti le caselle di
controllo: crossfade, Monophonic, Key
Track, Equal Detune e Disable MIDI
Volume/Pan.

Finestra Envelope

=

La Finestra Envelope mette a disposizione 3
inviluppi a quattro punti con controlli
supplementari: Key Track, Envelope
Amount e Gate Time.
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Matrix, finestra

#

La finestra Matrix & uno strumento per la
mappatura della modulazione che
consente di creare una mappatura tra
numerosi sorgenti di controllo della

modulazione e i parametri di destinazione.

Finestra Modulators

M s
T

La finestra Modulators mette a disposizione
due oscillatori LFO a velocita, ampiezza,
forma e modalita di attivazione variabili.
Inoltre, sono presenti un generatore di
rampa e 2 controller MIDI variabili.

Finestra Trackers

La finestra Trackers fornisce grafici a nove
punti di interruzione per il plottaggio di
curve di risposta personalizzate per
qualsiasi parametro.

Menu Windows

Le voci disponibili nel menu Windows
variano a seconda che si tratti di uno
strumento monocampione o di uno
strumento multicampione (vedere
“Creazione di nuovi strumenti” a
pagina 36).
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Creazione di nuovi strumenti

Le caratteristiche generali di uno
strumento vengono definite da tre
elementi

Strumenti mono o multicampione

In SampleCell vi sono due tipi di strumenti
di base: strumenti monocampione e
strumenti multicampione.

Gli strumenti monocampione sono dotati
di un solo gruppo di note, una sola zona di
velocity e nessun percorso di modulazione
(effetti sonori e loop sono spesso strumenti
monocampione). Per questo motivo,
Envelope, Matrix, Modulators o Trackers
non sono disponibili per gli strumenti
monocampione.

Gli strumenti multicampione possono
presentare piu gruppi di note, piu zone di
velocity e vari percorsi di modulazione. Gli
strumenti multicampione possono anche
essere montati utilizzando una qualsiasi
delle finestre di montaggio degli strumenti.

Ciascunascheda SampleCell Il presente nel
sistema puo contenere fino a 50 strumenti
multicampione e 10 strumenti mono
monocampione, nonché fino a 25
strumenti multicampione e 5 strumenti
stereo monocampione.

Strumenti mono o stereo

Gli strumenti possono essere mono o
stereo. Le caratteristiche mono/stereo dei
campioni che si desidera utilizzare nello
strumento determinano la modalita di
definizione del nuovo strumento stesso.



A Quando dei campioni mono vengono
caricati in strumenti stereo, il campione mono
utilizzera fino a 2 voci. E preferibile creare
strumenti separati se si utilizzano campioni
sia mono che stereo.

Per creare un nuovo strumento:

1 All'interno di un banco aperto, scegliere
File > New o fare clic sul pulsante New sulla
barra degli strumenti Edit.

Pulsante Create New

2 Selezionare il tipo di strumento che si
desidera creare, quindi fare clic su OK.

—Select New Document Type: —
@ Eank
D FMulti-Sarmple Instrument
D Stereo Multi-Sample Instrurment
D Single-Sample Instrument

D Stereo Single-Sample Instrument

Finestra di dialogo Create New

3 Scegliere Windows > Single Map.

O E possibile impostare SampleCell in modo
che venga creato uno strumento quando si
trascinano nell'editor piu file audio. Per
ulteriori dettagli vedere “Make one
Instrument” a pagina 102.

Aggiunta/Importazione di
Campioni

Una volta creato un nuovo strumento
mono o multicampione, si € pronti per
aggiungere i campioni. SampleCell
consente di aggiungere/sostituire campioni
uno alla volta o caricare in batch gruppi di
note durante la creazione di nuovi
strumenti.

0 Le zone di velocity devono essere aggiunte
una alla volta.

Per aggiungere un nuovo gruppo di note:

1 Scegliere Instruments > New Key Group o
fare clic sul pulsante New Key Group nella
finestra Sample Map:

Pulsante New Key Group

2 Selezionare il campione da importare. E
possibile selezionare regioni all'interno dei
file sonori oppure file sonori interi.

Sel

io File{s). [2]x]
Fies

Lookin [ Tdie st ~ =1

Fie pome: [

Files of vee: [aif (~aif) E

Flay Posiion

T ==

Finestra di dialogo New Key Group/Velocity Zone
(Windows)

Type: WAVE BitDepth: 166t
Length: 01:0000.000 Sample Rate: 441000000
Size: 0k Chanek: mono

w 7,193 1222 P
w 7,193 1222 P

File nfo:

Creal
Modfie

3 Fare clic su Play per ascoltare il campione
del suono con il tono originale.
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4 Fare clic su Open per caricare il campione
selezionato. Il nuovo gruppo di note e
posizionato su C8.

Il successivo gruppo di note a sinistra, con
una gamma di oltre una nota, viene ridotto
per fare posto al nuovo gruppo di note;
tutti i gruppi di note a nota singola

vengono spostati verso sinistra di una nota.

Per caricare in batch gruppi di note
(Macintosh):

1 Scegliere Instruments > Add Multiple Key
Groups.

select files to add:
&3 snare Orchestral ¥

D snare Singl $trok Rim2
DO snare Singl Strok Rim3
O Snare Singl Strok Snr 0ff 1
O snare Singl $trok Snr 0ff 3
[1 Snare Sus Roll Snr OFf ff

01 Snare Sus Roll Snr Off mf
O Snare Weird!

= SampleCell ...

Eject

Desktop

Cancel

i

), Add

Audio IFF (AIFF) 16-bit Mono 44100 Hz
1 seconds 69,296 bytes
Files added:

Snare Singl Strok 2

Snare Singl Strok Snr Off 2
$nare Sus Roll T

Snare Sus Roll ff

snare Sus Roll mp

R

Add ANl

g

Play

Finestra di dialogo Add Multiple Key Groups
(Macintosh)

O In Windows € possibile aggiungere piu file
da una singola cartella, ma non da piu
cartelle. Per aggiungere piu file dalla stessa
cartella, scegliere Instruments > New Key
Groups.

2 Per aggiungere gruppi di note & possibile:

< Selezionare i campioni nell'elenco Select
Files to Add e fare clic su Add.

« Fare clic su Play per ascoltare il campione
correntemente selezionato.

< Per aggiungere l'intero contenuto della
cartella corrente, fare clic su Add All.
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« Per rimuovere un campione dall'elenco
Files Added, selezionarlo e fare clic su
Remove.

3 Una volta terminato, fare clic su Done.

Tutti i nuovi gruppi di note verranno
distribuiti su tutta la gamma dello
strumento nella finestra Sample Map.

Per caricare in batch i gruppi di note mentre
si stanno creando nuovi strumenti:

1 Scegliere SampleCell > Preferences e
scegliere una delle seguenti impostazioni
per I'opzione Make One Instrument when
Multiple Sound Files are Dragged Onto the
Editor:

Selected. Quando l'opzione ¢ selezionata,
viene creato uno strumento e vengono
caricati tutti i campioni trascinati su tale
strumento.

Not Selected. Quando l'opzione &
deselezionata, viene creato uno strumento
per ciascun campione trascinato su tale
strumento.

2 Trascinare il numero di campioni
desiderato sull'icona del file SampleCell (lo
strumento deve essere gia stato creato e
salvato affinché la funzione sia
disponibile).

0 Non € possibile caricare zone di velocity in
batch.

Per aggiungere una zona di velocity:

1 Selezionare un campione nel gruppo di
note in cui si desidera aggiungere una
nuova zona di velocity.

2 Scegliere Instruments > New Velocity
Zone o fare clic sul pulsante New Velocity
Zone nella finestra Sample Map:



+

[

+

Pulsante New Velocity Zone

3 Fare clic suun campione per selezionarlo.

4 Fare clic su Play per ascoltare il campione
del suono con il tono originale.

5 Fare clic su Open per caricare il campione
selezionato.

La nuova zona di velocity viene
posizionata nella gamma di velocity piu
elevata. La zona di velocity del campione
immediatamente sotto di essa verra ridotta.
Parametri del campione

) Instrument Select
Nuovo gruppo di note

Finestraacomparsa  Finestra Open Loops
Ricarica campione

Sample Map

Essenzialmente uno strumento € composto
da campioni che sono stati mappati su
varie gamme di note (gruppi di note) e
velocity (zona di velocity) MIDI. Tale
mappatura puo essere visualizzata,
modificata e cambiata nella finestra Sample
Map.

Per aprire la finestra Sample Map:

= Fare clic sull'icona Sample Map dello
strumento nella finestra Bank o fare doppio
clic sul nome di uno strumento.

Casella di controllo
MIDI selects zone

Modifica campione

Nuova zona
di velocity ampi=z Map
attack flute 3w Inz.i -
Limite
della 20 |[Cuack 1.cr.ait Helicop ammy passhy aif [Aragan.aif Wizird machine ort.aif
zona di 2
velocity
55 |
Zona di ﬂ Phione, Burope, busy? aif Lele 3t Fip,zhort 1,crt.aif
velocity — 24
4
3
g |[attack flute wawv [asta snare kick.waw Fip =hort 1,crt.aif Lol Aaif
40 |
Scala di velocity  z7]
24 |
Impostazione ~ |!& |
della nota g
d'origine
Ordinamento l
di gruppi di
note per
nota
d'origine v | ! N !
Distribuzione dei Tastiera Nota d'origine MIDI ~ Gruppo di Limite del gruppo di note
gruppi di note note

Finestra Sample Map
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Informazioni di base sulla
mappatura delle note

La mappatura delle note ¢ la disposizione
di pitl campioni su una gamma
riproducibile di uno strumento
multicampione.

Per riprodurre in modo realistico il timbro e
la gamma di vari strumenti musicali sono
generalmente necessari pitl campioni.
Registrando pitu campioni che catturano le
varie gamme dinamiche e di frequenza,
quindi mappandoli nei gruppi di note e
nelle zone di velocity, & possibile emulare
la sorgente originale in modo molto
accurato e preciso.

Tutti gli strumenti multicampione nei CD-
ROM SampleCell sono gia mappati,
pertanto nelle sezioni seguenti verranno
analizzati per illustrare il funzionamento
delle zone di velocity e dei gruppi di note.

Gruppi di note

I campioni sono mappati lungo I'asse
orizzontale sulle varie gamme di note
chiamate gruppi di note. Il numero di
gruppi di note pud essere compreso tra uno
che copre I'intera tastiera fino a 60 (se la
memoria lo consente).

Zone di velocity

Ciascun gruppo di note contiene zone di
velocity. La maggior parte dei suoni e degli
strumenti acustici in natura presentano
timbri diversi a seconda del volume. Per
questo motivo, ¢ utilizzata anche la
mappatura della velocity (oltre alla
mappatura del tono) in modo che i vari
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campioni che sono stati registrati a varie
intensita possano essere assegnati alle
corrispondenti gamme di velocity.

SampleCell puo avere fino a sei
campioni/zone di velocity per gruppo di
note. Il campione nellazonadi velocity che
corrispondente alla velocity MIDI in
ingresso verra attivato.

La finestra Sample Map mostrata nella
Figura 7 illustra uno strumento che utilizza
3 zone di velocity e 8 gruppi di note.

Questo strumento é composto da 24
campioni. | nomi dei campioni sono
seguiti dal suffisso p, m, o f per indicare la
zona di velocity desiderata.

Sample Map ——————————1|

Bosendorfer 1 ¥

3 Mo |
ol s L % R
[2f (21 [L#3f c*4r Fedf

88 [EOSEN O Im |BOGEN C[EOSENF |EOSEN  [BOGEN  [BOGEN [FOSENE 4m
fom D*3m  [C*am [FRam

3 |[BOSEN A Op [EOSEN D 1p |BOGEN C|EOSENF [EQREN  [GOSEN  [GOSEM [EOSENE dp
l2p lb*ap c*4p  [Foap

Figura 7. Finestra Sample Map per “Bosendorfer 1”

Le zone di velocity possono anche essere
utilizzate per selezionare successivamente
suoni completamente differenti. Un
classico esempio ¢ il basso con un suono
“diteggiato” nella zona di velocity
inferiore, e un campione “pop” nella zona
superiore. Le note riprodotte a un volume
piu elevato azionano i campioni pop,
mentre velocity MIDI piu basse azionano
un basso con diteggiatura normale.



0O Per esempi supplementari di zone di
velocity con vari campioni consultare “Idee per
I’esecuzione di strumenti ensemble” a
pagina 89.

Selezione di Campioni (gruppi di note
e zone di velocity) nella finestra
Sample Map

Prima che sia possibile modificare i
parametri del campione di un gruppo di
note o di una zona di velocity, occorre
selezionare il campione appropriato nella
finestra Sample Map.

Per selezionare manualmente un campione:
= Fare clic sui gruppi di note/zone di
velocity desiderati nella finestra Sample
Map.

- O -
= Fare clic sulla tastiera sullo schermo per
selezionare un gruppo di note, quindi fare
clic sulla scala di velocita per selezionare
una zona entro tale gruppo di note.

Per selezionare un campione utilizzando la
tastiera del computer:

0 In una zona qualsiasi tra quelle gia
selezionate premere la freccia destra (o il
tasto di tabulazione) per selezionare i
gruppi di note sulla destra. Premere la
freccia sinistra (o i tasti Maiusc e Tab) per
selezionare i gruppi di note sulla sinistra.
Premere le frecce Su/Giu per selezionare
una zona di velocity superiore/inferiore.

Per selezionare un campione utilizzando un
controller MIDI:

o Selezionare I'opzione MIDI Selects Zone,
situata vicino all'angolo superiore destro
della finestra Sample Map.

Con l'opzione selezionata, la riproduzione
di una nota nel controller MIDI seleziona
un campione nella velocity e nella gamma
di note MIDI appropriate. La possibilita di
selezionare gruppi di note/zone tramite
MIDI e sempre attiva mentre si effettua il
montaggio nella finestra Sample
Parameters.

Montaggio di gruppi di note

Una volta che i campioni sono stati caricati
nella finestra Sample Map di uno
strumento, la loro posizione e larghezza del
gruppo di note possono essere modificate
in vari modi. Inoltre, vari parametri del
gruppo di note, quali Zone Start (o dove
iniziera la riproduzione nel campione)
possono essere modificate nella finestra
Sample Parameters. Quando si sposta un
gruppo di note, tutte le zone di velocity in
tale gruppo vengono spostate assieme e il
gruppo di note conserva la propria
larghezza (ovvero lagamma del tasto) dopo
che e stato spostato.

Spostamento, montaggio,
sostituzione ed eliminazione di
campioni

Vi sono molti modi per ridisporre e
ricostruire campioni che costituiscono la
finestra Sample Map di uno strumento.

E possibile riordinare i gruppi di note
manualmente trascinandoli in nuove
posizioni ed ¢ possibile ridimensionarli
trascinandone il limite superiore/inferiore
in nuove posizioni. Inoltre, é possibile
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utilizzare vari pulsanti con funzioni
speciali affinché SampleCell ordini/riordini
automaticamente i gruppi di note.

Per trascinare un Gruppo di note in una nuova
posizione:

= Trascinare in una nuova posizione la
zona di velocity piu bassa in un gruppo di
note. Tutte le zone nel gruppo di note
verranno spostate e manterranno la loro
dimensione (gamma).

Il comando Reorder Key Groups By Root
Note (Riordina gruppi di note per nota di
origine) consente di rimappare i gruppi di
note in base alla nota di origine, dalla
minore alla maggiore. Se sono appena stati
caricati piu campioni, questo comando
offre un modo rapido per ordinarli per nota
di origine nella finestra Sample Map.

i
il
Pulsante Reorder Key Groups By Root Note

Se vi & piu di una zona di velocity nel
gruppo di note, le zone verranno spostate
con i gruppi di note corrispondenti. In altre
parole tutte le zone verranno rimappate in
base alla nota di origine della zona di
velocity piu bassa nel gruppo di note. (Per
ulteriori dettagli vedere “Nota di origine
MIDI” a pagina 45).

Per ordinare la posizione dei gruppi di note
per nota di origine:

= Fare clic sul pulsante Reorder Key Groups
By Root Note o scegliere Instruments >
Reorder Key Groups By Root Note.

Tutti i gruppi di note nella finestra Sample
Map corrente verranno riordinati in base
alla loro nota di origine MIDI.
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Ridimensionamento dei gruppi di note

E possibile ridimensionare i gruppi di note
manualmente o automaticamente. Inoltrei
limiti superiore e inferiore di una zona di
velocity possono essere modificati
manualmente.

Per modificare manualmente la gamma di un
gruppo di note:

= Trascinare la linea del limite del gruppo
di note nella posizione desiderata. Il
gruppo di note adiacente verra accorciato o
allargato per adattarlo all'operazione di
ridimensionamento.

Distribuzione dei gruppi di note

Pulsante Spread Key Groups

E possibile ridimensionare i gruppi di note
selezionati in modo che siano
uniformemente distribuiti su tutta la
tastiera. Le larghezze di tutti i gruppi di
note a destra del gruppo di note
correntemente selezionato (o tutti se non
ne é stato selezionato nessuno)
diventeranno uniformi.

Ad esempio, la Figura 8 mostra la finestra
Sample Map di uno strumento prima
dell'utilizzo del comando Spread Key
Groups (Distribuisci gruppi di note).
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Figura 8. Sample Map prima dell'utilizzo di Spread
Key Groups

Una volta fatto clic sul pulsante Spread Key
Groups la finestra Sample Map dello
strumento diventa uniforme, come
illustrato nella Figura 9.

|W
|W
[ [Z07
Figura 9. Sample Map dopo dell'utilizzo di Spread
Key Groups

Per distribuire tutti i gruppi di note
uniformemente su tutta la gamma dello
strumento:

= Fare clic sul pulsante Spread Key Groups
nella finestra Sample Map. Tutti i gruppi di
note a destra del gruppo di note
selezionato, incluso quest'ultimo, verranno
distribuiti uniformemente su tutta la
tastiera.

Regolazione dei limiti della zona di
velocity

E possibile regolare manualmente i limiti
della zona di velocity trascinandoli.

Per modificare la gamma di un zona di
velocity:

= Trascinare la linea del limite dellazona di
velocity nella posizione desiderata. La zona
di velocity adiacente verra accorciata o
allargata per adattarla all'operazione di
ridimensionamento.

O E possibile modificare
contemporaneamente la gamma di tutte le
zone di velocity, tenendo premuto il tasto
Opzione e trascinando (Macintosh) oppure
tenendo premuto il tasto Alt e trascinando
(Windows) il limite di una zona di velocity
gualsiasi. Notare che tutte le zone avranno
quindi tutte le stesse impostazioni per il limite
(le singole impostazioni vengono perdute).

Sostituzione ed eliminazione di
campioni

Il modo piu facile per sostituire ed
eliminare i campioni & mediante la finestra
Sample Map. Cio rende possibile la
creazione di modelli di strumenti mappati
precedentemente, per costruire
rapidamente strumenti.

E possibile sostituire rapidamente un
campione con un altro utilizzando il
pulsante Change Sample.

Per sostituire un campione:

1 Selezionare il campione da sostituire
facendo clic sul gruppo di note o zona di
velocity appropriati.
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2 Fare clic sul pulsante Change Sample o
scegliere Instruments > Change Sample.

Pulsante Change Sample

3 Selezionare un campione per sostituire il
primo campione.

4 Fare clic su Play per ascoltare il campione
del suono con il tono originale.

5 Fare clic su Open per caricare il campione
selezionato. Il nuovo campione verra
visualizzato nella finestra Sample Map con
gli stessi gruppo di note e zona di velocity
di quelli sostituiti.

Per scaricare un campione selezionato:
= Scegliere Instruments > Unload Sample.

Il campione selezionato sara scaricato da
SampleCell RAM, e lo strumento manterra i
limiti del gruppo di note e della zona di
velocity del campione. Il nome del
campione verra visualizzato in corsivo
nella finestra Sample Map.

Per ricaricare un campione che é stato
scaricato:

1 Selezionare il gruppo di note/zona di
velocity del campione.

2 Fare clic sul pulsante Reload Sample o
scegliere Instruments > Load Sample.

[

+

—
Pulsante Load Sample

Il campione viene ricaricato nel relativo
gruppo di note/zona.
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0O Per impostare SampleCell in modo che
vengano caricati i campioni quando si apre un
banco o uno strumento, vedere “Automatically
load samples” a pagina 103.

Ciascun gruppo di note nella finestra
Sample Map puo contenere fino a 6 zone di
velocity. | campioni in queste zone
possono essere ridisposti nel gruppo di
note trascinando la zona in una nuova
posizione.

Per spostare un campione in una nuova
posizione nella zona di velocity:

= Posizionare il puntatore sul
campione/zona di velocity da spostare e
trascinare il campione verso l'alto o il basso
nella nuova posizione desiderata.

Per eliminare un gruppo di note o una zona di
velocity:

1 Selezionare il gruppo di note o lazona da
eliminare.

2 Scegliere Edit > Clear. In questo modo
verranno rimossi dalla finestra Sample Map
il gruppo di note o la zona di velocity, mail
campione restera nella memoria di
SampleCell.

Per scaricare un campione:
1 Selezionare il campione da eliminare.
2 Scegliere Instruments > Unload Sample.

Generalmente i campioni rimangono nella
memoria di SampleCell dopo aver chiuso
un banco o eliminato uno strumento. E
possibile impostare SampleCell in modo
che tutti i campioni vengano scaricati
automaticamente quando si chiudono i
banchi o si eliminano gli strumenti. A



questo scopo, selezionare lI'opzione
Automatically Delete Unused Samples
nella finestra Preferences.

Altri parametri Sample Map

Nota di origine MIDI

Quando un campione viene assegnato alla
finestra Sample Map, il campione di origine
deve essere assegnato a una nota che viene
chiamata nota di origine MIDI. Non é
necessario che la nota di origine sia dello
stesso tono del campione (infatti la nota di
origine predefinita C4), ma se si imposta la
nota di origine MIDI sul tono del campione
di origine si otterranno risultati piu
realistici.

E possibile invece personalizzare i suoni
impostando la nota di origine su un tono
diverso. Ad esempio, se si carica un
campione di tromba (si supponga una
tromba C3) e si imposta la nota di origine
su C4, la tromba avra un suono piu alto di
un'ottava, che potrebbe essere accettabile
per una tuba.

SampleCell Il pud riprodurre un campione
soltanto entro una gamma di tre ottave piu
alta rispetto al tono originario; le note
superiori a tale gamma verranno riprodotte
nell'ottava piu alta consentita del
campione.

Impostazione della nota di origine
MIDI

(]

+—F

A volte i campioni vengono caricati in
SampleCell senza che venga definita una
nota di origine. E possibile aprire la finestra
Sample Parameters di un gruppo di note e
immettere manualmente le singole note di
origine, o trascinare l'indicatore della nota
di origine in una posizione appropriata
nella tastiera della finestra Sample Map
visualizzata sullo schermo.

Per assegnare manualmente la nota di
origine MIDI:

1 Fare clic sull'icona della tastiera associata
alla nota di origine MIDI. Viene
visualizzata una piccola tastiera.

[FOSEND im |[BOSENC [BOSENF |BOSEM  [BOSEW  |DOSEW |BOSEN B 4m
l2m f2m p*3m  [c%am  [FRam

[BOSEN A Op [BOSENC [BOSENF [GOSEN  [BOSEN  [BOSEN [BOSEN B 4p
[2p p=3p co4p  |Feap

Nota di origine MIDI impostata su C4
Assegnazione della nota di origine MIDI

2 Trascinare lungo la tastiera finché non é
evidenziata la nota di origine desiderata.

Per impostare o modificare la nota di origine
di tutti i gruppi di note in uno strumento:

1 Fare clic sul pulsante Set Root Note o
scegliere Instruments > Set Root Notes.

2 Scegliere tra:
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Reassign the root notes for all
the zones in this instrument,
using the method selected
below?

@ Use Audio File
I Middle
) Highest
O Lowest

[0k |

Finestra di dialogo Root Note

0 Low: posiziona la nota di origine nella
nota piu bassa del gruppo di note.

0 Middle: posiziona la nota di origine nella
nota centrale del gruppo di note.

0 High: posiziona la nota di origine nella
nota piu alta del gruppo di note.

0 Use Audio File: posiziona la nota di
origine in base a una delle seguenti
condizioni.

e Se il campione € un file AIFF, viene
utilizzata la nota di origine
memorizzata nel file.

« Se il campione ¢ un file SDII, la nota
predefinita &€ C4 (C medio).

3 Fare clic su OK per modificare la nota di
origine.

Pulsante Loop

Icona del pulsante Loop

Tramite il pulsante Loop sara possibile
caricare il campione correntemente
selezionato nella finestra Edit Loops. Per
ulteriori informazioni sul looping dei
campioni vedere il Capitolo 6: Montaggio dei

campioni, esecuzione di loop e trim dell'audio.
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Parametri del campione

A

Pulsante diapason

Tramite il pulsante diapason ¢ possibile
aprire la finestra Sample Parameters per il
gruppo di note/zona selezionati.

La finestra Sample Parameters mette a
disposizione i controlli per I'ampiezza del
campione, lI'accordatura, la direzione, il
punto di inizio dell'offset e I'accordatura
del loop.

Per accedere alla finestra Sample
Parameters:

1 Selezionare un gruppo di note/zona di
velocity nella finestra Sample Map.

2 Fare clic sul pulsante diapason o fare
doppio clic sul campione desiderato nella
finestra Sample Map.

[[] Sample Parameters x|

e
Ec

:

Frecce di selezione del campione

|

[ A2 | yen)
(=)
(J

Finestra Sample Parameters

E possibile modificare vari gruppi di
note/parametri del campione della zona
utilizzando le frecce di selezione del
campione (o i tasti di direzione della



tastiera del computer) nella parte superiore
destra della finestra Sample Parameters,
come mostrato di seguito:

Frecce di selezione del campione

< Tramite la freccia su (o il tasto PagSu) &
possibile selezionare la zona di velocity
successiva piu alta nel gruppo di note
corrente.

e Tramite la freccia destra (o tasto Tab) é
possibile selezionare la zona piu bassa
nel gruppo di note successivo piu alto.

< Tramite la freccia giu (o il tasto PagGiu) &
possibile selezionare la zona di velocity
successiva piu bassa nel gruppo di note
corrente.

e Tramite la freccia sinistra (o tasto Maiusc)
& possibile selezionare la zona piu bassa
nel gruppo di note successivo pitl basso.

« |l tasto Home seleziona la zona di
velocity piu bassa rimasta.

E inoltre possibile selezionare campioni nei
rispettivi gruppi di note e zone via MIDI se
e selezionata l'opzione MIDI Selects Zone.

Parametri della zona e
parametri del campione

E possibile copiare e incollare gli strumenti
per crearne delle copie. Si tratta di un
metodo che fa un uso efficiente della
memoria per chorus, doubling
(sdoppiamento) e altri effetti.

Se il banco corrente utilizza pit copie dello
stesso campione in uno o piu strumenti
contemporaneamente, tenere presente che
alcuni dei controlli disponibili nella

finestra Sample Parameters avranno un
effetto globale, mentre altri verranno

applicati soltanto allo strumento corrente.

Parametri del campione

Le modifiche apportate ai seguenti
parametri del campione verranno udite in
tutti gli strumenti correntemente aperti in
cui viene utilizzato tale campione.

I controlli Sample Start e Sample Fine Tuning della
finestra Sample Parameters

Sample Start Coarse, Sample Start Medium
e Sample Fine Tuning sono parametri
globali del campione. Inoltre, Sus e Rel
Loop Fine Enable/Fine Tune (e Sus/Rel
Enable/Fine Tune) sono controlli globali
del campione disponibili quando nel
campione vi sono uno o due loop. Per
ulteriori informazioni sui loop, vedere il
Capitolo 6: Montaggio dei campioni,
esecuzione di loop e trim dell*audio.
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Parametri della zona (specifici per lo
strumento)

L'effetto dei seguenti controlli per i
parametri della zona e il pan del gruppo di
note verra udito soltanto nello strumento
che contiene il campione correntemente
selezionato.

Pan del gruppo di note e parametri della zona

Key Group pan, Fine (Sample Start), MIDI
Root Note, Direction e Amplitude sono
parametri specifici per la zona. Inoltre,
nell'area Start Offset viene visualizzato
I'offset cumulativo applicato al campione
da tutti i controlli Sample/Zone Start.

Parametri della zona

Pan del gruppo di note

E possibile eseguire il pan su ciascun
gruppo di note nella finestra Sample Map.
Un'applicazione di questa funzione
potrebbe essere un pianoforte stereo, in cui
sui campioni inferiori viene eseguito il pan
piu verso sinistra, mentre su quelli
superiori piu verso destra. Un altro
potrebbe essere uno strumento con tastiera
separata con uscite separate risultanti da
pan hardware su canali opposti.
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Per madificare il pan di un determinato
gruppo di note:

1 Trascinare il dispositivo di scorrimento di
Key Group Pan (se lo si desidera, mentre
in corso la riproduzione del campione via
MIDI). Verra eseguito il pan di tutto il
gruppo di note del campione
nell'immagine stereo dello strumento
(come stabilito con il dispositivo di
scorrimento Instrument Pan nella finestra
Bank).

0 Tenere premuto il tasto Control e fare clic
(Macintosh) o fare clic con il pulsante destro
(Windows) sul dispositivo di scorrimento Key
Group Pan per controllarlo dal controller MIDI.

E inoltre possibile simulare un effetto
simile al pianoforte stereo descritto sopra,
senza modificare il pan del gruppo di note
per ciascun campione e utilizzare la finestra
Matrix per mappare MIDI Note Numbersin
modo che venga controllato il pan dello
strumento. Per ulteriori dettagli vedere
“Modulazione della matrice” a pagina 56.

Inizio di zona - Fine

E possibile modificare il punto in cui inizia
la riproduzione nella forma d'onda di un
campione. Cio & veramente utile se si
desidera la porzione sostenuta di un
campione, tuttavia tutta o parte della
caratteristica del suo attacco iniziale non lo
e.

E possibile regolare Sample Start mediante
tre dispositivi di scorrimento differenti,
due dei quali sono parametri del campione
mentre uno, il dispositivo di scorrimento
Fine, € un parametro di zona. Il dispositivo
di scorrimento Fine consente di regolare il



punto iniziale del campione per incrementi
minimi, che hanno effetto soltanto sullo
strumento corrente.

Per regolare il punto iniziale del campione:

0 Regolare il dispositivo di scorrimento
Fine situato nell'area Zone Parameters della
finestra Sample Parameters.

Ciascun incremento rappresenta 256
campioni per un offset totale possibile di
32.512 campioni. Il campione corrente €
visualizzato nell'offset iniziale del
parametro della zona.

Direzione

Un campione puo anche essere riprodotto
in avanti (dall'inizio alla fine) o all'indietro
(dalla fine all'inizio). Nella modalita
all'indietro vengono ignorate le
impostazioni di loop, in quanto si tratta di
una modalita utile soprattutto per gli effetti
speciali.

Per modificare la direzione di riproduzione di
un campione:

0 Fare clic su Forward o Backward per
selezionare la direzione desiderata.

Ampiezza della zona

E possibile attenuare I'ampiezza (volume)
di una zona utilizzando il dispositivo di
scorrimento Zone Amplitude. Si
contribuisce cosi a creare il bilanciamento
corretto nei vari campioni che
compongono uno strumento.

Per attenuare il volume di un campione:

0 Trascinare il dispositivo di scorrimento
Zone Amplitude.

Ciascun incremento rappresenta 0,5 dB per
una gamma totale di 50 dB.

Nota di origine MIDI

I controlli della nota di origine MIDI (la
tastiera a comparsa e il display con valori
modificabili) eseguono la trasposizione del
campione. La nota di origine MIDI
predefinita & C4. Vedere “Nota di origine
MIDI” a pagina 49 per ulteriori
informazioni.

Parametri del campione

I campioni possono essere accordati in due
modi. L'accordatura complessiva di un
campione potrebbe richiedere delle
correzioni affinché il tono sia compatibile
con quello degli altri campioni dello
strumento e un loop di sostenimento o un
loop di rilascio a volte influenza il tono
durante la riproduzione del loop.

Per regolare il campione selezionato:

1 Regolare il dispositivo di scorrimento
Sample nell'area Sample Fine Tuning, per
aumentare o diminuire il tono del
campione. E possibile regolare i dispositivi
di scorrimento mentre il campione viene
attivato via MIDI.

La gamma del dispositivo di scorrimento &
+ 1/4 di tono. Se un campione in memoria
e utilizzato da piu di uno strumento,
gruppo di note o zona di velocity, la
modifica della regolazione nel modo sopra
descritto si ripercuotera su tutti gli
strumenti in tale campione.
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Accordatura dei loop

E possibile cambiare l'accordatura di
qualsiasi loop abilitato utilizzando i
dispositivi di scorrimento Loop Tuning
della finestra Sample Parameters.

Per regolare il loop Sus/Rel:

0 Trascinare il dispositivo di scorrimento
Sus/Rel Tune per trasporre la porzione in
loop del campione. E possibile ascoltare
I'effetto di tali impostazioni quando si
attiva il campione via MIDI.

La gamma del dispositivo di scorrimento é
+ 1/4 di tono.

Per regolare la porzione loop di sostenimento
di un campione:

0 Trascinare il dispositivo di scorrimento
Sus Tune per trasporre soltanto il loop di
sostenimento. Se nel campione vi
soltanto un loop, il dispositivo di
scorrimento Sus tuning non verra abilitato.
E possibile ascoltare I'effetto di tali
impostazioni quando si attiva il campione
via MIDI.

La gamma del dispositivo di scorrimento é
+ 1/4 di tono.

I loop di sostenimento e rilascio possono
anche essere attivati e disattivati in modo
indipendente. Per ulteriori informazioni
vedere il Capitolo 6: Montaggio dei campioni,
esecuzione di loop e trim dell*audio.

Per attivare/disattivare il loop di
sostenimento:

0 Selezionare I'opzione Sus/Rel Loop.

Per attivare/disattivare il loop di rilascio:
0 Selezionare I'opzione Sus Loop Enable.
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0 Se un campione presenta solo un loop,
allora viene utilizzato come sostenimento e
rilascio (“sus/rel” nella finestra Sample
Parameters). Se invece vi sono due loop, il
primo sara il loop di sostenimento e il secondo
quello di rilascio. | loop non si devono
sovrapporre.

Accordatura dei loop e scambio dei
loop

Per brani parlati, frasi brevi e altri campioni
di parlato, € possibile ottenere risultati
interessanti provando varie impostazioni
dei due loop. Utilizzare le finestre Matrix ed
Envelope per controllare il bilanciamento
tra il primo e il secondo loop, quindi
attivare e controllare la sincronizzazione
con uno dei tasti del controller MIDI.
Consultare la descrizione del pulsante
Loop Switch in “Modifica dei loop:
scambio dei loop, crossfade” a pagina 76.

Parametri Misc

La finestra Misc dispone di controlli: pitch,
filter frequency, crossfade, key track, pitch
tracking, intonation, MIDI filtering, voice
overlap e priority e velocity sensitivity.

Per aprire la finestra Misc:

= Selezionare Windows > Misc o fare clic
sul pulsante Misc.

iz I

Pulsante Misc




Il nome dello strumento correntemente
selezionato é visualizzato nella finestra a
comparsa Instrument. E possibile utilizzare
questa finestra a comparsa in tutte le
finestre di montaggio e modulazione, per
modificare tali impostazioni per uno
strumento diverso.

Tite Room Drums 1%

Qﬂj

Finestra Misc

Disabilitazione del tracciamento del
tono

A volte & preferibile che i campioni siano
sempre riprodotti nei loro toni di origine, a
prescindere dalla nota MIDI riprodotta. Gli
effetti sonori e i kit di percussioni sono due
esempi classici. Ciascun strumento puo
essere impostato per trasporre i campioni
ad esso associati in base ai valori delle note
MIDI o per riprodurre sempre i campioni
nel loro tono di origine.

Per disattivare i cambiamenti di tono in uno
strumento:

0 Nella finestra Misc deselezionare Key
Track. La risposta del tono & disabilitata
quando Key Track & deselezionato.

E possibile configurare SampleCell in modo
che le impostazioni predefinite di Key
Track siano disattivate quando vengono
creati nuovi strumenti. Cio0 sarebbe pratico

in una situazione dove nuove serie di
strumenti vengono sviluppate, ciascuna
con una singola percussione o effetto
sonoro.

Per disattivare Key Track come impostazione
predefinita:

1 Scegliere SampleCell > Preferences.

2 Deselezionare I'opzione Key Track per
Default New Instruments.

Per ulteriori informazioni sulle preferenze
di SampleCell consultare il

Capitolo 8: Scheda di riferimento di
SampleCell I1.

Risposta di velocity

Una delle poche funzionalita con
collegamento hardware in SampleCell 11 &
il routing della velocity MIDI al volume. Il
dispositivo di scorrimento Velocity nella
finestra Misc consente di regolare
singolarmente la risposta di velocity di
ciascuno strumento.

Per modificare la velocity di risposta MIDI di
uno strumento:

0 Nella finestra Misc trascinare il
dispositivo di scorrimento Velocity sul
livello desiderato.
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Con la velocity impostata su 0, non vi
risposta alla velocity (ovvero, le note sono
attivate o disattivate); impostazioni
positive producono un aumento del
volume con l'aumento della velocity,
mentre impostazioni negative fanno
diminuire il volume con l'aumentare della
velocity.

O Se tutti gli strumenti in tutti i banchi non
rispondono correttamente ai comandi,
controllare le impostazioni della velocity o
della curva di velocity nel controller MIDI. La
regolazione del dispositivo master avra quindi
un effetto globale su tutti gli strumenti
SampleCell.

Un utilizzo pratico della velocity negativa é
il crossfade tra due strumenti in base
all'intensita con cui si preme un tasto. Si
supponga di avere due strumenti in un
banco, ad esempio uno a corda e un ottone,
assegnati allo stesso canale MIDI, e che si
desiderino soltanto strumenti “a corda”
quando si riproduce musica a velocity
bassa, entrambi gli strumenti a velocity
media, e soltanto gli ottoni nelle
riproduzioni a velocity elevata. Cid pud
essere ottenuto assegnando un velocity
negativa moderata agli strumenti a corda e
una velocity positiva sufficientemente
elevata agli ottoni.

Crossfade della velocity dello
strumento

La finestra Misc mette a disposizione una
funzione crossfade che consente di
impostare tra due strumenti un crossfade
controllato dalla velocity. Cio ¢ diverso
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dall'esempio precedente ed elimina il
bisogno di operare con valori di velocity
negativi.

Per utilizzare la funzione crossfade nella
finestra Misc, due strumenti vengono
nuovamente assegnati allo stesso canale
MIDI. Uno strumento € impostato per il
crossfade, l'altro no. Quando uno
strumento & impostato per il crossfade,
vengono modificate le curve di velocity di
entrambi gli strumenti nel canale; lo
strumento su cui é stato eseguito il
crossfade fornisce una risposta significativa
soltanto alle velocity piu basse, mentre
quello su cui non é stato eseguito il
crossfade risponde soltanto alle velocity
aumentate.

Per implementare il crossfade tra due
strumenti:

1 Impostare gli strumenti in modo che
rispondano sullo stesso canale MIDI.

2 Fare clic sul pulsante Ins Vel Crossfade
nella finestra Misc dello strumento che
deve rispondere alle basse velocity.

0 Eseguendo il crossfade vengono assegnate
due voci per ciascuna nota riprodotta. Se, ad
esempio, si riproducono quattro note con una
coppia di strumenti su cui & stato eseguito il
crossfade, verranno utilizzate otto voci.

Assegnazione della voce

Come succede per molti strumenti musicali
elettronici, in SampleCell 1l & possibile
assegnare le voci in vari modi. Ad esempio,
& possibile assicurarsi che solo uno
strumento possa riprodurre una sola nota
alla volta (in altre parole lo strumento é
monofonico).



Per selezionare la risposta monofonica:

0 Fare clic sul pulsante Monophonic nella
finestra Misc. Lo strumento rispondera
soltanto all'ultima nota riprodotta (“last-
note priority”). Accertarsi che l'opzione sia
deselezionata se si desidera la risposta
polifonica.

Quando si utilizzano piu voci
contemporaneamente (ad esempio con un
pianoforte sostenuto o una sequenza molto
ricca di suoni), € possibile che si superi il
limite delle 32 voci di SampleCell. Per
ridurre al minimo l'effetto di tale limite, é
possibile assegnare a ciascuno strumento
una priorita sonica che verra presa in esame
se vengono richieste troppe voci.

Per regolare I'assegnazione della priorita
della voce di uno strumento:

0 Nella finestra Misc trascinare il
dispositivo di scorrimento Sound Priority
sulla posizione desiderata e rilasciare.

Lo e adatto a strumenti e attenuazioni in
sottofondo in cui una o due voci “rubate”
non vengono immediatamente notate nel
missaggio sonoro complessivo. Hi & piu
adatto per la melodia e strumenti “in primo
piano”, quando generalmente non si
desidera perdere una voce.

Vi sono anche situazioni in cui é piu
importante stabilire che alle note esistenti
sia consentito di essere riprodotte, anche se
si rilascia il tasto e immediatamente dopo
lo si ripreme. Un esempio & il cembalo: se si
preme di nuovo la nota in rapida
successione per aggiungere un NUOVoO
transiente, non si annullano le vibrazioni
residue generate dalla prima pressione della
nota. Il pianoforte € un esempio piu
sofisticato: Anche quando le note sono

riprodotte in staccato, la scheda sonora
vibra ancora leggermente. Invece un
organo o una batteria ridotta non
presentano tali caratteristiche. In
SampleCell questo concetto viene
affrontato con una funzione di
“sovrapposizione” che modifica la fase di
rilascio della nota precedente, quando la
stessa nota viene attivata di nuovo.

Per specificare come le note riattivate
verranno sovrapposte:

0 Riprodurre ripetutamente una nota nel
controller MIDI mentre si trascina il
dispositivo di scorrimento Overlap
Amount sul valore desiderato.

Un'impostazione pari a O indica nessuna
sovrapposizione, ogni nota viene strozzata
o silenziata sostenendo le note. Un valore
pari a 99 rappresenta l'intero valore della
fase di rilascio dello strumento.

Inviluppi

L'uso principale di un inviluppo € quello di
controllare I'ampiezza del suono e questo &
il motivo per cui il parametro di inviluppo
Envelope 3 in SampleCell e
permanentemente impostato su
Amplitude. Un inviluppo, da un punto di
vista musicale, puo essere utile anche in
altri modi. Ad esempio, se si utilizza
I'inviluppo su un oscillatore LFO, si
potrebbe produrre un vibrato ritardato.

Gli inviluppi emettono un segnale di
controllo che si forma gradualmente in
relazione all'intensita con cui é stata
premuta una nota, quanto viene tenutae la
lentezza con la quale viene rilasciata.
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Quando una nota viene azionata in un
inviluppo tradizionale ADSR
(Attack/Decay/Sustain/Release), il segnale
aumenta da zero al livello massimo
dell'inviluppo, quindi si abbassa in base al
tasso di decadimento su un livello di
sostenimento. Questo livello di
sostenimento € mantenuto finché non
viene premuto un tasto, quindi il segnale
ritorna a zero in base alla velocita di
rilascio.

sustain release

amplitude

sustain level |

A

gate on gate off

Un inviluppo ADSR

Gli inviluppi SampleCell presentano
alcune aggiunte: con Sustain Decay €
possibile avere un decadimento ridotto
durante il sostenimento e dopo la normale
fase di decadimento; in Gate Time viene
specificato il tempo minimo affinché
I'inviluppo venga mantenuto “aperto”
indipendentemente dal fatto che la nota
sia stata tenuta o meno. Ad esempio,
qualsiasi effetto ambiente alla fine di un
suono di batteria andrebbe perduto se la
nota venisse rilasciata istantaneamente
dopo essere stata riprodotta, a meno che
non sia stato impostato Gate Time.

Per accedere a un inviluppo:

1 Fare clic sull'icona Envelope sulla barra
degli strumenti della finestra Bank o
scegliere Windows > Envelope.
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Icona Envelope

2 Utilizzare la barra di scorrimento e la
casella di dimensionamento per
visualizzare i parametri di Envelope 1,
Envelope 2 ed Envelope 3.

Figura 10. Finestra Envelope (i 3 riquadri Envelope
vengono visualizzati)

Opzioni di visualizzazione
dell'inviluppo

| controlli Envelope possono essere
visualizzati in vari modi. Nella finestra
Envelope é possibile visualizzare punti di
interruzione/segmenti o i controlli
scorrevoli ADSR. La Figura 10 mostra i
segmenti inviluppo.

Per specificare come verranno visualizzati i
parametri dell'inviluppo:

1 Scegliere SampleCell > Preferences.
2 Eseguire una delle seguenti operazioni:



« Selezionare Display Line Segment
Envelopes per la vista con segmenti di
linea. Questo non avra effetto sulla
visualizzazione di una finestra Envelope
aperta; occorrera chiuderla e riaprirla per
poter visualizzare le modifiche.

« Deselezionare Display Line Segment
Envelopes per mostrare i valori
dell'inviluppo come dispositivi di
scorrimento.

La Figura 11 mostra una finestra Envelope
nella vista Slider:

m Envelopes

Tstring

L=

Figura 11. Finestra Envelope, nella quale vengono
visualizzati i valori di unita reali nella vista Slider

| parametri Envelope vengono modificati
regolando i rispettivi dispositivi di
scorrimento (vista Slider) o trascinandone i
punti finali (vista con segmenti ).

I parametri Envelope possono essere
visualizzati in millisecondi o in unita
SampleCell.

Per visualizzare i valori di inviluppo in unita
reali (ms.):

0 Nella finestra di dialogo Preferences

selezionare Display Controls in Real Units.

Quando si creano o modificano i parametri
di un inviluppo, attenersi alle seguenti
linee guida:

0 Per controllare quanto tempo impiega
un inviluppo per passare dall'assenza di
livello al valore impostato dall'ampiezza
del percorso di modulazione, trascinare
Attack sul valore desiderato e rilasciare.

0 Per controllare quanto tempo impiega
un inviluppo per passare dal livello
massimo al livello di sostenimento,
trascinare Decay sul valore desiderato e
rilasciare.

0 Per controllare il livello che un inviluppo
potra sostenere mentre un riduttore e
attivo, trascinare Sustain sul valore
desiderato e rilasciare.

0 Per controllare quanto tempo impiega
un inviluppo per passare dal livello di
sostenimento a un livello leggermente
inferiore, trascinare Sustain Decay sul
valore desiderato e rilasciare.

0 Per controllare gquanto tempo impiega
un inviluppo per passare dal livello del
decadimento di sostenimento all'assenza di
livello, trascinare Release sul valore
desiderato e rilasciare.

0 Per controllare il tempo minimo per il
quale un inviluppo manterra un riduttore,
trascinare dispositivo di scorrimento Gate
Time sul valore desiderato e rilasciare.

0 Per determinare la quantita di segnale di
inviluppo che & disponibile per il
dispositivo di scorrimento Amplitude del
percorso di modulazione, trascinare il
dispositivo di scorrimento Envelope
Amplitude sul valore desiderato e rilasciare.

Gli inviluppi possono anche tenere traccia
della tastiera in modo che i tempi
dell'inviluppo siano accorciati
progressivamente e uniformemente
all'aumentare del tono e che siano
allungati al diminuire dello stesso. Cio ¢
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particolarmente utile nella simulazione
degli strumenti acustici (ad esempio, l'aria
impiega piu tempo per spostarsi in una
tuba che in una tromba).

Affinché un inviluppo tracci le note MIDI in
ingresso:

0 Fare clic su Keyboard Track nella finestra
Envelope e fare di nuovo clic per ritornare
all'impostazione normale.

Modulazione della matrice

Le funzioni di modulazione della matrice
non sforniscono soltanto un potente modo
per personalizzare I'ampia raccolta di
strumenti SampleCell ma, se si pensa ai
campioni come forme d'onda, trasformano
SampleCell stesso in un vero e proprio
sintetizzatore.

La modulazione della matrice consente di
modulare qualsiasi destinazione
disponibile (ovvero, un parametro
SampleCell quale strumento volume/pan,
filter cutoff, envelope, LFO, e cosi via.), con
qualsiasi sorgente di controllo disponibile
(controllo Modulation o controllo Pitch,
velocity, pressione, controller MIDI, e cosi
via).

Per accedere ai controlli di modulazione della
matrice di uno strumento:

= Selezionare lo strumento nella finestra
Bank e fare clic sul pulsante Matrix sulla
barra degli strumenti della finestra Bank.

|

Icona Matrix
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= Scegliere Windows > Matrix.

Tite Roorn Drums 1%

yelocit -
Yelacit
Modulation Wheel -
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Sustain Pedal b Envelope 3 Release

Pitch ‘itheel

Finestra Matrix

Utilizzare la finestra Matrix per designare i
percorsi di modulazione dello strumento
selezionato; ciascun percorso di
modulazione € composto da una sorgente,
una destinazione, un attributo di riduzione
e una quantita di modulazione.

Visono in tutto 20 percorsi di modulazione
definibili dall'utente.

Per selezionare la sorgente di controllo di un
percorso di modulazione:

= Selezionare la sorgente dal menu a
comparsa Source.



Sorgenti della matrice
Per selezionare la destinazione per un
percorso di modulazione:

= Selezionare la destinazione dal menu a
comparsa Destination.

Destinazioni di modulazione

La quantita di modulazione determina la
gamma dell'effetto di modulazione. Un
classico esempio potrebbe essere
I'associazione con il routing Pitch Wheel to
Pitch. Le impostazioni Amplitude (Amp)

del percorso potrebbero determinare la
gamma massima disponibile dal controllo
Pitch del controller MIDI.

I valori positivi forniscono una risposta
normale e aumentano l'intensita della
mappatura; le impostazioni negative
creano una modulazione invertita.

Si supponga, ad esempio, che un inviluppo
sia indirizzato verso un tono di controllo:
una modulazione positiva produce un
aumento del tono durante la fase di attacco
e una caduta durante la fase di
decadimento; un valore negativo
provocherebbe una caduta del tono
durante la fase di attacco e un aumento
durante la fase di decadimento.

Per determinare la quantita di modulazione in
un percorso di modulazione:

= Trascinare il dispositivo di scorrimento
Amp per il percorso desiderato.

Per impostare un valore di ampiezza massima
(+99):

= Premere i tasti Opzione, Maiusc e fare
clic (Macintosh) oppure i tasti Alt, Maiusc e
fare clic (Windows) sul valore dell'ampiezza
(non sul dispositivo di scorrimento).

Per impostare il valore di ampiezza minimo
(-99):

= Premere i tasti Opzione, Control e fare
clic (Macintosh) oppure i tasti Alt, Maiusc e
fare clic (Windows) sul valore dell'ampiezza
(non sul dispositivo di scorrimento).

Per reimpostare il valore dell'ampiezza su O:
= Premere il tasto Opzione e fare clic
(Macintosh) o il tasto Alt e fare clic
(Windows) sul valore dell'ampiezza (non
sul dispositivo di scorrimento).
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Per eliminare una sorgente o una
destinazione:

= Premere Opzione e fare clic (Macintosh)
oppure premere Alt e fare clic (Windows)
sulla sorgente o sulla destinazione del
percorso di matrice desiderato, per
cancellare le impostazioni (ovvero, per
lasciare vuota la casella
sorgente/destinazione).

Varie sorgenti di modulazione quali gli
inviluppi, gli oscillatori LFO e i controller
MIDI, sono dotate dei propri controlli di
ampiezza. Tali controlli consentono di
impostare la gamma massima disponibile
sull'ampiezza del percorso della matrice,
cosi come il primo di due rubinetti
collocati in serie determina la quantita
d'acqua gestita dal secondo.

Se si utilizza un inviluppo o un controller
MIDI in una matrice e i rispettivi controlli
di ampiezza sono impostati su 0, non é
possibile ottenere alcuna modulazione nel
percorso della matrice. Aprire la finestra
Envelope o la finestra Modulation per
regolare I'ampiezza di tali parametri,
quindi tornare nella finestra Matrix e
impostare I'ampiezza del percorso.

Se la quantita di modulazione in un
determinato percorso non consente una
gamma sufficiente per ottenere I'effetto
desiderato, i percorsi di modulazione
supplementari con sorgenti e destinazioni
identiche avranno un effetto cumulativo
per la gamma cosi aumentata. Potrebbe
essere necessario raddoppiare o triplicare il
percorso di modulazione per ottenere la
gamma desiderata.
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Modulazione del pan in strumenti
stereo

Quando si modula il pan con unasorgente,
ad esempio un oscillatore LFO, occorre
mapppare due volte tale sorgente per un
pan nella finestra Matrix affinché venga
effettuato il pan desiderato di entrambi i
canali. Il pan degli strumenti mono viene
effettuato con una singola mappatura della
matrice.

Ciascun percorso pu0 essere sempre in
funzione oppure soltanto per il tempo che
viene tenuta una nota (ridotta). Questa
funzione agisce nota per nota. Un buon
esempio dell'utilita della modulazione
ridotta potrebbe essere la programmazione
di un intervallo del controllo Pitch ridotto
in uno strumento con un rilascio
prolungato: le note rilasciate di un accordo
Nnon vengono interessate mentre viene
eseguita al melodia con l'intervallo del
tono!

Per impostare il percorso di modulazione in
modo che funzioni soltanto mentre la nota e
tenuta:

= Fare clic sull'opzione Gated nel percorso
di modulazione desiderato. Quando
I'opzione & selezionata, il percorso é attivo
soltanto quando la nota é ridotta. Quando
non é selezionata, il percorso di
modulazione & sempre attivo.

Vi sono numerosi percorsi di modulazione

con collegamento hardware in SampleCell

che non tolgono nessuno dei 20 percorsi

definibili dall'utente:

* Note Number to Pitch (le note MIDI
controllano il tono dello strumento)

« Envelope 3 to Volume (Envelope 3
controlla il volume dello strumento)



< Velocity to Volume (la velocity MIDI
controlla il volume dello strumento)

e Pitch Wheel to Pitch (curva del tono)

Sia le mappature Velocity to Volume che
Pitch Wheel to Pitch possono essere
attivate o disattivate dalla finestra Misc.
Consultare “Parametri Misc” a pagina 50.

Quando viene creato un nuovo strumento,
larelativa finestra Matrix viene configurata
per cinque percorsi di modulazione
predefiniti oltre a quelli hardware elencati
sopra:

< Velocity to Sample Select (la velocity
MIDI sceglie la zona di velocity in
Sample Map)

e LFO 1 to Pitch (vibrato)

e Modulation Wheel to LFO 1 Amplitude
(il controllo Modulation controlla la
quantita di vibrato)

« Sustain Pedal to Envelope 3 Release
(funziona come un pedale di
sostenimento)

E possibile rimuovere questi percorsi di
modulazione predefiniti e qualsiasi altro
percorso, selezionando gli elementi vuoti
dai menu a comparsa.

E possibile salvare in qualsiasi momento le
impostazioni di modulazione della nuova
matrice predefinita (e di altre) scegliendo
Instruments > Set Instrument Defaults.

Oltre a questi percorsi predefiniti, la
modulazione della matrice € configurabile
come meglio si desidera. Si consiglia di
provare liberamente con diversi routing di
modulazione e si otterranno sicuramente
molte applicazioni interessanti con po' di
sperimentazione.

A Alcuni indirizzamenti di modulazione,
benché possibili nella finestra Matrix,
potrebbero non produrre risultati udibili.

Modulatori

La finestra Modulators contiene dei
parametri di montaggio supplementari,
compresi controller MIDI, LFO e generatori
di rampa. Essi possono essere impostati
nella finestra Modulators e
successivamente utilizzati sia come
sorgenti di modulazione che destinazioni
nella finestra Matrix.

Per aprire la finestra Modulators di uno
strumento:

= Fare clic sul pulsante Modulators sulla
barra degli strumenti della finestra Bank
oppure scegliere Windows > Modulators.

Modulators

Moog Basz 1 Left  *

Free Run hd Fres Run -
Sine hd

Sine -

'%

<5 L

Finestra Modulators
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Oscillatori LFO

SampleCell Il presenta due oscillatori a
bassa frequenza LFO identici. In genere gli
oscillatori LFO producono fluttuazioni di
controllo periodiche o regolari che
corrispondono alla loro forma d'onda. Ad
esempio, se si modula il tono con un
oscillatore LFO (ovvero, mappando LFO to
Pitch nella finestra Matrix di SampleCell) si
otterrebbe un vibrato da un'onda
sinusoidale e trilli da un‘'onda quadrata.

Per impostare la forma d'onda di un LFO:

1 Scegliere una forma d'onda dal menu a
comparsa Waveform.

v Sine
Triahgle:
Upzaw
Dromrizam
Square
Fiandom
Moise

Forme d'onda LFO

La velocita di un oscillatore LFO determina
la velocita con cui si verificano le
modifiche del controllo. La gamma di
modifica del controllo ¢ influenzata dalla
sua ampiezza. (L'ampiezza dell'oscillatore
LFO imposta la gamma massima del
controllo che é disponibile sul controllo
Amp del percorso di modulazione.)

Ad esempio, il vibrato e una sirena possono
essere entrambi prodotti modulando il
tono con un'onda sinusoidale. La sirena
utilizza una velocita bassa e un‘ampiezza
elevata, mentre il vibrato utilizza una
velocita maggiore e un'ampiezza inferiore.
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Quando si regolano gli oscillatori LFO,
ricordarsi che ¢ possibile modificarli con
valori di unitareali (ovvero Hz, ms., ecc.) in
Preferences.

Per modificare la velocita di modulazione di
un LFO:

= Trascinare il dispositivo di scorrimento
Speed dell'oscillatore LFO appropriato sul
livello desiderato.

Per modificare la gamma di modulazione di un
LFO:

= Trascinare il dispositivo di scorrimento
Amplitude dell'oscillatore LFO appropriato
sul livello desiderato.

Poiché piu forme d'onda LFO emettono un
segnale di controllo ciclico, é preferibile
controllare come e quando l'oscillatore
LFO viene attivato in rapporto al segnale
che sta modulando. Il menu a comparsa
LFO Synch nella finestra Modulators
consente di specificare la sincronizzazione
LFO scegliendo tra quattro opzioni.

Quando l'oscillatore LFO funziona
liberamente, tale funzionamento avviene
in modo ciclico, pertanto potrebbe trovarsi
in un punto qualsiasi del ciclo quando
viene attivata al modulazione. Cio
aggiunge un elemento di casualita alla
modulazione LFO in quanto non si & mai
certi del punto in cui si trova il ciclo di
modulazione quando si applica il controllo
Modulation o altri controller.

Oscillatori LFO sincronizzati su piu voci
danno I'impressione che tutte le voci siano
modulate uniformemente da un solo
oscillatore. Cio potrebbe andare bene per
sintetizzazioni funky, ma non per sezioni
con strumenti a corda o ensemble.



L'attivazione dell'oscillatore LFO ne
garantisce l'avvio all'inizio del proprio
ciclo, quando viene riprodotta la nota. Cio
puo essere preferibile per inflessioni
musicali quali trilli e altri effetti che
richiedono uniformita di modulazione tra
le note.

Per selezionare la modalita di attivazione di
un determinato oscillatore LFO:

1 Scegliere la modalita desiderata dal menu
a comparsa LFO Synch. Sono disponibili le
seguenti opzioni:

v Free Bun
Sunc
Trg
Sunc & Trig

Menu a comparsa LFO

e Free Run non tiene conto della fase di
forma d'onda tra le voci e le note.

e Sync sincronizza la fase delle forme
d'onda LFO tra le voci SampleCell per
simulare un solo oscillatore LFO.

e Trig reimposta la forma d'onda LFO su
zero-crossing per ciascuna nota MIDI per
eventi prevedibili.

e Sync & Trig combina gli attributi Trig e
Sync.

Generatore di rampa

Il generatore di rampa emette un segnale di
controllo che assomiglia a una rampa
nell'effetto che produce. Il segnale inizia al
livello normale e passa con una
determinata velocita a un altro livello. Se
viene utilizzata una quantita di
modulazione positiva la rampa aumenta;
ampiezze negative la fanno diminuire.

Ad esempio, se il generatore di rampa sta
modulando il tono, lI'impostazione
dell'ampiezza su 50 obbliga ciascuna nuova
nota a salire di un'ottava; un‘ampiezza di -
50 fa scendere ciascuna nota di un'ottava.

Per modificare la velocita di variazione del
segnale del generatore di rampa:

= Trascinare il dispositivo di scorrimento
Ramp Time sulla posizione desiderata.

Assegnazione dei controller
MIDI

SampleCell consente di definire per ciascun
strumento due controller MIDI (A e B) da
scegliere tra 120 disponibili. Questi
possono quindi essere utilizzati come
sorgenti di modulazione. Ad esempio, si
potrebbe desiderare che un Yamaha Breath
Controller (Controller MIDI # 2) moduli il
volume oppure che un pedale (Controller
MIDI # 4) moduli LFO 1 Amplitude.

Per assegnare il controller MIDI A o B:

= Trascinare la piccola icona del
dispositivo di scorrimento posta sotto il
controller MIDI A (o B) finché non
compare il numero del controller MIDI
desiderato.

T

Selezione del numero di un controller MIDI
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O E inoltre possibile assegnare un controller
MIDI tenendo premuto il tasto Control,
facendo clic sul numero associato a ciascun
controller MIDI e spostando il controller MIDI
desiderato sul dispositivo principale.

Generatori di tracciamento

Il generatore di tracciamento (Tracker)
modifica il segnale di controllo in base al
grafico a nove punti definito dall'utente. |
punti sono uniformi in spaziatura e
sincronizzazione; la loro altezza nel grafico
ne determina il valore positivo o negativo.
L'asse X & la sorgente di modulazione
(selezionabile da un menu a comparsa nella
finestra Trackers), mentre l'asse Y ¢ la
destinazione di modulazione.

La finestra Matrix Map & elemento chiave
per attingere a molte delle possibilita
espressive dei generatori di tracciamento.
Se configurati correttamente, i generatori
di tracciamento vengono “inseriti” tra la
sorgente e la destinazione di modulazione.
Per ciascun generatore di tracciamento la
sorgente di modulazione viene selezionata
dal menu a comparsa del generatore di
tracciamento. In questo modo viene
mappata tale sorgente (ad esempio,
velocity, pressure, MIDI Note #) attraverso
il generatore di tracciamento, dove la
disposizione dei nove punti di interruzione
definisce la curva da applicare alla
destinazione di modulazione su cui &
mappato nella finestra Matrix.

Per un esempio sull'utilizzo ottimale dei
generatori di tracciamento, si pud pensare
a uno strumento come un violino
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pizzicato, che produce un suono meno
intenso in una determinata zona (registro
alto) piuttosto che in un‘altra (registro
basso). Il controllo del volume mediante la
velocity risulta semplice ed & possibile
ottenere un maggiore realismo attribuendo
al violino una curva di risposta tale che
I'intensita del registro alto non sia forte
quanto quella del registro basso. Quando
viene riprodotto, il volume complessivo
verra determinato innanzitutto dalla
velocity (supponendo che rimanga la
mappa della matrice predefinita), ma sara
piu evidente la differenza tra i registri alto e
basso, cosi come si verifica quando si suona
un violino vero e proprio. Inoltre, qualsiasi
altra mappatura quale velocity to filter, o
velocity to envelope attack verra migliorata
dalla curva di risposta tracciata nel
generatore di tracciamento.

Per ulteriori esempi, consultare “Tracker” a
pagina 83, che contiene numerosi consigli
per l'uso dei generatori di tracciamento.

Per aprire la finestra Tracker:

1 Fare clic sul pulsante Trackers sulla barra
degli strumenti della finestra Bank oppure
scegliere Windows > Trackers.

Pulsante Trackers



Ska Synth Stereo v

MIC| Note Nurnber -

ML | Mote Murnber -

Finestra Trackers

Per selezionare la sorgente di modulazione
del generatore di tracciamento:

= Scegliere un controllo della sorgente dal
menu a comparsa Tracker.

La curva di risposta del generatore di
tracciamento verra applicata alla sorgente
selezionata.

Per regolare la curva di controllo a nove punti
del generatore di tracciamento:

= Trascinare ciascun punto verticalmente
sul livello desiderato.

Il passaggio finale quando si utilizzano i
generatori di tracciamento & quello di
mapparli su un'altra destinazione nella
finestra Matrix. Passare alla finestra Matrix
e provare varie mappature e impostazioni
di ampiezza. Salvare le varie prove.
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Montaggio dei campioni, esecuzione di loop

e trim dell'audio

In SampleCell Editor é presente la finestra
Edit Loops che consente I'aggiunta, il
montaggio e I'eliminazione di punti di loop
nei campioni e fornisce tutti gli strumenti
necessari per trasformare i campioni in
loop di qualita. La finestra Edit Loops
fornisce inoltre funzionalita di trim audio
non distruttive, che consentono di
eliminare i dati in eccesso pre- e postloop.

La finestra Edit Loops mette inoltre a
disposizione tutte le funzioni di loop
presenti in Sound Designer Il e aggiunge
nuove funzioni, tra cui:

0 Possibilita di creare fino a2 loop: un loop
Sustain (sostenimento) e un loop Release
(rilascio) in tutti i file audio

0 Trim audio (elimina tutto l'audio non
selezionato)

0 Esecuzione di crossfade, loop in
avanti/indietro e altro ancora

0 Salvataggio dei file direttamente nella
finestra Edit Loops

0 Apertura dei file audio dal disco o
dall'interno degli strumenti SampleCell

0 Visualizzazione dei dati, controllo e
montaggio/spostamento di loop durante il
monitoraggio/l'attivazione del campione

dai controller MIDI esterni (mediante OMS
nei sistemi Macintosh o Multimedia in
Windows)

0 Controllo dei loop mediante la scheda
SampleCell o mediante Controllo suono di
Apple o una scheda audio per Windows

Introduzione

Nella presente sezione vengono spiegati i
loop di sostenimento e di rilascio in
SampleCell e come possono essere utilizzati
per un'espressivita e un controllo massimi.

Nozioni di base sui loop

SampleCell supporta fino a due 2 loop
all'interno del file audio. Ogni campione
puo avere fino a 4 indicatori di loop: inizio
loop 1 e fine loop 1, inizio loop 2 e fine
loop 2.

Con due loop in un file audio, verra
dapprima eseguito il primo loop mentre
una nota MIDI viene tenuta o sostenutace il
secondo loop durante il rilascio della nota.
Quando viene definito un solo loop,
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SampleCell lo esegue sia quando la nota
viene sostenuta che quando viene
rilasciata.

Se il file audio presenta un solo loop

Se il file audio presenta un solo loop, viene
riprodotto il campione fino all'inizio del
loop e quindi continua a riprodurre la parte
con il loop del campione mentre la nota
viene tenuta. Quando la nota viene
rilasciata, la riproduzione del loop
continua mentre il suono si attenua in base
all'inviluppo corrente.

A Se un file audio contiene un solo loop, viene
chiamato “Sus/Rel” nella finestra Parameters
di SampleCell (i controlli per Sustain Loop
sono ombreggiati e non sono disponibili con i
campioni a un solo loop).

File audio con due loop

Se il file audio presenta due loop,
SampleCell trattera il loop 1 come loop
Sustain (di sostenimento), viene riprodotto
mentre il tasto viene tenuto premuto, e il
loop 2 come loop Release (di rilascio) che
viene riprodotto una volta rilasciato il
tasto.

I loop creati devono soddisfare 2 requisiti:

e | due loop non devono sovrapporsi (cioé
il loop 1 deve terminare prima dell'inizio
del loop 2)

e Lalunghezza di ciascun loop deve essere
equivalente ad almeno un ciclo
completo di forme d'onde, o a 5 frame
campione, del campione
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E possibile disaccordare entrambi i loop
singolarmente nella finestra Sample
Parameters. Per ulteriori informazioni
vedere lasezione “Parametri del campione”
a pagina 49.

Caricamento di campioni e
apertura della finestra Edit
Loops

Quando si apre la finestra Edit Loops, una
copia del campione correntemente
selezionato viene caricata nella memoria
RAM del computer. In questo modo &
possibile lavorare in modo non distruttivo
nella finestra Edit Loops, proteggendo la
copia originale, che rimane caricata nella
RAM di SampleCell.

Tutte le operazioni eseguite nella finestra
Edit Loops possono essere annullate
scegliendo Edit > Undo. Inoltre & possibile
determinare come e quando il campione
originale viene aggiornato (in altre parole
sovrascritto dal contenuto corrente della
finestra Edit Loops). Per ulteriori
informazioni vedere la sezione “Utilizzo
della modalita Link” a pagina 68.

Non ¢ necessario che i file siano caricati
negli strumenti di SampleCell, prima di
poterli aprire nella finestra Edit Loops. E
possibile caricare un campione nella
finestra Edit Loops direttamente dal disco e
quindi eseguire il loop oppure caricarlo
all'interno della finestra Sample Map.

A Interrompere sempre il sequencer quando
si apre la finestra Edit Loops.



Per aprire la finestra Edit Loops:

= Se si desidera eseguire il loop di un
campione gia caricato in uno strumento di
SampleCell, selezionare il campione nella
finestra Sample Map dello strumento e
quindi scegliere Instruments > Edit (nome
del campione) oppure fare clic sull'icona del
loop.

Pulsante per la modifica dei loop
p— O p—
= Pereseguire il loop di un file su disco (un

file che non ¢ gia caricato in SampleCell)
scegliere Instruments > Edit Loops.

0 Non é possibile caricare un campione nella
finestra Edit Loops se si trova su un CD
correntemente non montato. La situazione
puo verificarsi se si aprono gli strumenti senza
caricare i campioni mediante I'opzione
Automatically Load All Samples.

=== Loop -shforteA2——
Audio File l T O = a5s
4 nm @nl 15.. | Cn 203,642 Samples A Dlale
0ss 1e 15: 2 255 3s 35: | as
0] <1
[ ]
Laop 1: k|
start[1577e0 ] & <. *
End
=
Loop 2:
start[ ]
e [ ]
Tupe
Audio Selection:
Shﬂl:lg == e
] [ — s [y i ey
4 D

Figura 12. Finestra Edit Loops

La finestra Edit Loops utilizza la memoria
RAM del sistema per memorizzare il
campione (non la RAM di SampleCell). 1l
campione vero e proprio non verra
modificato finché non si utilizza il menu a
comparsa Save Audio File della finestra Edit
Loops per sovrascrivere i campioni oppure
finché non si utilizza Save Audio File As per
salvare il nuovo file, lasciando inalterato
l'originale.

Per uscire dalla finestra Edit Loops:

= Scegliere il nome di un banco dal menu
Windows oppure chiudere la finestra Edit
Loops.

Ascolto dei campioni

La riproduzione nella finestra Edit Loops
puo essere attivata in diversi modi: facendo
clic su una delle icone degli altoparlanti
visualizzate, premendo la barra spaziatrice
o via MIDI. Utilizzando un comando di
riproduzione diverso, é possibile
selezionare di ascoltare i dati del loop e i
dati prima della definizione del loop
oppure solamente i dati del loop o ancora
I'intero file audio una sola volta o in
modalita di ripetizione.

Utilizzando MIDI, & possibile ascoltare il
loop attraverso le uscite di SampleCell
insieme ad altri campioni e strumenti.
Tuttavia affinché cid funzioni occorre
attivare la modalita di collegamento a
SampleCell (Link-to-SampleCell). In base
alle impostazioni predefinite, la modalita
Link é attivata quando un campione &
caricato nella finestra Edit Loops da uno
strumento. Se l'audio nella finestra Edit
Loops non ¢ stato caricato da uno
strumento, in base alle impostazioni
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predefinite la modalita Link viene
disattivata. Per ulteriori informazioni
vedere la sezione “Utilizzo della modalita
Link” a pagina 68.

Se si utilizzano le opzioni di riproduzione
sullo schermo (icone degli altoparlanti,
barra spaziatrice) si potranno ascoltare
selezioni diverse di audio mediante il
controllo suono (Macintosh) o la periferica
per l'uscita audio (Windows).

Per riprodurre I'intero campione (ignorando
gli indicatori di loop):

= Premere il tasto Opzione (Macintosh) ol
tasto Alt (Windows) e fare clic sull'icona
dell'altoparlante. Si pud anche premere il
tasto Opzione e la barra spaziatrice
(Macintosh) o il tasto Alt e la barra
spaziatrice (Windows).

L'audio verra controllato mediante le uscite
audio del computer e non tramite
SampleCell.

Utilizzo di driver Wave per Windows

E possibile ascoltare i loop con I'hardware
Pro Tools utilizzando il driver Pro Tools
Wave. Per ulteriori informazioni consultare
la documentazione di Pro Tools relativa a
Windows.

Per riprodurre solamente I'audio con loop:

= Premere la barra spaziatrice o fare clic
sull'icona dell'altoparlante nel riquadro
d'ingrandimento del loop (parte inferiore
della finestra Edit Loops).
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Per riprodurre il loop dall'inizio del campione:

1 Deselezionare tutto l'audio nel riquadro
principale premendo il tasto Opzione e
facendo clic (Macintosh) o semplicemente
facendo clic (Windows) nel riquadro
principale della forma d'onda.

2 Fare clic sull'altoparlante del riquadro
principale. Il campione verra eseguito
dall'inizio del file e quindi il primo loop
verra eseguito e ripetuto. Per interrompere
la riproduzione, fare di nuovo clic.

Per riprodurre solamente I'audio selezionato:

1 Trascinare per effettuare la selezione nel
riquadro principale della forma d'onda.

2 Fare clic sull'icona dell'altoparlante
oppure premere la barra spaziatrice.

Utilizzo della modalita Link

MIDI non attiva la riproduzione dell'audio
nella finestra Edit Loops. Solamente gli
strumenti SampleCell sono dispositivi
MIDI. L'opzione Link-to-SampleCell
consente di rinviare la versione modificata
del campione allo strumento, dove potra
essere attivata da MIDI e riprodotta
mediante le uscite audio di SampleCell.

Per riprodurre i campioni tramite le uscite di
SampleCell:

= Per riprodurre il campione/loop
mediante la scheda SampleCell e attivarla
via MIDI, attivare I'opzione Link-to-
SampleCell. La modalita Link viene
disattivata quando i campioni vengono
caricati nella finestra Edit Loops da disco e
non dallo strumento.



Se il campione é gia associato a uno
strumento, l'aggiornamento avviene
automaticamente. Se non vi sono
strumenti associati, I'attivazione della
modalita Link-to-SampleCell creera un
nuovo strumento con il campione come
unico gruppo di note.

Quando si utilizza il sequencer o il
controller MIDI, viene attivata la copia piu
recente del loop. (Per informazioni sulla
modalita Link vedere la sezione
“Aggiornamento dei campioni e modalita
Link” a pagina 69.)

Aggiornamento dei campioni e
modalita Link

Quando si apre un campione nella finestra
Edit Loops, il campione viene caricato nella
memoria RAM del computer. Le modifiche
apportate nella finestra Loop vengono
apportate alla copia del campione nella
memoria RAM di sistema, non al campione

originale caricato nella RAM di SampleCell.

Tuttavia, quando lI'opzione Link-to-
SampleCell & selezionata, ogni modifica
apportata nella finestra Edit Loops attiva
I'operazione di salvataggio automatico che
sostituisce il campione dello strumento
correntemente caricato con il contenuto
della finestra Loop.

Quando l'opzione Link-to-SampleCell e
deselezionata, il caricamento automatico
non si verifica. Il file nella memoria RAM di
SampleCell rimane inalterato e l'intero
monitoraggio avviene mediante le uscite
audio del computer.

E probabile che si preferisca modificare i
loop con l'opzione Link to SampleCell
disattivata. Una volta terminato il

montaggio del loop, se si desidera
ascoltarlo in contesto, selezionare
I'opzione Link-to-SampleCell per
aggiornare il campione nella RAM di
SamplecCell.

0 In modalita Link I'opzione Try to assign
unused MIDI Channel for a new Instrument
consente di assegnare automaticamente il
canale MIDI successivo pil alto disponibile
per gli strumenti appena creati. Per ulteriori
informazioni su questa preferenza vedere la
sezione “Instruments Preferences” a
pagina 102.

Selezione del colore per lo sfondo
della finestra Edit Loops Window

E possibile personalizzare i colori utilizzati
per visualizzare ogni canale e lo sfondo
della finestra Loops Edit.

Per scegliere i colori desiderati per la finestra
Edit Loops:

1 Scegliere SampleCell > Preferences. Il
selettore dei colori si trova nella parte
inferiore della schermata Preferences.

Loop Editing
Laop window left channel color
. Loop windaw right channel color
. Loop window background color

Selettore dei colori per i canali e lo sfondo della
finestra Edit Loops

2 Fare clic su una delle tre opzioni di colore
e scegliere il colore desiderato.

Ripetere I'operazione per lI'altro canale e per
lo sfondo.
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Selezione di un altro editor di
campioni

Il comando Select Sample Editor del menu
Instruments consente di selezionare
qualsiasi applicazione di montaggio
compatibile, per modificare i file di
campioni.

Con il comando Launch Sample Editor (nel
menu Instrument della finestra Sample
Map) e possibile caricare il campione
correntemente selezionato nell'editor
campione di propria scelta.

Panoramica della finestra
Edit Loops

Il riquadro principale della forma d'onda
(nella parte superiore dello schermo)
mostra l'intero file audio caricato nella
finestra Edit Loops con una timeline nella
parte inferiore. E qui che si contrassegnano
e si controllano gli indicatori di inizio e
fine loop, si eliminano i dati in eccesso, si
scambiano loop e cosi via.

Nella presente sezione vengono descritti
tutti i comandi e tutte le funzioni della
finestra Edit Loops. In questa finestra si
possono creare loop dei propri campioni,
applicare loop crossfade, ripristinare ed
eseguire loop in avanti/indietro ed eseguire
la corrispondenza automatica dei loop
senza uscire dall'ambiente SampleCell.
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Barra degli strumenti

Menu Local della finestra Edit Loops

Si tratta di un menu a comparsa separato
che contiene i comandi Save, Save As, Save
Selection As, Save a Copy e Revert Audio
File. Utilizzare questo menu a comparsa per
le operazioni di gestione dei file e
situazioni di ripristino. Se I'opzione Link-
to-SampleCell & disattivata, questi comandi
eseguono le funzioni standard. Se I'opzione
Link-to-SampleCell é attivata, tutti i
comandi del menu Local consentono di
aggiornare lo strumento di SampleCell (ad
eccezione di Save a Copy). Il comando Save
Audio File consente di aggiornare i gruppi
note originali nello strumento SampleCell
(se ve ne sono). Il comando Save Audio File
As consente di creare uno strumento nuovo
contenente il campione con il loop come
I'unico gruppo di note. Il comando Save
Audio File Copy consente di salvare su
disco una copia nuova del file senza
aggiornare o creare strumenti. Il comando
Save Audio Selection As consente di
assegnare un nome e salvare l'audio
correntemente selezionato in un nuovo file
sul disco. Il comando Revert Audio File
consente di ripristinare la versione salvata
in precedenza del file audio corrente.

Pulsante altoparlante

Il pulsante dell'altoparlante nella barra
degli strumenti consente di controllare
l'audio nella finestra Edit Loops. Nella
finestra Edit Loop la riproduzione avviene
mediante le uscite audio del computer e
non tramite SampleCell.



Per riprodurre l'audio dalla finestra Edit
Loops fare clic sul pulsante
dell'altoparlante nel riquadro principale
della forma d'onda, per sentire il campione
dall'inizio fino al loop audio che viene
ripetuto. Se non sono stati definiti dei loop,
fare clic sull'icona dell'altoparlante e/o
premere la barra spaziatrice per riprodurre
la parte correntemente selezionata del file
audio. Se non e stata effettuata alcuna
selezione, (ossia non € evidenziata alcuna
parte dell'audio nel riquadro principale
della forma d'onda) e non é stato definito
alcun loop, viene riprodotto l'intero file
audio.

Per ascoltare l'intero file audio, ignorando
loop e selezioni, premere il tasto Opzione
(Macintosh) o Alt (Windows) e fare clic sul
pulsante dell'altoparlante (oppure mentre
si preme la barra spaziatrice).

Per ascoltare solo il loop, utilizzare il
pulsante dell'altoparlante, nell'area
d'ingrandimento del loop, o la barra
spaziatrice.

A Quando si fa clic sullicona dell*altoparlante
oppure si preme la barra spaziatrice per
ascoltare il contenuto della finestra Edit
Loops, la riproduzione avviene tramite il
dispositivo audio standard del sistema. Prima
di poter controllare un loop/campione
(attivato via MIDI) mediante la scheda
SampleCell, & necessario selezionare il
pulsante di collegamento a SampleCell per
aggiornare il campione nello strumento di
SampleCell (se esiste gia in uno strumento
caricato) o per creare uno strumento nuovo
per il campione.

Pulsante per il collegamento a
SamplecCell

Questo pulsante consente di inviare il
contenuto della finestra Edit Loops a
SampleCell e/o di aggiornare gli strumenti
appropriati di SampleCell, se necessario. Se
non & presente un campione con lo stesso
nome da aggiornare (se ad esempio si &
appena creato un file loop direttamente da
disco), viene creato un nuovo strumento
con un solo campione e, se necessario, un
nuovo banco.

Pulsante per I'assegnazione del
numero ai Loop

Questo pulsante consente di cambiare
I'assegnazione del numero di loop
correntemente selezionato (dala2oda?2
a 1). Il pulsante & attivato solamente se
esiste un loop. Dato che, in base alle
impostazioni predefinite, un loop diventa
il loop di rilascio, ¢ utile trasformare il loop
1in loop 2; in questo modo é possibile
aggiungere un loop di sostenimento (loop
1) prima di questo loop. (Se fosse ancora il
loop 1, sarebbe possibile aggiungere solo
un loop 2 dopo il loop 1 e il loop di rilascio
diventerebbe il loop di sostenimento.)
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Strumenti Trim

La funzione Trim di SampleCell consente
di eliminare tutto lI'audio che non rientra
nella selezione corrente (sempre che sia
stata effettuata una selezione). Fare molta
attenzione quando si utilizza lo strumento
Trim: lo strumento non elimina i dati
audio selezionati, ma invece elimina tutto
l'audio non selezionato.

Inoltre, se si intende applicare un crossfade
al loop, assicurarsi di lasciare dell'audio in
eccedenza prima e dopo gli indicatori di
loop. Le modifiche non verranno salvate su
disco finché non si utilizza il comando
apposito del menu Local nella finestra Edit
Loops.

Frecce zoom

Queste frecce consentono di ingrandire o
ridurre la visualizzazione del riquadro
principale. Le frecce su/giu
aumentano/diminuiscono l'altezza della
forma d'onda, mentre le frecce
destra/sinistra (e i tasti freccia) consentono
di eseguire lo zoom dentro e fuori la
timeline. Premere il tasto Opzione
(Macintosh) o il tasto Alt (Windows) e fare
clic su una qualsiasi freccia zoom della
panoramica (o sui tasti freccia della tastiera
del computer) per la risoluzione massima
(ossia zoom massimo 0 minimo).

Visualizzazione della lunghezza
(msec e campioni)

Quest'area della barra degli strumenti
mostra la lunghezza della selezione
corrente.
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Freccia di selezione

Questo selettore viene usato per effettuare
selezioni dell'audio nella visualizzazione
della forma d'onda e per inserire indicatori
di loop. Fare clic e trascinare per
selezionare un intervallo audio, premere il
tasto Maiusc e fare clic per aggiungere o
sottrarre dalle selezioni audio. Per
eliminare una selezione, fare clic in un
punto qualsiasi della panoramica.

Indicatori di inizio e fine loop

Gli indicatori di inizio e fine loop si
aggiungono alla forma d'onda nel riquadro
principale per definire il punto iniziale e
finale dei loop. Gli indicatori di loop
vengono aggiunti facendo clic sulle
rispettive icone sulla barra degli strumenti
per attivarli, quindi fare clic nella forma
d'onda per inserirli. Il relativo indicatore di
loop viene cosi inserito nella posizione
desiderata, che viene visualizzata nell'area
informativa (nella parte inferiore sinistra
della finestra Edit Loops). Per ulteriori
informazioni sull'aggiunta di indicatori di
loop vedere la sezione “Creazione di un
loop nuovo” a pagina 75.

Strumento gomma

Per eliminare un indicatore, selezionare lo
strumento gomma e fare clic sull'indicatore
desiderato.

Riquadro d'ingrandimento del loop e
relativi strumenti

In questa parte della finestra Edit Loops
viene visualizzato un primo piano delle
forme d'onda alla fine (del loop
selezionato, nella parte sinistra della



schermata zoom) e all'inizio (parte destra
della schermata zoom). Subito sotto il
riquadro d'ingrandimento del loop vi sono
i pulsanti Auto e di scorrimento. A sinistra
del riquadro d'ingrandimento vi sono gli
strumenti che hanno effetto in questo
riquadro, tra cui i pulsanti dei canali, per lo
scambio dei loop, il pulsante crossfade e le
frecce per l'ingrandimento del loop. Sotto
questi strumenti si trova la casella di
controllo Stereo, che consente di
monitorare uno o entrambi i canali del
loop stereo.

Frecce di scorrimento loop sinistra e
destra

Sotto I'inizio del loop (lato destro del
riquadro d'ingrandimento) e sotto la fine
del loop (lato sinistro del riquadro
d'ingrandimento) si trovano le frecce di
scorrimento loop sinistra e destra. Se si fa
clic su queste frecce, il punto
corrispondente del loop viene spostato
(mediante scorrimento) di piccoli
incrementi a sinistra (parti precedenti) o a
destra (parti successive) del file audio.

0 Premere il tasto Comando (Macintosh) o
Control (Windows) durante lo scorrimento per
effettuare delle regolazioni precise.

Il riquadro principale della forma d'onda e
quello d'ingrandimento del loop sono
attive simultaneamente e le modifiche
apportate in una finestra vengono riflesse
nell'altra. Inoltre é possibile passare da una
vista all'altra per spostare gli indicatori di
loop. Ad esempio, quando si lavora nel
riquadro d'ingrandimento del loop si puo
talvolta decidere di spostare un indicatore
in una posizione pit lontana e in modo piu

rapido di quanto consentito dalle frecce di
scorrimento del riquadro d'ingrandimento.
E sufficiente spostare I'indicatore nel
riquadro principale della forma d'onda in
una posizione diversa e quindi tornare al
riquadro d'ingrandimento del loop per
continuare a regolare con precisione il
loop.

O Inoltre, se si fa clic in un punto qualsiasi del
riquadro principale della forma d‘onda, anche
nel riquadro d'ingrandimento verra
visualizzata quella posizione.

Frecce Auto destra e sinistra

Le frecce AUTO destra e sinistra sono
strumenti particolarmente utili per il
posizionamento dei punti di loop. Anziché
fare scorrere i punti loop a destra e a sinistra
in piccoli incrementi, le frecce AUTO
spostano automaticamente il punto del
loop al successivo punto piu vicino che
mantiene sia il valore, sia I'inclinazione
dell'altro indicatore di loop. Ad esempio, se
si definisce la fine del loop e si fa clic sulla
freccia AUTO destra, la fine del loop viene
spostata verso la fine del file audio sulla
forma d'onda piu vicina corrispondente
all'inclinazione e all'ampiezza dell'inizio
del loop. Se si fa clic sulla freccia AUTO
sinistra, lo stesso indicatore viene spostato
in un punto precedente del file audio
finché non viene trovata una posizione
adatta. Si ricordi, tuttavia, che con questi
pulsanti non ¢ possibile garantire un loop
dal suono perfetto; sebbene sia possibile far
corrispondere la posizione di un indicatore
con l'inclinazione e I'ampiezza dell'altro,
questi fattori da soli non garantiscono la
formazione del migliore loop possibile (ad
esempio, le frecce AUTO non trovano
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automaticamente i punti del loop che
passano per il valore zero). E sempre meglio
fidarsi delle proprie orecchie per stabilire la
qualita del loop!

Frecce per I'ingrandimento del loop

Queste frecce consentono di definire la
risoluzione (ingrandimento) della
visualizzazione nel riquadro
d'ingrandimento del loop scegliendo tra
quattro livelli d'ingrandimento.

Le frecce su/giu aumentano/riducono
I'altezza delle forme d'onda; le frecce
destra/sinistra aumentano/riducono
l'ingrandimento orizzontale. Per
controllare le frecce per l'ingrandimento
del loop, & possibile anche tenere premuto
il tasto Maiusc e fare clic sul corrispondente
tasto freccia sulla tastiera del computer.

Casella di controllo Stereo

Questa casella di controllo consente di
ascoltare i singoli canali di un loop stereo.
Se selezionata, in tutti i controlli del loop
verranno utilizzati entrambi i canali di un
loop stereo. Se non ¢ selezionata, sara
possibile sentire solamente il canale
selezionato mediante il pulsante di
selezione del canale. E possibile modificare
I'impostazione della casella di controllo
anche durante I'ascolto dei loop.

Pulsante loop crossfade

Se si fa clic su questo pulsante viene
visualizzata la finestra di dialogo Crossfade
Loop. In questa finestra & possibile
selezionare il tipo e la lunghezza del
crossfade. E possibile selezionare due tipi di
crossfade, Linear ed Equal Power, e
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impostare la lunghezza del crossfade sul
valore desiderato, a condizione che non
superi la lunghezza della regione/del
campione. La finestra di dialogo Crossfade
Loop consente inoltre di creare loop in
avanti e loop in avanti/indietro. Per
ulteriori informazioni vedere la sezione
“Creazione di un loop crossfade” a
pagina 77.

0 Se si utilizza un sistema Macintosh, non é
possibile ascoltare un loop in avanti/indietro
nella finestra Edit Loops, se non e caricato in
uno strumento di SampleCell. In altre parole,
se il pulsante per il collegamento a
SampleCell non é attivato, non & possibile
attivare un loop in avanti/Zindietro via MIDI. Per
ascoltare il loop, € necessario attivare il
pulsante di collegamento (SampleCell verra
aggiornato con la versione in avanti/indietro
del file audio).

Pulsante per la selezione del loop

Il numero del loop che si sta modificando &
sempre indicato sulle icone poste nella
parte superiore del riquadro
d'ingrandimento. Per modificare un loop
diverso, fare clic sul pulsante per la
selezione del loop. Utilizzare questo
pulsante per selezionare e controllare i loop
mediante l'altoparlante nel riquadro
d'ingrandimento loop (o la barra
spaziatrice).

Pulsante per la selezione del canale

Se si fa clic su questo pulsante, viene
visualizzato il loop sul canale sinistro o
destro di un file stereo.



Pulsante altoparlante

Il pulsante altoparlante consente di
riprodurre l'audio selezionato.

Area informativa

Nell'area informativa relativa al loop vi
sono dei campi di testo modificabili per
l'inizio e la fine della selezione/dei loop (in
campioni), alcune icone di occhiali che
consentono di far scorrere la panoramica
sul punto di loop desiderato e un menu a
comparsa per la selezione del tipo di loop.
Modificando i valori di questi campi (fare
clic nel campo, digitare i valori desiderati e
quindi premere Invio) € possibile
definire/regolare direttamente i loop e/o le
selezioni.

Start/End. Vengono visualizzate le
posizioni di inizio (Start) e di fine (End) (in
campioni) per Loop 1, Loop 2 e la selezione
audio (Audio Selection) corrente, sempre
che ve ne sia una. Per modificare questi
valori, fare clic sul valore visualizzato e
immettere il numero desiderato.
L'eliminazione o la cancellazione di questi
valori causera I'eliminazione del relativo
indicatore di loop o di selezione.

Occhiali. Facendo clic sull'icona degli
occhiali posta accanto ai vari campi dei
loop, si fa scorrere la visualizzazione della
forma d'onda nella posizione di tale
indicatore.

Type. Per cambiare la direzione del loop,
fare clic sul menu a comparsa Type e
selezionare Fwd/Bk per definire un loop in
avanti/indietro oppure Forward per
selezionare un loop in avanti standard.

Creazione di un loop nuovo

Introduzione

Nella presente sezione si imparera a creare
loop. A questo scopo aprire dapprima la
finestra Edit Loops con il campione nel
quale si desidera effettuare il loop e quindi
aggiungere gli indicatori di loop al file
utilizzando gli strumenti dell'editor di
loop. Una volta ascoltati i loop, si potra
vedere come modificarne la posizione,
aggiungere loop crossfade, scambiare loop
e utilizzare la modalita Link-to-SampleCell.

Per caricare un campione nella finestra Edit
Loops:

1 Se il campione é gia caricato in uno
strumento di SampleCell, selezionare Key
Group e Velocity Zone relativi a quel
campione nella finestra Sample Map e
scegliere Instruments > Edit (home
campione) oppure fare clic sul pulsante per
la modifica dei loop nella finestra Sample
Map.

Pulsante per la modifica dei loop

La finestra Edit Loops compare con il
campione caricato e visualizzato nel
riquadro principale della panoramica. Non
€ necessario caricare un campione in
SampleCell per eseguirne il loop. E
possibile aprire e modificare i file su disco
direttamente nella finestra Edit Loops
prima di caricarli in SampleCell. Se si
desidera eseguire il loop di un file che non
€ ancora stato caricato in SampleCell,
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scegliere Instruments > Edit Loops.
Individuare il file desiderato utilizzando la
finestra di dialogo visualizzata. Se la
modalita Link to SampleCell & attivata,
viene creato automaticamente uno
strumento con un unico campione per il
loop, non appena viene aggiunto o
modificato un indicatore di loop.

Quando viene aperta la finestra Edit Loops
il nome del file viene visualizzato sulla
barra del titolo e la lunghezza del file viene
indicata nella parte centrale della barra
degli strumenti (in msec e campioni). Nella
finestra principale vengono visualizzati le
forme d'onda del file e visualizzati gli
indicatori di loop esistenti in quel file (fino
a un massimo di due loop).

Per creare un loop nella finestra Edit Loops:

1 Fare clic sull'icona dell'indicatore di
inizio loop. Il cursore si trasforma in un
cursore di inizio loop tutte le volte che
viene posizionato sopra la forma d'onda in
fase di modifica.

Indicatore di inizio loop
2 Fare clic sul cursore di inizio loop nel
punto di inizio loop desiderato all'interno

della forma d'onda. Viene visualizzato
I'indicatore di inizio loop con il numero 1.

3 Fare clic sullicona dell'indicatore di fine
loop nella barra degli strumenti. Il cursore
si trasforma in un cursore di fine loop tutte
le volte che viene posizionato sopra la
forma d'onda in fase di modifica.
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Indicatore di fine loop

4 Fare clic sul cursore di fine loop nella
forma d'onda in prossimita della posizione
desiderata per il punto finale. Nella parte
inferiore della visualizzazione della forma
d'onda, lungo la timeline, viene
visualizzato un indicatore di fine loop con
il numero 1.

Si € appena creato un loop. Nel riquadro
d'ingrandimento del loop (nella parte
inferiore destra della finestra Edit Loops)
viene sempre visualizzato un primo piano
dei punti di loop.

Modifica dei loop: scambio
dei loop, crossfade

Il modo pit semplice per modificare un
loop consiste nel trascinare gli indicatori di
loop in una posizione diversa nel riquadro
principale della forma d'onda. E tuttavia
improbabile che questa operazione
produca delle regolazioni sufficientemente
precise per creare un loop uniforme; si
consiglia di utilizzare invece i pulsanti
AUTO e le frecce di scorrimento
destra/sinistra del riquadro
d'ingrandimento per provare nuovi punti
di loop.

*
o

Strumenti per la visualizzazione dei punti di loop nel
riquadro d'ingrandimento



Le due meta del riquadro d'ingrandimento
visualizzano i primi piani dell'audio alla
fine del loop (nella parte sinistra) e
all'inizio del loop (nella finestra destra). Per
loop uniformi sono preferibili punti di
giunzione che passano per lo zero. In
questo tipo di loop significa che i punti di
inizio e di fine del loop si incontrano
esattamente sullo zero. E possibile
constatare la vicinanza allo zero dei punti
di loop correnti osservandone la
visualizzazione nel riquadro
d'ingrandimento del loop.

Sotto questi due riquadri si trovano le
frecce di scorrimento sinistra/destra e i
pulsanti AUTO sinistra/destra. Le frecce di
scorrimento sposteranno l'indicatore di
loop appropriato pit avanti o piu indietro
nel tempo (rispettivamente a sinistra e a
destra) di piccoli incrementi. Premere il
tasto Comando (Macintosh) o Control
(Windows) e fare clic per attivare la
modalita di definizione precisa, che
consente di scorrere il display molto
lentamente. Con queste frecce ¢ piu facile
trovare il punto piu vicino allo zero, o
qualsiasi altra posizione desiderata, nel
campione.

Le frecce AUTO destra/sinistra sono
strumenti particolarmente utili per il
posizionamento dei punti di loop. Anziché
far scorrere i punti loop a destra e a sinistra
in piccoli incrementi, le frecce AUTO
spostano automaticamente il punto del
loop al successivo punto che mantiene sia
il valore sia l'inclinazione della giunzione.
Se si sta definendo la fine del loop, la
freccia AUTO corrisponde all'inizio del
loop. Se si sta definendo Il'inizio del loop, la
freccia AUTO corrisponde alla fine del
loop. Inoltre & possibile fare clic su una

delle forme d'onda visualizzate nel
riquadro d'ingrandimento del loop e
I'indicatore di loop corrispondente si
spostera in quella posizione.

Per definire con precisione le posizioni del
loop:

1 Una volta aggiunti gli indicatori di loop
nel riquadro principale della forma d'onda,
utilizzare le frecce di scorrimento
sinistra/destra per trovare un punto di
giunzione per l'indicatore di loop
selezionato.

Premere il tasto Comando (Macintosh) o
Control (Windows) durante lo scorrimento
per effettuare regolazioni estremamente
precise.

2 Una volta trovato un punto di giunzione
adeguato, utilizzare l'altra freccia AUTO
dell'indicatore per individuare una
giunzione corrispondente. In alternativa
utilizzare le frecce di scorrimento
sinistra/destra per trovare manualmente
un punto di giunzione corrispondente.
Oppure utilizzare i campi modificabili di
testo dell'area informativa per definire le
posizioni degli indicatori. Fare doppio clic
sul campo desiderato e digitare la nuova
posizione (in campioni).

Creazione di un loop crossfade

Nella finestra Edit Loops & presente
un'opzione crossfade che ammette
I'operazione di annullamento.

Per creare un loop crossfade:

1 Fare clic sul pulsante Crossfade nella
finestra Edit Loops. Viene visualizzata la
finestra di dialogo Crossfade Looping.
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Pulsante Crossfade

La finestra di dialogo Crossfade Looping
consente di creare un loop crossfade. Le
operazioni di loop crossfade costituiscono
una tecnica di montaggio distruttivo dei
campioni che utilizza I'evoluzione naturale
della forma d'onda di un suono per rendere
piu “uniforme” il punto di giunzione del
loop.

Essenzialmente la funzione di loop
crossfade esegue una copia della forma
d'onda di fine loop ed esegue il crossfade al
50% di quest'ultima con il 50% della forma
d'onda d'inizio loop. Successivamente
viene eseguito il crossfade al 50% della
forma d'onda di inizio loop originale con il
50% della forma d'onda di fine loop. In
questo modo si garantisce la
corrispondenza delle forme d'onda di
inizio e di fine loop, sebbene nessuna delle
due sia stata modificata radicalmente.

Crossfade Looping

Loop Number: 1

® Linear
) Equal Power

Crossfade Type:

Min Length: 8
Max Length: 0

Crossfade Length: IEI Samples
(Continue)

Finestra di dialogo Crossfade Looping

Samples

Samples

Per garantire che tutte le transizioni siano
riprodotte uniformemente, incluse quelle
prima dell'inizio loop e quelle dopo la fine
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del loop, i crossfade sono centrati proprio
sui punti di inizio e fine loop. Tra le
funzioni della finestra di dialogo Crossfade
Looping vi sono:

Crossfade Type. Vi sono due tipi di
crossfade: Linear Crossfade che utilizza
curve di crossfade piatte (lineari) ed é la
scelta adatta alla maggior parte delle
applicazioni. Equal Power Crossfade che
utilizza curve di fade non lineari. Questo
tipo di crossfade ¢ utile se, al centro del
crossfade, il volume sembra ridursi
drasticamente.

Crossfade Length. L'opzione Crossfade
Length determina la quantita di forma
d'onda compresa tra i punti di loop che
verra inclusa nel crossfade. Per questo
motivo, la lunghezza del crossfade deve
essere piu corta della lunghezza
complessiva del loop, piu corta della
lunghezza della forma d'onda compresa tra
I'inizio del file audio e I'inizio del loop e piu
corta della lunghezza della forma d'onda
tra la fine del loop e la fine del file audio.

0 Con SampleCell non & possibile ascoltare
un loop in avanti/indietro direttamente dalla
finestra Edit Loops. E necessario attivare il
pulsante di collegamento, quindi attivare e
controllare la versione fwd/rev dal controller
MIDI.

2 Configurare le impostazioni del crossfade
e fare clic su OK. Se I'opzione di
collegamento a SampleCell ¢ stata attivata,
I'aggiunta di un loop crossfade aggiornera
lo strumento di SampleCell.



Scambio del loop 1 e del loop 2

SampleCell & in grado di riconoscere due
loop nei file audio. Se esiste un solo loop
(ossia una sola coppia di indicatori di
inizio/fine loop), quel loop verra
visualizzato durante le parti sia sostenute
sia di rilascio del file audio. Quando si
aggiunge un secondo loop a un file che gia
ne contiene uno, il secondo loop diventaiil
loop di rilascio, mentre il primo loop
diventa il loop di sostenimento. Per la
massima flessibilita nella creazione di loop,
e possibile usare il pulsante di scambio dei
loop per “scambiare” il primo loop allo
scopo di definire il loop successivo quando
si aggiunge il loop di sostenimento.

Per aggiungere un solo loop:

0 Aggiungere gli indicatori di inizio e fine
loop. Il file audio avra ora un loop e tale
loop viene definito “Sus/Rel Loop” nella
finestra Sample Parameters. Questo loop
verra ripetuto durante il sostenimento e il
rilascio dell'inviluppo dello strumento.

Per aggiungere un secondo loop:

0 Decidere se si desidera che il loop
corrente diventi il loop di sostenimento o
di rilascio.

Se si desidera che il loop corrente diventi il
loop di sostenimento e si desidera
aggiungere il loop dirilascio, aggiungere gli
indicatori di inizio/fine del loop 2 dopo la
fine del loop 1. Il nuovo loop diventa il
loop di rilascio.

Se si desidera che il loop corrente diventi il
loop di rilascio e si desidera aggiungere un
nuovo loop di sostenimento, fare clic sul
pulsante per lo scambio dei loop.

Dy

Pulsante per lo scambio dei loop

In questo modo il loop corrente diventa il
loop 2 e gli indicatori di loop verranno
associati al loop 2. Il nuovo loop che verra
ora aggiunto diventa cosi il loop di
sostenimento. Una volta fatto clic sul
pulsante di scambio dei loop, aggiungere
gli indicatori del nuovo loop e collocarli
prima degli indicatori esistenti del loop 2. |
nuovi indicatori verranno etichettati con
“1” per indicare che definiranno la parte
sostenuta del loop.

Per scambiare i loop:

1 Verificare che vi sia un solo loop definito
nel file.

2 Fare clic sul pulsante per lo scambio dei
loop.

3 Definire ora un nuovo loop di modo che
sia il loop di sostenimento.

Eliminazione di loop

Lo strumento gomma consente di
rimuovere un loop in qualsiasi momento.

Per eliminare un loop:

1 Sulla barra degli strumenti fare clic sullo
strumento gomma. Il cursore diventa una
gomma.

2 Fare clic sugli indicatori di inizio e fine
loop che si desidera eliminare.

—_ 0 —_
3 Selezionare e cancellare il valore di inizio
e fine nell'area informativa. Il relativo
indicatore del loop viene cosi eliminato.
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Trim audio

Il comando Trim consente di rimuovere
lI'audio prima e dopo l'intervallo della
forma d'onda selezionato da un file.
Questo comando fornisce un modo molto
pratico per rimuovere velocemente tutti i
dati ad esclusione dell'intervallo
selezionato.

Per rimuovere i dati in eccesso da un file
audio:

1 Selezionare l'area del file audio che si
desidera conservare.

2 Fare clic sul pulsante Trim.

X

Pulsante Trim

3 Tutti i dati, ad eccezione dell'area
selezionata, verranno rimossi dal file audio.
L'operazione puo essere annullata
scegliendo Edit > Undo.

4 Scegliere Save Selection As dal menu
Local della finestra Edit Loops per salvare il
campione (ritagliato) e assicurarsi di
assegnargli un nome univoco, per evitare
di sovrascrivere il campione originale. (Per
lasciare inalterato il campione originale,
chiuderlo senza salvare le modifiche
effettuate.)

- O -

Una volta fatto clic sul pulsante Trim,
scegliere Save Audio As dal menu Local
della finestra Edit Loops per salvare il
nuovo campione con il nuovo nome.
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capitolo 7

Tecniche avanzate

Il presente capitolo illustra delle modalita
per ravvivare i campioni e gli strumenti
utilizzati. Molti degli esempi riportati sono
dovuti al contributo di beta tester, esperti
del servizio di assistenza clienti e
sviluppatori audio. Utilizzare gli esempi
riportati come punto di partenza per le
proprie sperimentazioni e ricerche.

Modelli

La funzione di base di un modello di
strumento é la memorizzazione della
mappatura di zona/gruppo di note e di
impostazioni di parametri degli strumenti.
E possibile utilizzare un file di modello
come punto di partenza per nuovi
strumenti. Nei modelli SampleCell sono
inclusi i parametri Sample Map, Matrix
Modulation, Envelope, Tracker e altri
parametri degli strumenti.

Caricamento automatico dei campioni

Quando nella finestra di dialogo
Preferences si seleziona l'opzione
Automatically Load Samples, tramite
SampleCell verranno caricati tutti i
campioni richiesti dai banchi e dagli
strumenti che si aprono. Quando l'opzione
é deselezionata, lo strumento aperto

presenta campioni vuoti e in Sample Map
vengono visualizzati i nomi dei campioni
in corsivo (ad es. Elec bass D2).

E possibile selezionare zone singole e
sostituirne i campioni oppure € possibile
caricare il campione originale
selezionandone la zona e scegliendo il
comando Load Sample.

I modelli possono essere caricati con
campioni “vuoti” o segnaposto contenenti
poche o nessuna informazione audio. Cio
consente di caricare velocemente il
modello e di sostituire in un secondo
momento i campioni con file sonori
“reali”.

I modelli consentono di impostare
facilmente strumenti complessi. Ad
esempio gli strumenti della batteria sono
composti da un numero elevato di
campioni individuali, numerosi gruppi di
note/zone e numerose impostazioni di
parametri individuali. Una volta impostato
lo strumento batteria con la mappatura
MIDI, le curve di velocity e ADSR, il
filtraggio, il pan e cosi via, & possibile
utilizzare il comando Save Instrument As
per salvare una nuova copia dello
strumento e utilizzarlo come modello.
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Se si desidera riutilizzare piu volte il
modello di uno strumento, é possibile
salvarlo come Blocco Moduli (Macintosh) o
come file di sola lettura (Windows).

Per creare un modello di strumento:

1 Aprire o creare uno strumento e
configurare i relativi parametri come
desiderato. Configurare la finestra di
dialogo Sample Map e apportare modifiche
nelle finestre di dialogo Misc, Envelope,
Matrix Map, Modulators, Trackers e/o
Sample Parameters, se necessario.

2 Utilizzare il comando Save Instrument As
per salvare il file e assegnargli un nuovo
nome per identificarlo come modello.

3 Aprire il modello in uno dei seguenti
modi:
0 Per aprire velocemente il modello senza
caricare alcun campione, aprire la finestra
Preference e deselezionare I'opzione
Automatically Load Samples.

- O -
0 Per aprire velocemente il modello e
caricare tutti i campioni, verificare che
nella finestra Preferences sia selezionata
I'opzione Automatically Load Samples,
quindi aprire il file modello.
4 Selezionare Save Instrument As per
salvare il nuovo strumento sotto un nuovo
nome oppure selezionare Save Instrument
per salvare la nuova versione del modello.

5 Quando si apre il file modello, sostituire

o caricare i campioni nel modo desiderato.

Utilizzo di campioni vuoti

In SampleCell Instrument Templates &
possibile utilizzare campioni vuoti per
risparmiare spazio su disco e velocizzare il
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caricamento iniziale del modello. Un
campione vuoto consiste in un file audio
breve e di ridotte dimensioni (& possibile
trovarne uno nel CD-ROM SampleCell
Library #1 tra i campioni di batteria e
percussioni). Quando lo strumento é
aperto ¢ possibile iniziare a caricare i
campioni in Sample Map per sostituire
quelli vuoti.

Impostazioni predefinite e
modelli degli strumenti

Numerosi parametri di SampleCell possono
essere salvati come impostazioni
predefinite degli strumenti, ma é
importante distinguere queste
impostazioni dai modelli di strumenti
sopra esposti.

Instruments Defaults. Le impostazioni
predefinite vengono applicate a tutti i
nuovi strumenti: qualsiasi campione
singolo o multicampione, strumento
mono o stereo verra configurato in base
alle impostazioni predefinite degli
strumenti correnti. Le impostazioni
predefinite degli strumenti vengono create
quando si seleziona il comando Set
Instrument Defaults, che consente di
memorizzare i parametri Instrument e
Bank correnti (ma non le mappe di
campioni di zona/gruppo di note).

Quando viene creato un nuovo strumento,
vengono applicate entrambe le
impostazioni predefinite Bank e
Instrument. Se ¢ gia aperto un banco e
viene caricato uno strumento (incluso un
modello di strumento), vengono applicati
soltanto i parametri di livello Bank
predefiniti (volume dello strumento, pan,



canale MIDI, uscita audio e note alte basse).
I parametri di livello Instrument (Misc,
Envelope, Matrix, Modulators, Trackers,
ecc.) verranno configurati asecondadel file
di strumento aperto.

Instrument templates. Rappresenta un
modo per salvare diverse serie di
impostazioni predefinite degli strumenti
(dato che nei modelli vengono
memorizzati parametri di livello
Instrument) con il vantaggio di
memorizzare le mappe di campioni di
zona/gruppo di note (le mappe di
campioni non vengono memorizzate con
le impostazioni predefinite degli
strumenti).

Tracker

| generatori di tracce (o Tracker) possono
essere utilizzati in vari modi, quali la
creazione di curve di riposta personalizzate,
I'aumento della risoluzione delle
impostazioni Matrix Map, I'aggiunta di un
elemento di randomizzazione dei toni, il
miglioramento dell'effetto di vibrato e altri
parametri di esecuzione.

Curve di risposta
personalizzate

Le curve di risposta personalizzate vengono
utilizzate per incrementare o diminuire un
parametro basato sull'ingresso di un altro
parametro. | generatori di tracce
consentono di tracciare facilmente una
curva di risposta, favorendo l'incremento
della risoluzione di qualsiasi tipo di
mappatura di matrice per ottenere migliori
accordature, vibrato e altri effetti.

Le curve di risposta personalizzate possono
essere utilizzate in molte situazioni diverse.
Nelle seguenti sezioni vengono illustrati
numerosi esempi.

Aumento della risoluzione di
Matrix Map: Matrix, Tracker

E possibile applicare questa tecnica a
qualsiasi strumento utilizzato. | generatori
di tracce possono essere utilizzati per
modificare mappe che potrebbero
altrimenti essere incollate tra ampiezze di
matrice. Alle volte, ad esempio, il valore 2
per un‘ampiezza di matrice non é
sufficiente, mentre 3 & troppo. Il dilemma
sorge spesso quando si assegna la velocity a
un tono per simulare le variazioni naturali
nella batteria e in altri strumenti a
percussione. In tali condizioni,
un'impostazione troppo alta potrebbe
determinare una alterazione troppo
marcata del tono del campione (i tam-tam
potrebbero sembrare timpani distorti),
mentre un'impostazione troppo bassa
potrebbe portare a un risultato irrilevante.
Inoltre, potrebbe essere necessario evitare
una fluttuazione di tono di una batteria a
pedale o di un campanaccio a differenza di
altri componenti dell'insieme.

Segue un esempio dell'utilizzo del
generatore di tracce per modulare
finemente il modulatore di controllo, in
questo caso la velocity, per ottenere la
risoluzione desiderata dalle mappature di
matrice:
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1 Aprire la finestra di dialogo Trackers e
scegliere Velocity da uno dei menu a
comparsa Tracker, quindi tracciare una
curva di risposta leggermente deviante dal
neutrale (incrementare o diminuire
leggermente tutti i nodi rispetto al centro
oppure creare alcune variazioni non
lineari). Provare con diverse impostazioni
per raggiungere il risultato desiderato.

2 Aprire la finestra di dialogo Matrix e
mappare il generatore di tracce (ricordarsi
quello utilizzato nel passaggio precedente)
sul tono, quindi impostare un‘ampiezza
bassa compresa tra 3 e 8 come valore
iniziale.

3 Ascoltare lo strumento. Cercare di
utilizzare strumenti demo, quali Drums
Library #1, e vedere se tramite i generatori
di tracce € possibile “animare” la batteria,
mentre il tono dei cimbali resta invariato il
piu possibile.

4 Se & necessaria un'ulteriore regolazione, &
possibile aumentare o diminuire I'ampiezza
di matrice del generatore di tracce sul tono,
oppure tornare ai generatori di tracce e
modificare la curva di risposta. Eseguire
prove con questi due parametri fino a
quando lo strumento non presenta l'esatto
livello di risposta.

Accordatura: Matrix, Trackers,
Random Generator

E possibile utilizzare i generatori di tracce
per raggiungere la variazione di tono
ottimale e la randomizzazione degli
strumenti che la richiedono, quali
dulcimeri, kora e altri strumenti non
occidentali. Ad esempio, per creare un
suono metallico basso simile al suono di un
gamelan, considerare lo strumento
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“Glockenspiel Mono” nel CD-ROM Library
#1 e disaccordarlo di due ottave verso il
basso.

Per accordare ulteriormente lo strumento
provare una o entrambe le seguenti
tecniche. Il primo metodo consente di
disaccordare l'intero strumento con
incrementi diversi dal semitono. Il secondo
metodo consente di aggiungere
randomizzazione di tono allo schema di
accordatura gia esistente dello strumento.

Metodo 1: incrementi diversi dal
semitono

1 Aprire la finestra di dialogo Misc
Parameters e disattivare Key Track.

2 Aprire la finestra di dialogo Trackers e
selezionare MIDI Note # dal menu a
comparsa. Mantenere la curva del
generatore di tracce lineare (una linea retta
diagonale). Premere il tasto Opzione
(Macintosh) o il tasto Alt (Windows) e fare
clic sulla curva per reimpostare la
posizione, se necessario.

3 Aprire la finestra di dialogo Matrix Map,
mappare il generatore di tracce sul tono e
impostare I'ampiezza su 99.

E ora possibile ottenere incrementi diversi
dal semitono. Eseguire prove con
I'ampiezza di matrice e la curva di
tracciamento fino a ottenere l'intonazione
desiderata.

Metodo 2: randomizzazione del tono

1 Aprire la finestra di dialogo Trackers e
scegliere Random Generator come uno
degli ingressi del generatore di tracce.



2 Quindi tracciare una curvadi risposta per
lo stesso generatore di tracce. Il suono delle
aree dove é stata aumentata la curva sara
caratterizzato da una maggiore
applicazione di Random Generator. Tale
curva ¢ alla base della randomizzazione
dello strumento, che rappresenta
visivamente le gamme in cui lo strumento
suonera diesis o bemolle.

3 Aprire la finestra di dialogo Matrix e
mappare questo generatore di tracce sul
tono. Iniziare con una valore di ampiezza
basso, tra +5 e +15, quindi regolare
I'ampiezza di matrice sui valori desiderati.

Lo strumento risultera leggermente
stonato, mentre verra mantenuto il centro
del tono.

Per una maggiore varieta di risposta dello
strumento, tornare alla finestra di dialogo
Matrix Map e mappare Random Generator
sul tono con una ampiezza di matrice
media, tra 10 e 15. Scegliere una nota sul
controller e riprodurla ripetutamente,
ascoltando la variazione del tono causata
da Random Generator. (Notare che per
Random Generator in genere s'intende una
sottile sorgente di modulazione.) In tal
modo é possibile aggiungere una
destabilizzazione molto vivace alla tonalita
dello strumento.

O Per ulteriori informazioni sulle tecniche di
accordatura, vedere “Chorus” a pagina 91.

Impostazioni del vibrato
dinamico: Matrix, Trackers,
Modulators

I generatori di tracce possono anche essere
utilizzati per impostazioni di vibrato
dinamico. Se si mappa LFO 1 sul tono,
viene fornito un tipo di vibrato predefinito.
Utilizzando il generatore di tracce é
possibile applicare una curva di risposta in
modo tale che I'ampiezza del vibrato vari a
seconda del tono relativo della nota.

Ad esempio, considerare il suono del
vibrato sui violini reali e altri strumenti ad
arco, per i quali & normale ottenere un
vibrato piu ampio nei registri superiori
rispetto a quelli inferiori. La ragione &
chiara se si guarda la tastiera di una
chitarra, dove i tasti sono piu ravvicinati
nella parte superiore. Maggiore ¢ la
frequenza, minore sara la distanza tra i
toni. La stessa tecnica di vibrato puo variare
il tono di £ un quarto di tono applicato alla
nota inferiore, ma molto di piu (un
semitono, tre quarti di tono o superiore) se
applicata a una ottava superiore sulla stessa
corda.

E possibile utilizzare il generatore di tracce
per impostare una curva che, una volta
mappata sul valore LFO 1 Amplitude che
genera il vibrato, consente di aumentare
I'ampiezza del vibrato nei registri superiori
per corrispondere maggiormente a questo
effetto. Sebbene sia facile eseguire
I'operazione mappando MIDI Note # su
LFO 1 Amplitude nella finestra Matrix, la
risoluzione dell'ampiezza di matrice
potrebbe non essere sufficiente per
raggiungere il risultato desiderato (vedere
“Aumento della risoluzione di Matrix Map:
Matrix, Tracker” a pagina 83). | generatori
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di tracce possono fornire un grado piu
sottile di variazione di vibrato,
specialmente quando la gamma dello
strumento é limitata.

1 Aprire la finestra di dialogo Trackers e
selezionare MIDI Note # dai menu a
comparsa dei generatori di tracce.

2 Regolare la curva incrementando
leggermente i nodi superiori e/o
diminuendo leggermente i nodi inferiori e
confrontare l'effetto di entrambi i metodi.

3 Aprire la finestra di dialogo Matrix Map,
mappare il generatore di tracce su LFO 1
Amplitude e verificare che LFO 1 sia
mappato sul tono.

4 Aprire la finestra di dialogo Modulators e
regolare le impostazioni per LFO 1 come
desiderato.

5 Tornare alla finestra di dialogo Matrix
Map e, durante I'esecuzione del controller o
sequencer, regolare I'ampiezza di entrambi
i percorsi di matrice fino a raggiungere il
risultato desiderato.

Vibrato ritardato: matrice,
generatore di rampe, trackers,
inviluppi

Un altro parametro del vibrato altamente
espressivo consiste nella sincronizzazione
dell'inizio del vibrato rispetto alla nota.
Molti cantanti e strumentisti non
applicano il vibrato immediatamente.
Piuttosto, mantengono stabilmente per un
periodo variabile di tempo una nota lunga
che gradualmente verra caratterizzata da
incrementi di vibrato. In SampleCell &
possibile realizzare I'operazione mappando
il controllo Modulation sull'ampiezza LFO
adeguata (molti strumenti presentano tale
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impostazione come predefinita),
utilizzando il generatore di rampe per
ritardare il vibrato in modo costante o
utilizzando un inviluppo per ritardare il
vibrato in modo variabile.

Controllo Modulation. Il modo piu facile di
ottenere un vibrato ritardato consiste
nell’utilizzare il controllo Modulation per
controllare 'ampiezza LFO. Questo
metodo é ideale quando si ha una mano
libera, ma & impraticabile quando
entrambe le mani sono occupate e non si
dispone di un controller a pedale. In tali
situazioni, uno dei seguenti metodi
potrebbe rappresentare una soluzione.

Generatore di rampe. Per creare un effetto
di vibrato ritardato &€ anche possibile
utilizzare un generatore di rampe. L'unico
inconveniente consiste nel fatto che la
velocita del generatore di rampe non puo
essere modulata da nessun altro parametro,
quali Mod Wheel, MIDI Note #, Pressure, €
cosi via.

Inviluppo. L’utilizzo di un inviluppo per
controllare il tempo di ritardo del vibrato
offre grande flessibilita e richiede solo
alcuni passaggi aggiuntivi.

Per utilizzare il generatore di rampe per il
vibrato ritardato:

1 Aprire la finestra di dialogo Modulators e
impostare Ramp Time su un valore
sufficientemente alto, in modo da
agevolare l'ascolto dell’effetto, poiché sara
sempre possibile regolarlo in un secondo
momento. (Potrebbe essere piu facile
impostare Ramp Time se Preferences viene
prima impostato su Display Real Units. In
tal modo il valore Ramp Times verra
visualizzato in millisecondi.)



2 Aprire la finestra di dialogo Matrix Map e
mappare il generatore di rampe su LFO 1
Amplitude. Impostare I’'ampiezza del
percorso di matrice su una quantita media
(circa 30).

3 Se necessario, regolare I'impostazione
Ramp Time nella finestra di dialogo
Modulators e/o I'ampiezza
dell’impostazione di Ramp>LFO
Amplitude nella finestra di dialogo Matrix
Map fino all’ottenimento dell’effetto
desiderato.

Sebbene I’esempio precedente porti a
risultati apprezzabili, il tasso di ritardo,
ovvero I'ammontare di tempo necessario
prima che inizi il vibrato, resta lo stesso
indipendentemente dal tono. Per evitare
I’applicazione lineare del vibrato, &
possibile utilizzare il generatore di tracce
per aggiungere una curva di risposta al
ritardo.

Per utilizzare un generatore di tracce per il
vibrato ritardato:

1 Aprire la finestra di dialogo Trackers e
selezionare MIDI Note # nel menu a
comparsa di uno dei generatori di tracce.

2 Definire una curva di risposta per il
generatore di tracce adeguata a raggiungere
il risultato desiderato. Per ottenere un
vibrato che venga visualizzato piu
rapidamente nei registri piu alti,
incrementare leggermente i nodi di registro
superiori. Analogamente, affinché il
vibrato venga visualizzato piu lentamente
sulle note di registro inferiore, diminuire
leggermente i nodi sull'estrema sinistra.

3 Aprire la finestra di dialogo Envelopes e
impostare l'inclinazione di attacco
graduale per Envelope 1 o0 2 (a seconda che
vengano gia utilizzati entrambi o uno dei
due), ma non utilizzare Envelope 3. Se si
abilita I'opzione Display Real Unit Values
nella finestra di dialogo Preferences, €
possibile visualizzare le impostazioni
Envelope nelle unita di tempo.

4 Aprire la finestra di dialogo Matrix Map.
Mappare il generatore di tracce adeguato al
corrispondente Envelope Attack e
impostare I'ampiezza su un valore
leggermente negativo, ad esempio -11. In
tal modo nelle note elevate viene ridotto il
tempo di Envelope Attack.

5 Mappare Envelope Attack su LFO 1
Amplitude con una ampiezza positiva
moderata, compresa tra 30 e 40.

6 Ascoltare le modifiche riproducendo e
tenendo premute le note nei registri
inferiore, medio e superiore del controller,
per ascoltare a quale velocita inizia a
comparire il vibrato.

E quindi possibile tornare alle finestre di
dialogo Tracking Generator e/o Matrix
Map per regolare il ritardo di vibrato fino al
raggiungimento dell’effetto desiderato.

Filtri

Per creare numerosi effetti interessanti &
possibile utilizzare un filtro a un polo dello
strumento. Due usi possibili consistono
nell’aumento di nitidezza degli strumenti
batteria e percussioni e nella riduzione del
rumore su campioni con attacchi bassi.
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Utilizzo dei filtri per controllate
dinamicamente la nitidezza
delle percussioni

Un modo semplice ma efficace per
aumentare la nitidezza delle sequenze di
batteria e percussioni consiste
nell’utilizzare i filtri di SampleCell.

Probabilmente il modo piu rapido per
ascoltare un esempio consiste nell’utilizzo
della matrice per mappare Velocity su Filter
con una ampiezza di matrice di £30, ma
non troppo alta, altrimenti il filtro
potrebbe chiudersi completamente sulle
note piu deboli. La mappatura consente di
ottenere una batteria simile a quella reale,
che alle volte pud suonare piu nitida
quando viene colpita con maggiore forza e
vice versa. Nella finestra di dialogo Misc
impostare Filter Cutoff su un valore
inferiore a quello massimo. Inoltre
impostare la quantita Overlap nella finestra
di dialogo Misc dello strumento su un
valore pari ai 2/3 del valore massimo. In tal
modo si eviterad che le note successive
taglino quelle precedenti, dato che il filtro
risponde a nuove quantita di velocity.

I solo limite di questa tecnica consiste nel
fatto che nessuna dinamica del batterista &
coerente con unarisoluzioneinclusatraOe
127 della velocity MIDI. Nei casi in cui si
desideri una variazione superiore a quella
dell'esempio Velocity-a-Filter menzionato,
€ possibile aggiungere Random Generator
nel missaggio per modulare ulteriormente
il filtro in modo pit 0 meno impercettibile.
A tal fine, impostare Velocity sul percorso
della matrice del filtro appena descritto
fino a ottenere il migliore suono possibile,
quindi creare un percorso di matrice
aggiuntivo nel quale Random Generator
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controlli il filtro. Ora si dovrebbe disporre
di due sorgenti differenti mappate sul
filtro: Velocity e Random Generator.

Impostare I'ampiezza di matrice del
percorso Random Generator-a-Filter su
un'impostazione relativamente elevata,
quindi eseguire prove fino a quando non
viene raggiunto un buon equilibrio tra il
controllo del filtro tramite la velocity e le
variazioni casuali nella frequenza
proveniente da Random Generator. Notare
che Random Generator € una delle sorgenti
di modulazione piu accurate, quindi
potrebbe essere necessario impilare piu
mappature di Random Generator sul filtro
per raggiungere risultati piu adeguati.

0O Per agevolare le operazioni illustrate in
questo esempio, impostare alcune misure di
un quarto di nota nel sequencer. Impostare
tutti i livelli nella prima battuta su un volume
basso (p), quindi ripetere le stesse note a un
volume leggermente piu alto (m) e infine a un
volume ancora superiore (f). Eseguire il loop
delle tre battute e iniziare la riproduzione.
Dovrebbe essere possibile sentire le diverse
caratteristiche di frequenza in note successive
con velocity identiche.

Utilizzo del filtro per controllare
il rumore

Se si dispone di un campione con rumore,
il rapporto segnale/rumore nella gamma
dinamica inferiore potrebbe non essere
accettabile. Il fenomeno é piu evidente
durante lo stadio di decadimento del
campione, quando si puo notare che il
rumore di ambiente sembra aumentare con
lo sfumare dell’effetto sonoro o dello
strumento campionato. Per ridurre I'effetto



di tale rumore, cercare di mappare
Envelope 3 sul filtro, con un’ampiezza di
matrice positiva moderata, in modo che il
filtro si apra quando il suono aumenta e/o
si chiuda quando il suono diminuisce.

Utilizzo del filtro con effetti
audio per film/video

Per un maggiore controllo dell’ampiezza di
spettro dei campioni & anche possibile
utilizzare il controller MIDI esterno e i filtri
di SampleCell. L'effetto interessa in modo
particolare i suoni che presentano gia
numerose informazioni ad alta frequenza.

Segue un esempio delle situazioni in cui
I’effetto risulta utile. Si consideri il caso in
cui si creano degli effetti sonori per una
scena di un filmato in cui si vede sfrecciare
un jet. Se la scena si verifica in un campo
aperto, il campione grezzo della libreria di
effetti sonori puo risultare abbastanza
realistico. Ma cosa succede se la scena si
verifica in una strada cittadina, circondata
da grattacieli? In questa situazione, il
suono dei motori sarebbe muto, crescendo
in intensita finché I'aereo non ¢
direttamente sopra l'osservatore che viene
sovrastato dal frastuono dei motori.
Successivamente, quando il jet e passato
sopra l'osservatore e scompare dietro agli
edifici sul lato opposto della strada, il
suono diminuirebbe all'improvviso, fino a
scomparire nella distanza.

Mappando il controllo Modulation sui
filtri e osservando il video di riferimento é
possibile tracciare manualmente una curva
ADSR corrispondente ai tempi di
avvicinamento (il filtro si apre
gradatamente), di passaggio (il filtro €

completamente aperto) e di
allontanamento (il filtro si chiude
gradatamente) del jet.

Per eseguire le stesse operazioni in
automatico, senza utilizzare il controllo
Modulation, mappare Envelope 1 o 2 sul
controllo del filtro, quindi tracciare
I'effetto Envelope per approssimare il
materiale di riferimento.

Idee per I’esecuzione di
strumenti ensemble

Nella presente sezione si analizzano due
modalita di creazione di percorsi per
controller di esecuzioni espressive per
strumenti d’assieme, quali la sezione degli
ottoni e degli strumenti a corda.

La curva del tono o la modulazione del
tono LFO sono ottimi per suoni sintetizzati
e per alcuni assoli di strumenti acustici,
quali la chitarra o la tromba. Tuttavia, gli
strumenti acustici ensemble raramente
sembrano autentici quando sono tutti
modulati sulla stessa frequenza di
campionamento e quindi spesso il
controllo Modulation (o anche il controllo
Pitch) non viene utilizzato con tali
strumenti. Il Controllo Modulation e/o
Pitch sono invece disponibili per il
controllo in tempo reale di altri parametri
che si possono utilizzare in modo molto
espressivo e con un'elevata potenza.
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Maggiore espressivita tramite
il comando Sample Select

Questa tecnica ¢ applicabile a uno
strumento d’assieme con numerose zone di
velocity per gruppo di note (piu sono,
meglio €). Il componente principale di
questo effetto controlla Sample Select
tramite un controllo, preferibilmente il
controllo Modulation. Quando le zone di
velocity dello strumento contengono piu
variazioni dinamiche del suono, il risultato
€ una maggiore espressivita lungo tutta la
gamma dinamicadello strumento. Quando
le diverse zone di velocity contengono
diversi riff o inflessioni stilistiche, il
controllo Modulation consente di eseguire
parti con sfumature molto maggiori. Per
molti degli strumenti ensemble a corda e a
fiato registrati sui CD-ROM di

SampleCell Il viene gia utilizzata questa
mappatura della matrice.

Per creare tale impostazione, aprire la
finestra di dialogo Matrix e mappare il
controllo Modulation su Sample Select. Per
il momento, potrebbe essere utile
disattivare qualsiasi altra mappatura del
controllo Modulation, quali LFO o altre
assegnazioni standard del controllo
Modulation). Provare il controllo
Modulation durante la riproduzione a
diversi livelli dinamici. Il controllo
Modulation potrebbe causare I'attivazione
delle zone di velocity superiori, mentre il
volume verra ancora controllato dalla
velocity. In tal modo é piu facile riempire i
vuoti di colore esistenti quando si
aggiungono parti d’assieme alla sequenza.
(Ad esempio verificare gli ottoni Rock &
Roll sul CD-ROM SampleCell Library #1.)
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E anche possibile utilizzare questa tecnica
per simulare un effetto in tempo reale della
barra di trazione di “percussione” di un
organo Hammond spinta avanti e indietro.
Se sono stati caricati campioni con
numerose percussioni nelle zone di
velocity superiori, il controllo Modulation
consentirebbe di attivare suoni con un
attacco piu intenso, anche a velocity basse.

Un trucco aggiuntivo per ottenere
maggiore espressivita consiste nel mappare
il controllo Modulation sull’ampiezza
Envelope 3 con una ampiezza di matrice di
-99, trasformandola in un controllo del
volume invertito per dissolvenze. Aprire la
finestra di dialogo Trackers e, dopo aver
selezionato Mod Wheel dal menu a
comparsa, modificare la curva in uno dei
generatori di tracce; provare con una
inclinazione verso I'alto (simile alla
dissolvenza in entrata di un crossfade di
Pro Tools o Sound Designer). La
combinazione di queste due mappature di
matrice consente al controllo Modulation
di fornire una maggiore gamma di
espressione dinamica.

Maggiore realismo per
strumenti a corda tramite la
creazione di piu matrici
inviluppo

Gli strumenti ad arco, a causa della tecnica
di esecuzione, non presentano curve di
attacco uniformi a diversi livelli dinamici.
Se, ad esempio, un violoncello viene
suonato per produrre una nota alta,
rispondera immediatamente producendo
un suono. Tuttavia, se il violoncello viene



suonato piano, I'attacco € leggermente
ritardato a causa della minore intensita
esercitata dall’arco sulla corda.

Se I'effetto si limita a pochi campioni, &
possibile simularlo mappando Envelope 1
0 2 su Envelope 3 che controlla I'ampiezza.
Envelope 1 (o0 2) é caratterizzato da un
attacco lento e viene impostato per
rispondere alle note suonate piano, mentre
Envelope 3 ha un attacco “normale” ed &
impostato per rispondere a una velocity
alta.

1 Aprire la finestra di dialogo Envelopes.

2 Modificare Envelope 2 incrementando il
tempo di attacco in modo tale che sia
maggiore (piu lento) dell’attacco Envelope
3. Quanto maggiore ¢ la differenza tra
questi due parametri, pit marcato risultera
I'effetto.

3 Aprire la finestra di dialogo Matrix Map e
creare i seguenti percorsi di matrice:

« Velocity to Envelope 2 Amplitude 90

e Envelope 2 to Envelope 3 Attack 30

Per ottenere una maggiore vivacita da
questa configurazione, mappare Envelope
2 sul filtro con una ampiezza massima di
matrice (99).

Chorus

Il chorus rappresenta un effetto eccezionale
per ispessire alcuni strumenti e conferire
maggiore personalita al suono. E possibile
creare ottimi effetti chorus in base al
seguente esempio:

1 Caricare lo strumento al quale si desidera
applicare il chorus (i violini sostenuti
rappresentano un buon esempio).

2 Nella finestra di dialogo Bank copiare e
incollare lo strumento in modo da avere

due copie dello stesso strumento nel banco.

3 Aprire la finestra di dialogo Misc
Parameters del secondo strumento
(copiato) e disaccordarlo leggermente,
utilizzando il dispositivo di scorrimento
Detune, non il dispositivo Pitch Semitone.

Per ottenere ulteriori effetti chorus, provare
a mappare Modulator sul tono del secondo
strumento e provare con diverse
impostazioni LFO Sync e Waveform.

Trucchi ed effetti vari

Rumore di passi: utilizzo della
velocity per controllare Zone
Start

Quando si aggiunge il rumore di passi o
simili effetti audio di tipo Foley a un
progetto, spesso non e sufficiente
aumentare semplicemente il volume
quando il personaggio si avvicina allo
spettatore. Per approcci prolungati é anche
necessario che I'attacco dei passi risulti pit
pronunciato man mano che i passi si
avvicinano. A tal fine, nella finestra di
dialogo Matrix map mappare Velocity su
Sample Start Point come descritto di
seguito:

1 Aprire la finestra di dialogo Sample
Parameters per le zone contenenti i
campioni di passi.

2 Regolare Zone Start sulla velocity
inferiore che si attivera.

3 Aprire la finestra di dialogo Matrix e
mappare Velocity su Sample Start Point.
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4 Impostare I'ampiezza per la mappatura
su un valore negativo. L’'operazione avviera
prima il campione con velocity superiori.

Incremento di batteria: utilizzo
della randomizzazione di
campioni per ridurre le
ripetizioni

La randomizzazione di campioni consente
di riprodurre casualmente diversi campioni
con le stesse note MIDI ed ¢
particolarmente utile quando si creano
batterie campionate meno ripetitive. Per
impostare I'effetto, effettuare le seguenti
impostazioni:

1 Caricare almeno 2 campioni in una zona
di velocity del gruppo di note.

2 Regolare le zone su valori
sufficientemente bassi (ad es. raggrupparle
verso la parte inferiore del gruppo di note).

3 Nella finestra di dialogo Matrix
impostare tre mappature identiche di
Random Generator su Sample Select con
ampiezza 99.

Questo esempio si applica adeguatamente
soltanto ai campioni mono, perché
Random Generator seleziona i canali
sinistro/destro in maniera indipendente.
Ad esempio, si potrebbe riprodurre il canale
sinistro del campione 1 e il canale destro
del campione 2. Se si utilizzano campioni
stereo, si puo evitare il problema
utilizzando un oscillatore LFO per
modulare Sample Select invece di Random
Generator.
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Scheda di riferimento di SampleCell 1l

Menu File

New
Crea un banco o uno strumento nuovo.

Selezionare Bank e fare clic su OK per creare
un nuovo banco vuoto.

Per creare un nuovo strumento nel banco
corrente, scegliere il tipo di strumento
adatto.

I quattro tipi di strumento disponibili
sono:

Multi-Sample Instrument. Strumento che
utilizza uno o pit campioni mono con
opzioni di modulazione.

Stereo Multi-Sample Instrument. Strumento
che utilizza uno o pit campioni stereo con
opzioni di modulazione.

Single-Sample Instrument. Strumento che
utilizza uno o pit campioni mono in un
singolo gruppo di note senza opzioni di
modulazione.

Stereo Single-Sample Instrument Strumento
che utilizza uno o piu campioni stereo in
un singolo gruppo di note senza opzioni di
modulazione.

Anche i campioni devono essere associati a
uno strumento.

Open

Carica un banco, uno strumento o un
campione in una qualsiasi scheda
SampleCell disponibile.

Close

Chiude la finestra attiva.

Save All Changed

Salva tutte le modifiche apportate ai banchi
aperti e a tutti gli strumenti in essi
contenuti.

Save Bank

Salva il banco corrente nell'unita e nella
directory dalle quali & stato caricato.

Save Bank As

Salva il banco corrente in un'unita e una
directory specifiche. Il comando consente
inoltre di salvare gli strumenti e i campioni
in una directory nuova.
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Revert Bank

Ripristina l'ultima versione salvata del
banco corrente.

Save Instrument

Salva lo strumento correntemente
selezionato nell'unita e nelladirectory dalle
quali é stato caricato.

Save Instrument As

Salva lo strumento corrente in un‘unita e
una directory specifiche. Consente inoltre
di salvare tutti i campioni associati allo
strumento in una directory nuova.

Revert Instrument

Ripristina l'ultima versione salvata dello
strumento.

Get Bank Info

Vsualizza i commenti relativi al banco
corrente. | commenti relativi al banco
vengono visualizzati nelle finestre di
dialogo Open e Where Is.

Quit
Esce da SampleCell.

0 La chiusura di un banco provoca il
silenziamento di tutti gli strumenti in esso
contenuti. L'uscita da SampleCell consente di
tenere gli strumenti correnti nella RAM e
pertanto si potra continuare a utilizzarli senza
aprire SampleCell Editor.
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Menu Edit

Undo

Annulla lI'ultimo comando o l'ultima
modifica effettuata (non tutti i
comandi/modifiche possono essere
annullati).

Cut Instrument

Rimuove lo strumento correntemente
selezionato da un banco e ne memorizza
una copia negli Appunti. Non é possibile
annullare questo comando.

Copy Instrument

Memorizza una copia dell'elemento
correntemente selezionato negli Appunti,
senza rimuoverlo dal banco. Non é
possibile annullare questo comando.

Paste Instrument

Incolla uno strumento dagli Appunti nel
banco corrente. Una copia dello strumento
rimane anche negli Appunti. Non &
possibile annullare questo comando.

0 Se siincollano strumenti in un computer
con piu schede SampleCell, viene visualizzata
una finestra di dialogo nella quale & possibile
scegliere in quale scheda si desidera incollare
lo strumento.



Clear Instrument

Rimuove lo strumento correntemente
selezionato da un banco senza
memorizzarne una copia negli Appunti.

Non é possibile annullare questo comando.

Menu Instruments

New Velocity Zone

Crea una nuovazonadi velocity all'interno
del gruppo di note correntemente
selezionato (con un massimo di sei zone di
velocity per gruppo di note). Associa il
campione o la regione alla nuova Velocity
Zone. Se si fa clic sul pulsante di
riproduzione, € possibile ascoltare il
campione o la regione selezionata con il
tono di base. Se & necessario un campione
stereo per uno strumento mono, in una
finestra di dialogo aggiuntiva é possibile
selezionare il canale 1 (sinistra) o il canale 2
(destra) come unico canale da caricare.

New Key Group

Crea un nuovo gruppo di note contenente
il campione specificato nella finestra di
dialogo successiva. Ogni strumento puo
avere fino a un massimo di 60 gruppi di
note. Se si fa clic sul pulsante di
riproduzione, € possibile ascoltare il
campione selezionato con il tono di base. Il
nuovo gruppo di note viene collocato sul
lato destro della finestra Sample Map, con
un intervallo predefinito di una nota.

0 In Windows, € possibile selezionare piu file
di campioni dalla finestra di dialogo New Key
Group.

Add Multiple Key Groups
(Solo Macintosh)

Seleziona piu campioni e quindi li carica
tutti contemporaneamente. Il comando ¢
utile per la creazione rapida di strumenti
multicampione.

Load Sample

Carica il campione per la zona/gruppo di
note selezionati. Il comando viene
utilizzato insieme alla preferenza
Automatically load samples. Quando
I'opzione non é selezionata, vengono
caricate solamente le informazioni
contenute nella directory per lo strumento:
il campione verra caricato solamente
quando si sceglie il comando Load Sample.
(Il metodo ¢ utile se occorre aprire un
banco o uno strumento troppo grande per
essere caricato nella scheda SampleCell.)

Unload Sample

Scarica il campione correntemente
selezionato mantenendo i limiti del gruppo
di note/zona di velocity e i riferimenti al
file.

Reload Sample

Utilizzato per ricaricare una versione
modificata di un campione o di una
regione. Se si modifica un campione o una
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regione, il campione originale rimarra in
SampleCell finché non si utilizza questo
comando per aggiornarlo.

Change Sample

Carica un nuovo campione nella
zona/gruppo di note correntemente
selezionati. Tutti gli altri parametri
impostati per questo campione (Start
Point, Tuning, e cosi via) verranno
applicati anche al nuovo campione.

Sample Parameters

Apre o rende attiva la finestra Sample
Parameters per il campione selezionato di
uno strumento.

0 E possibile aprire la finestra Sample
Parameters facendo doppio clic su un
campione (ad esempio, un gruppo di note o
una zona di velocity) dalla finestra Sample
Map o facendo clic sull'icona del diapason con
un campione evidenziato nella finestra Sample
Map.

Finestra Sample Parameters

Le seguenti informazioni vengono
visualizzate nella parte superiore della
finestra Sample Parameters:

Instrument Mostra il nome dello strumento
di SampleCell che contiene il file del
campione correntemente selezionato.

File Mostra il file del campione
correntemente selezionato.

Size Mostra la dimensione del file per il
file/la regione correntemente selezionati.
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Volume Mostra la posizione del file del
campione correntemente selezionato.

Region Mostra la regione correntemente
selezionata.

Time Visualizza la lunghezza del file/della
regione (in secondi).

I parametri seguenti sono parametri di
campione globali (I'effetto viene percepito
in tutti gli strumenti che utilizzano copie
del campione correntemente selezionato):

Sample Start Coarse Regola il punto di
inizio del campione in tutta la lunghezza
del campione.

Sample Start Medium Fornisce delle
regolazioni di precisione per
I'impostazione Sample Start Coarse.

Sus Loop Fine Tune Definisce laregolazione
di precisione del tono del campione
durante il loop di sostenimento. Questo
dispositivo di scorrimento e disponibile
solamente se il campione corrente presenta
due loop.

Sus/Rel (Rel) Loop Fine Tune Definisce la
regolazione di precisione del tono del
campione durante il loop Sus/Rel
(sostenimento e rilascio) o il loop Rel
(rilascio). Questo dispositivo di
scorrimento é disponibile solamente se il
campione corrente presenta dei loop. Se il
campione presenta un solo loop, il
dispositivo di scorrimento Sus/Rel
consente di definire con precisione l'audio
che verra riprodotto durante il
sostenimento e il rilascio. Quando il
campione presenta due loop, il dispositivo
di scorrimento diventa il dispositivo Rel e
consente di definire con precisione l'audio
con il loop durante il rilascio del suono.



Sample Fine Tune Definisce la regolazione
di precisione globale del tono del
campione.

Sus Loop Enable Se la casella di controllo &
selezionata, consente di attivare il loop di
sostenimento. Fare clic per
selezionarla/deselezionarla. E disponibile
solamente se il campione presenta due
loop.

Sus/Rel (Rel) Loop Enable Se la casella di
controllo é selezionata, viene attivato, a
seconda dei casi, il loop Sus/Rel o il loop
Release. Fare clic per
selezionarla/deselezionarla.

I parametri seguenti sono parametri relativi
solamente alle zone (il loro effetto viene
percepito solamente nel campione nello
strumento corrente):

Key Group Pan Controlla il pan del
campione selezionato nel campo stereo
complessivo dello strumento. Lo zero
rappresenta un pan bilanciato tra destra e
sinistra.

Sample Amplitude Singolo volume del
campione selezionato.

Fine (Zone Start) Imposta il punto di
inizio della riproduzione della zona di
velocity, in incrementi piu piccoli rispetto
alle impostazioni coarse/medium. Il
parametro ha effetto solamente sul
campione correntemente selezionato (e
non sulle copie del campione usate in altri
strumenti aperti) ed é utile per eliminare
silenzi o transienti all'inizio del campione.
Intervallo: da 0 (nessun offset) a 127
(32.512 cicli della forma d'onda) in
incrementi di 256.

MIDI Root Note Consente di rimappare un
campione di modo che la nota specificata
riproduca il campione con il tono originale
indipendentemente dalla posizione del
gruppo di note all'interno dell'intervallo di
uno strumento. Per cambiare
I'impostazione, trascinare la tastiera a
comparsa sul valore di una nota diversa.

Direction Determina la riproduzione del
campione: in avanti o indietro. Se &
selezionata I'impostazione Backward i loop
vengono ignorati.

Launch Sample Editor

Consente di passare all'applicazione per il
montaggio dei campioni e di aprire il
campione correntemente selezionato. Una
volta terminato il montaggio, € necessario
utilizzare il comando Reload Sample se
sono state utilizzate operazioni di
montaggio distruttivo oppure il comando
Change Sample per caricare una nuova
versione del campione.

Select Sample Editor

Consente di designare l'applicazione per il
montaggio dei campioni che verra avviata
quando si fa clic sul pulsante Edit Sample.

Edit Loops

Consente di scegliere il file audio da
caricare nella finestra Edit Loops. Quando
la finestra Edit Loops viene visualizzata con
il file selezionato, in base alle impostazioni
predefinite la modalita Link-to-SampleCell
¢ disattivata.
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Edit “sample name”

Carica nella finestra Edit Loops il campione
correntemente selezionato nella finestra
Sample Map. Una volta caricato il
campione selezionato nella finestra Edit
Loops, in base alle impostazioni predefinite
la modalita Link to SampleCell viene
attivata.

Convert Instrument to
Stereo/Mono

Converte lo strumento correntemente
selezionato in stereo, se si tratta di uno
strumento mono, e viceversa. Il nome del
nuovo strumento sara accompagnato dalla
definizione mono o stereo.

Get Instrument Info

Visualizza i commenti sullo strumento
correntemente selezionato. | commenti
offrono un modo pratico per creare delle
note sugli strumenti, ad esempio “il
controllo Pitch controlla il tono, il
controllo Modulation controlla il pan”,
ecc.

Set Instrument Defaults

Salva i parametri (modulatori, inviluppo,
ecc.) per lo strumento correntemente
selezionato come impostazioni predefinite
da utilizzare quando si creano strumenti
nuovi o si aggiungono strumenti a un
banco. Se si crea uno strumento nuovo, le
impostazioni salvate vengono applicate
all'intero strumento. Se si apre uno
strumento in un banco, solo i parametri
salvati relativi al banco (pan, canale MIDI,
volume strumento) vengono applicati,
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poiché tutti i parametri relativi allo
strumento vengono presi dallo strumento
stesso.

Map All Instruments

Rimappa tutti gli strumenti nel banco
corrente e regola l'intervallo delle note
alte/basse di ogni strumento di modo che
presenti un intervallo di note esclusivo. Ad
esempio se gli strumenti vengono aggiunti
al banco ed entrambi i loro intervalli di
note sono compresi tra AO e C8, il
comando Map All Instruments consente di
rimappare l'intervallo del primo strumento
(quello piu a sinistra) in modo che sia
compreso tra AO e F4 e quello del secondo
di modo che sia compreso tra F#4 e C8.

Set Root Notes

Consente di impostare e reimpostare
automaticamente la nota di origine MIDI
per il campione selezionato, in base alla
nota piu bassa, piu alta o centrale del
gruppo di note del campione.

0 Macintosh: se si utilizza un file AIFF, &
possibile impostare la nota di origine MIDI
utilizzando la definizione di nota di origine
memorizzata nel file.

Reorder Key Groups By Root
Note

Riorganizza i gruppi di note selezionati
dello strumento (compresi tutti i gruppi di
note a destra della zona/gruppo di note
selezionato), sistemandoli, in base alla nota
di origine, in ordine ascendente in tutto lo
strumento.



Spread Key Groups

Sposta e ridimensiona i gruppi di note
selezionati di modo che abbiano la stessa
ampiezza e lo stesso intervallo (inclusi tutti
i gruppi di note a destra della zona/gruppo
di note selezionato).

Menu SampleCell

Load All Samples

Consente di caricare tutti i campioni
necessari per il banco o lo strumento
correntemente aperto.

Delete Unused Samples

Rimuove dalla memoria i campioni non
utilizzati dagli strumenti correntemente in
memoria.

Test SampleCell

Consente di sottoporre a test i vari chip
RAM e ROM della scheda SampleCell Il. Per
una spiegazione dettagliata della finestra
Test SampleCell vedere I'Appendice C: Test
dell’hardware di SampleCell II.

68000 Status Consente di sottoporre a
test il microprocessore della scheda.

ASIC Consente di controllare il processore
audio di SampleCell.

SRAM Status Consente di convalidare la
RAM utilizzata per i parametri dello
strumento.

DRAM Status Consente di testare la RAM
usata per memorizzare i campioni. Una
volta eseguito il test sullo stato della
DRAM, é necessario spegnere e riaccendere
il computer.

Test Sine Invia un'onda sinusoidale con
segnale massimo a tutte le uscite
analogiche di SampleCell II.

A Attenzione: prima di eseguire Test Sine,
abbassare il volume del mixer.

Monitor SampleCell

Visualizza una finestra nella quale vengono
presentati diversi aspetti dello stato
dell'audio e della memoria per ogni scheda
SampleCell Il installata.

Total Memory Indica la quantita totale di
RAM installata sulla scheda.

Available Memory Visualizza la quantita di
memoria rimasta per campioni
supplementari.

Largest Unused Block Visualizza la
dimensione del blocco piu grande di RAM
contigua, non usata di SampleCell.

Open Current OMS Studio Setup
(Solo Macintosh)

Awvvia l'applicazione OMS Setup e apre il
documento corrente Studio Setup. Per
informazioni su come aggiornare OMS
Studio Setup, consultare il manuale OMS.
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MIDI Setup
(Solo Macintosh)

Apre la finestra di dialogo OMS MIDI
Setup, nella quale ¢ possibile attivare e
disattivare le porte seriali per la
comunicazione MIDI.

Nella finestra di dialogo € possibile inoltre
avviare l'applicazione OMS Setup facendo
clic su New Easy Setup o Edit Custom
Setup. Inoltre & possibile selezionare
I'opzione Run MIDI in Background.

0OMS MIDI Setup

| (Y RAC | External ports to uze:
: [ % Modem [=]
[ Oy Printer

-

B4 Run MIDI in background

{when “Run MIDI In background™ is checked,
OMS will retain control of external ports used
by MICI interfaces until a1l OMS applications
have quit.)

[ NewEasySetup | [ Errorlog |

(Edit custom setup | [ ok ||

Finestra di dialogo OMS MIDI Setup

Per ulteriori informazioni, consultare il
manuale OMS.

Run MIDI in Background

L'opzione consente ai sequencer
compatibili con OMS di continuare la
riproduzione MIDI anche quando non
sono piu l'applicazione corrente; in questo
modo é possibile ascoltare i montaggi
effettuati in SampleCell Editor mentre il
sequencer continua la riproduzione.
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Si tenga presente che se lI'opzione Run
MIDI in Background ¢ attivata, e sia il
sequencer che SampleCell Editor inviano
dati MIDI allo stesso strumento, verranno
prodotte delle note doppie.

Per evitare il problema, disattivare I'eco
MIDI nel sequencer oppure verificare che
MIDI non sia indirizzato allo strumento
SampleCell.

All Notes Off

Quando uno strumento viene assegnato a
un nuovo canale, € possibile indirizzare le
note disattivate sul canale nuovo e non su
quello corrente (che riproduce i suoni). Il
comando All Notes Off consente di
silenziare momentaneamente tutti gli
strumenti in tutti i banchi aperti per
correggere le note incollate.



Finestra Preferences

Consente di personalizzare i parametri di
SampleCell.

s s

[ Automatically delete unused samples after deleting an instrument or closing a bank

[ Pass MIDI theu from the editors control port to the currently selected instrument
Instruments

[ Default new instruments to “Key Track” off

[ Automatically remap instruments in 3 bank after adding an instrument

[ Make one instrument when multiple sound files are dragged onto the editor

[ Try to assign unused MIDI channel for & new instrument
Opening/Loading

[ Preview using Sound Manager

A verify sample file locations before loading

] utematically open aTl instruments in a bank

[ autornatically load samples
Display Searching

A misplay Tine segment envelopes A confirm moved file locations
[l befault to small Bank view
[ Display controls in real units

Wolumes To Search On:

rsturents ANl Yolurnes B
Samples  |_all Yolurnes B

Loop Editing
Loop window left channel color
Loop window Fight shanne) color

[] Loop window backgreund color

Finestra Preferences (Macintosh)

[V Autornaticaly delete unused samples after deleting an instrument of closing a bank
I~ Pass MIDI thiu from the editors control port ta the currently selected instrument

[% Pass MIDI thiu unchanged ta SampleCell cardls)

I~ Pass MIDI thiu when in background

Instrumerts
I Default new instruments ta "Key Track' off
I Automatically remap instiumerts in a bark after adding an instrument
I¥ Make one instrument when riultiple sound files are dragged onto the editor
I# Tiy to assign unused MIDI channel for a new instrument
OpeningfLoading
I Werify zample fie locations before lnading
™ Automaticaly open alinstruments in a bank.
I Autamatically load samples
Display
|¥ Display line segment envelopes
I~ Default to small Bank view
I Display contiols in real units
Loop Editing
Loop window left channel color
Loop window right channel color

[ Luop window background eotor

Finestra Preferences (Windows)

Preferenze generali
Automatically delete unused samples

Garantisce che anche i campioni associati a
uno strumento in fase di eliminazione
vengano eliminati se non sono utilizzati da
altri strumenti. Questa opzione &
consigliata per la gestione efficiente della
memoria (a meno che non venga
successivamente caricato un nuovo

strumento che utilizza gli stessi campioni).

Pass MIDI Through from the editors control
port Consente di regolare i parametri di

SampleCell senza impostare il canale MIDI
corretto per attivare lo strumento
selezionato. | dati MIDI in entrata verranno
inviati al canale MIDI dello strumento
correntemente selezionato,
indipendentemente dall'assegnazione del
canale MIDI. Se si disattiva I'opzione, si
evita la possibilita di una doppia
attivazione delle note; questa situazione
puo verificarsi se il sequencer e lo
strumento sono gia impostati sullo stesso
canale.

Pass MIDI thru unchanged to SampleCell
(solo Windows) Questa opzione consente

di inviare i segnali MIDI ricevuti da tutti i
dispositivi di ingresso alle schede
SampleCell senza che vengano modificati.
L'Editor non incanala i dati MIDI verso uno
strumento particolare prima di inviarli alla
scheda, come invece avviene se €
selezionata I'opzione precedente. Questa e
I'opzione precedente si escludono a
vicenda.
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Pass MIDI thru unchanged to SampleCell
(solo Windows) Consente ai dispositivi

MIDI esterni di continuare ad attivare la
riproduzione della scheda SampleCell
anche se SampleCell Editor non &
I'applicazione corrente in Windows.

Instruments Preferences
Default new Instruments to “Key Track” off

Fa in modo che le note MIDI non abbiano
effetto sul tono degli strumenti nuovi.
Questa funzione & utile quando si crea un
banco di strumenti nel quale ogni
strumento contiene un effetto audio.

Automatically remap Instruments Il
comando estende tutti gli strumenti
esistenti nel banco corrente tutte le volte
che si aggiunge uno strumento nuovo. La
gamma degli strumenti e distribuita su un
intervallo di 5 ottave (ad esempio le note
MIDI alte/basse) e la nota centrale di
ciascun gruppo di note & assegnata alla
nota MIDI di base. Ad esempio, se si hanno
5 strumenti aperti, lo strumento piu a
sinistra viene assegnato da CO a B2 con la
nota di base impostata su F#2. Spostandosi
verso destra, lo strumento successivo viene
assegnato da C3 a B3 con nota di base F#3 e
cosi via. Questo rappresenta un modo
molto facile di creare istantaneamente
effetti audio o kit di percussione.

Make one Instrument Se si seleziona questa
opzione, tutti i file dei campioni vengono
caricati in uno strumento nuovo se
trascinati in SampleCell Editor. Se si tratta
di file AIFF, I'assegnazione del loro gruppo
di note viene presa dai parametri nel file
AIFF.
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Se I'opzione non ¢ selezionata, viene creato
un nuovo strumento per ogni file
campione e lI'assegnazione della nota alta e
bassa (Hi & Lo) rispettera i parametri AIFF
(se esistenti). Se non sono file AIFF
verranno caricati e ordinati in ordine
alfabetico per nome di campione.

Try to Assign Unused MIDI Channel for New
Instruments Questa opzione sostituisce le

impostazioni predefinite dello strumento e
assegna automaticamente il primo canale
MIDI disponibile non utilizzato a ogni
strumento nuovo.

Se non sono disponibili canali MIDI, lo
strumento viene impostato sul canale
corrente MIDI predefinito, il che potrebbe
dar luogo ad assegnazioni doppie di canali
MIDI.

Questa preferenza cerca solamente i canali
inutilizzati nel banco corrente. Se si hanno
piu banchi aperti, & possibile che questa
preferenza assegni un canale MIDI gia
utilizzato da un altro banco aperto.

Opening/Loading Preferences

Preview using Sound Manager (solo
Macintosh) Questa opzione consente di

utilizzare Sound Manager per ascoltare i
campioni nelle finestre di dialogo Where
Is, Open, New Key Group e Add Multiple
Key Groups. Se I'opzione é disattivata, tutte
le anteprime avranno luogo tramite la
scheda SampleCell. Quando si eseguono le
anteprime con SampleCell, non é possibile
interromperle.

Verify sample file locations Consente di
scegliere se si desidera che venga trovato
dapprima tutto quello che si € chiesto di



caricare oppure che venga trovato ogni
strumento/campione man mano che viene
eseguito il caricamento.

Automatically open all Instruments in a
Bank Se l'opzione ¢ selezionata, quando si

aprono i banchi, la finestra di dialogo
Select Instrument non viene visualizzata.
Questa finestra consente di scegliere quali
strumenti caricare e in quale scheda di
SampleCell.

Automatically load samples Carica
immediatamente ogni campione quando
viene aperto uno strumento o un banco.

Display Preferences

Display line segment envelopes Visualizza
graficamente i parametri dell'inviluppo
nella finestra Envelope.

Default to Small Bank View Consente di
impostare la vista predefinita del banco. Se
selezionata, tutti i banchi creati e aperti
verranno aperti in questa vista. Se
disattivata, viene utilizzata la vista intera
(full-view).

Display Controls in Real Units E possibile
configurare le finestre dei parametri degli
strumenti per visualizzare i valori in unita
reali (ms, Hz, ecc.) o in valori di SampleCell
(0-127, 0% - 100%).

Loop Editing

Consente di utilizzare la finestra di dialogo
standard per la selezione dei colori per
impostare i colori di sfondo e dei canali
nella finestra Edit Loops. Per ulteriori
informazioni vedere il

Capitolo 6: Montaggio dei campioni,
esecuzione di loop e trim dell*audio.

Searching Preferences
(Solo Macintosh)

Consente di impostare l'intervallo di
ricerca predefinito per le funzioni di ricerca
degli strumenti e dei campioni di
SampleCell.

Menu Windows

Editing Windows

Scegliere le voci nella parte superiore di
questo menu per aprire o rendere attive le
finestre per Sample Map, Misc Parameters,
Envelopes, Matrix, Modulators, Trackers. E
possibile accedere a ogni finestra tramite il
relativo pulsante della barra degli
strumenti Editor.

Switch Bank Size

Consente di cambiare le dimensioni della
vista del banco (per il banco corrente) dalla
vista intera alla vista Small Bank
(dimensioni ridotte) e viceversa.

Current Bank

Nella parte inferiore del menu Windows &
riportato I'elenco di tutti i banchi aperti. La
selezione di un banco lo rende la finestra
banco attiva.
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Uso di SampleCell Il con Pro Tools

E possibile assegnare le tracce MIDI Pro
Tools da riprodurre su strumenti
SampleCell. E se si utilizza SampleCell
TDM, ¢ possibile eseguire il routing
dell'uscita audio di SampleCell tramite il
bus TDM, assegnando gli insert e le
mandate desiderati alla finestra Pro Tools
Mix.

Per configurare Pro Tools in modo da attivare
SampleCell:

1 Assicurarsi che OMS (Macintosh) o
Windows Multimedia (Windows) sia
installato e configurato e che tutti gli altri
dispositivi MIDI siano accessi e collegati
correttamente.

2 Avviare Pro Tools e aprire una sessione.

3 Avviare SampleCell Editor e caricare gli
strumenti che si desidera riprodurre dalla
sessione di Pro Tools. Per I'esempio e
possibile utilizzare Library Instrument #2
(Drums).

4 Impostare il canale MIDI e altri parametri
per ciascuno strumento. Se & stato caricato
lo strumento batteria, impostarlo sul
canale MIDI 10.

5 In Pro Tools scegliere File > New Track.

6 Nella finestra di dialogo New Track
specificare una nuova traccia MIDI e fare
clic su OK.

7 Nella finestra di dialogo Mix Window
assegnare un selettore di canale della nuova
traccia MIDI al canale di SampleCell
desiderato (canale 10 per lo strumento
batteria).

8 Fare clic sul pulsante di abilitazione alla
riproduzione per la nuova traccia MIDI e

riprodurre alcune note sul controller MIDI.

Il LED delle tracce si illumina per indicare
l'uscita MIDI e, presupponendo che il
routing di segnale sia corretto, dovrebbe
essere possibile sentire il segnale audio in
uscita dallo strumento SampleCell.

Se si utilizza SampleCell TDM

Se si utilizza SampleCell TDM all'interno
del sistema Pro Tools, & anche possibile
eseguire il routing dell'uscita audio di
SampleCell all'interno di Pro Tools. In tal
modo é possibile applicare I'automazione
di Pro Tools all'audio SampleCell per
migliorare il missaggio e le prestazioni.

Per istruzioni sulla configurazione del
sistema Pro Tools con SampleCell TDM
fare riferimento alla Guida di installazione
del modulo TDM.

Appendice A: Uso di SampleCell Il con Pro Tools
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appendice b

Risoluzione dei problemi

La presente sezione del manuale consente
di risolvere problemi di installazione,
software, MIDI e hardware. Si consiglia
vivamente di leggere la presente sezione
prima di richiedere telefonicamente
supporto tecnico a Digidesign.

Note sull'installazione
dell'hardware

Se il computer non si accende o non
riconosce SampleCell dopo l'installazione,
verificare di nuovo l'installazione della
scheda. Spegnere il computer, toccare
I'alimentatore per scaricare dal corpo
I'energia elettrostatica e rimuovere la
scheda. Verificare che non vi siano pin
piegati sul connettore. Se durante
I'installazione sono stati piegati dei pin,
contattare il supporto tecnico di
Digidesign.

Se i pin non sono piegati, reinserire con
cautela la scheda senza fare forza e
assicurarsi che la scheda SampleCell sia
alloggiata correttamente nello slot.
Assicurarsi inoltre che la scheda
SampleCell non sia in contatto con altre
schede del computer.

Se il problema persiste, potrebbe trattarsi di
un problema relativo all'installazione del
software o all'hardware di SampleCell. Fare
riferimento alle relative sezioni.

Note sull'installazione del
software

Se si pensa che vi sia un problema relativo
al software, rivedere la sezione relativa
all'installazione del software e, se
necessario, reinstallare il programma.

Verificare che il sistema rispetti o ecceda i
requisiti minimi elencati in “Requisiti di
sistema” a pagina 3.

Per utenti Macintosh: se la memoria RAM
non é sufficiente, & possibile modificare la
partizione di memoria di SampleCell
Editor. Selezionare (facendo clic una sola
volta) I'icona di SampleCell Editor sul
desktop. Selezionare Get Info dal menu File
e modificare il numero Application
Memory Size a 1024, in modo che venga
richiesta meno memoria. Questa
operazione potrebbe limitare il numero
degli strumenti che si possono utilizzare in
SampleCell Editor o potrebbe
compromettere il corretto funzionamento
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del monitor audio. Notare che in questo
modo non si verifica alcun effetto sulla
memoria all'interno di SampleCell.

Test dell'ingresso MIDI

Per I'esecuzione del presente test si
suppone che OMS (Macintosh) o Windows
Multimedia siano attivi e riconoscano
SampleCell.

Per assicurarsi che SampleCell riceva dati
MIDI:

1 Caricare uno strumento in un banco, se
non ne € gia stato aperto uno.

2 Impostare il parametro MIDI Chan dello
strumento per ricevere sullo stesso canale
MIDI dal quale trasmette il controller
MIDI.

3 Fare clic sull'icona Sample Map nella
parte superiore del pannello anteriore dello
strumento. Viene visualizzata la finestra
Sample Map.

4 Riprodurre una nota sul controller MIDI.
La nota corrispondente dovrebbe essere
evidenziata sulla tastiera a schermo. Se la
nota viene visualizzata, SampleCell riceve i
dati MIDI. Se I'audio non viene riprodotto,
vedere “Test delle uscite audio” a

pagina 108.

5 Se sulla tastiera a schermo non viene
visualizzata la nota, fare riferimento alla
sezione MIDI Connections per la
piattaforma.

6 Eseguire il test di tutti i cavi MIDI di
collegamento tra il MIDI principale e il
computer. Eliminare temporaneamente, se
necessario, altre apparecchiature MIDI tra
questi due dispositivi per rimuovere
qualsiasi ulteriore variabile.
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7 Eseguire il test dell'interfaccia MIDI con
software e hardware diversi per verificare
che funzioni correttamente.

Test delle uscite audio

Se non viene riprodotto alcun suono da
SampleCell, il problema potrebbe risiedere
in diverse aree.

1 Caricare uno strumento in un banco, se
non ne € gia stato aperto uno. Per eliminare
la variabile di uno strumento modificato,
utilizzare uno strumento non alterato dalla
libreria SampleCell.

2 Impostare l'uscita dello strumento in
corrispondenza del connettore SampleCell
collegato al sistema audio.

3 Impostare il controllo Pan dello
strumento al centro.

4 Impostare il fader dello strumento su 0.

5 Fare clic sull'icona Sample Map nella
parte superiore del pannello anteriore dello
strumento. Viene visualizzata la finestra
Sample Map.

6 Fare clic su una nota della tastiera a
schermo. Se si sente un suono, eseguire lo
stesso test con lo strumento che dava
problemi in origine (se si trattava di uno
strumento diverso da quello appena
utilizzato). Se non viene riprodotto alcun
suono, analizzare le impostazioni dello
strumento per individuare il problema. Se
uno strumento riproduce un suono tramite
la tastiera a schermo, ma non tramite il
controller MIDI, fare riferimento a “Test
dell'ingresso MIDI” a pagina 108 per
verificare il corretto funzionamento di
SampleCell.



7 Se non si sente ancora alcun suono,
scollegare i cavi dalle uscite audio di
SampleCell e collegarli a un altro
dispositivo audio della cui riproduzione
sonora si é certi. Se non si sente alcun
suono da questo dispositivo, l'errato
funzionamento dipende dai cavi o dal
sistema audio.
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Test dell'hardware di SampleCell II

SampleCell Il presenta una funzione di
diagnostica integrata. Se si teme che
I'hardware non funzioni correttamente,
mettere in pratica le seguenti procedure di
test.

Per eseguire il test dell*hardware
SampleCell II:

1 In SampleCell Editor selezionare
SampleCell > Test SampleCell.

2 Per eseguire il test delle prestazioni di
68000, ASIC, SRAM o DRAM, fare clic su
ciascuno dei pulsanti Test. Per eseguire
alcuni test possono occorrere alcuni
minuti. (Per eseguire il test DRAM sulla
scheda SampleCell a 32 MB sono necessari
30 minuti.)

1 Test 68000

Se sul pulsante viene visualizzata la scritta
Passed, significa che e stato eseguito il test
della sezione e che & possibile procedere al
secondo test. Se I'esito del test 68000 non ¢
positivo, il microprocessore sulla scheda
SampleCell presenta problemi di
comunicazione con il sistema. Se il test
68000 non da risultato positivo, tutti gli
altri test avranno lo stesso risultato.

La scheda potrebbe non essere posizionata
correttamente nello slot. Spegnere il
computer, rimuovere la scheda SampleCell
e ispezionare i contatti verificando che non
siano sporchi o danneggiati. Reinstallare la
scheda ed eseguire di nuovo il test 68000.

Se il risultato del test & di nuovo negativo,
contattare il rivenditore o il supporto
tecnico di Digidesign per ottenere
assistenza.

2 Test SRAM

Se I'esito del test SRAM é positivo,
procedere al terzo test. Se il risultato del test
€ negativo, contattare il rivenditore o il
supporto tecnico di Digidesign per ottenere
assistenza.

3 Test ASIC

Se il test ASIC ha risultato positivo,
procedere al quarto test.

Se il risultato dei test 68000 e SRAM &
positivo, ma il test ASIC € negativo,
contattare il rivenditore o il supporto
tecnico di Digidesign per ottenere
assistenza.
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4 Test DRAM

0 La presente sezione non é pertinente se si
utilizza SampleCell Il Plus. Il presente test
consente di verificare lo stato della memoria
RAM delle schede SIMM della scheda
SampleCell standard.

Per il test DRAM occorrono circa 30 minuti.
Se l'esito del test DRAM e positivo,
procedere ai test della serie Test Sine.

Se il risultato del test DRAM é negativo,
verificare che i moduli SIMM della
memoria RAM della scheda SampleCell
siano posizionate correttamente. Spegnere
il computer e scollegarlo dallarete. Aprireil
computer e toccare l'alimentatore per
scaricare l'energia elettrostatica, rimuovere
la scheda SampleCell dallo slot, tutte le
schede RAM e quindi riposizionarle di
nuovo. Verificare che le schede RAM siano
posizionate correttamente prima di
reinserire la scheda.

Reinstallare la scheda SampleCell ed
eseguire di nuovo il test DRAM.

Se il risultato del test é di nuovo negativo,
contattare il rivenditore o il supporto
tecnico di Digidesign.

5 Test Sine

A |l test Sine consiste nell‘invio di un tono a
volume MOLTO ALTO alle uscite audio di
SampleCell II. Regolare adeguatamente i livelli
del volume sul mixer prima di eseguire un test
Sine.

Per eseguire il test delle uscite di
SamplecCell, fare clic sul pulsante numerato
Test Sine relativo al canale dell'uscita audio
desiderata. Verra quindi inviata un'‘onda
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sinusoidale singola massima all'uscita
designata. Per interrompere I'onda
sinusoidale, fare clic di nuovo sul pulsante
numerato relativo all'uscita oppure
chiudere la finestra di dialogo Test
SampleCell.

Se i problemi persistono contattare il
supporto tecnico di Digidesign.

Campioni in DRAM dopo il riavvio del
sistema

In SampleCell Il la memoria di
campionamento viene conservata dopo il
riavvio del sistema. Per eliminare
completamente il contenuto DRAM,
spegnere il computer, attendere alcuni
minuti, quindi riavviarlo.



appendice d

Creazione e montaggio dei campioni

Sebbene in SampleCell Il non sia possibile
eseguire campionamenti, tali
campionamenti possono essere creati
esternamente per poi essere utilizzati nella
creazione di strumenti SampleCell.

Campionamento con Audiomedia ll/1l1
(solo Macintosh)

Audiomedia Il e Audiomedia Il
consentono di eseguire un
campionamento front-end a due canali per
SampleCell.

Per creare campioni compatibili con
SampleCell tramite Audiomedia IIl:

1 Utilizzare Audiomedia lll per registrare su
disco rigido il suono desiderato. (Vedere la
documentazione relativa ad Audiomedia
Il se necessario.)

2 Utilizzare gli strumenti di montaggio per
selezionare la porzione di campione
desiderata. Assicurarsi che le dimensioni
della porzione siano inferiori alla memoria

disponibile sulla scheda SampleCell Player.

3 Salvare il campione nella relativa cartella
all'interno della cartella Samples (vedere la
documentazione di SampleCell). Dovrebbe
quindi essere possibile caricare il nuovo
campione dalla finestra di dialogo Sample
Map di SampleCell, che consente anche di
eseguire il loop e applicare il parametro
Matrix, nonché altri parametri
modificabili.

Campionamento con Pro Tools

Il sistema Pro Tools di Digidesign puo
anche essere utilizzato per campionare
suoni come Audiomedia.

Per creare un campione utilizzando Pro Tools:

1 Utilizzare Pro Tools per registrare su disco
rigido il suono desiderato. (Vedere la
documentazione di Pro Tools.)

2 Utilizzare gli strumenti di montaggio per
selezionare la porzione di campione
desiderata. Assicurarsi che le dimensioni
della porzione siano inferiori alla memoria
disponibile sulla scheda SampleCell.

3 Salvare il campione nella relativa cartella
all'interno della cartella Samples. Dovrebbe
quindi essere possibile caricare il nuovo
campione dalla finestra di dialogo Sample
Map di SampleCell.
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Utilizzo di campioni da altri
campionatori

Sul mercato sono disponibili numerosi
suoni campionati per numerosi
campionatori digitali. Sebbene il supporto
diretto per campionatori non siaincluso in
SampleCell Il, é possibile importare con
facilita campioni nei seguenti tipi di file:
AIFF, Sound Designer, Sound Designer Il o
Snd utilizzando un programma di terze
parti, quali Alchemy™ (Alchemy, Sound
Designer e Snd sono applicazioni per
Macintosh). Inoltre, & possibile utilizzare
uno qualsiasi dei numerosi programmi di
conversione dei file disponibili, come ad
esempio Interpreter™ di Gallery Software.
Per ulteriori informazioni su questi e altri
programmi di Digidesign e dei partner di
sviluppo, contattare Digidesign ai numeri
elencati nella copertina interna.
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